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Preface

Preface

This section defines the purpose of this document.

About this document
This document describes how to use ClearDesign.

Scope of this document
This document contains the following chapters:

l Chapter 1. Getting Started

l Chapter 2. Election basics

l Chapter 3. Adding fonts and images

l Chapter 4. Fundamental election entities

l Chapter 5. Setup of advanced election types

l Chapter 6. Adding support for downstream products

l Chapter 7. Setting up and laying out ballots

l Chapter 8. Layout Preview

l Chapter 9. Managing languages, device messages, and audio

l Chapter 10. Proofing elections

l Chapter 11. Ballot proofing reports

l Chapter 12. Producing an election

l Chapter 13. Logs

l Appendix A. Supported data import formats

l Appendix B. Common attributes of entities

l Appendix C. Formatting toolbar: Ballot Text editor

Intended audience
This document is intended for election officials and election staff who are responsible for operations
and maintenance before, during, and after an election. This document is also used by Clear Ballot
personnel who support election officials and election staff.
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Preface

Conventions
This section describes conventions used in this document.

References to ClearVote products
A ClearVote® system can comprise the ClearAccess®, ClearCast®, ClearCount®, and ClearDesign®
products. Jurisdictions are not required to purchase all products. You can ignore references to any
ClearVote products that are not part of your voting system. Also ignore implementation options that
are not relevant to your policies and procedures.

BDF and ADF
ClearAccess imports an election definition contained in an accessible definition file (ADF) created by
ClearDesign. ClearCount and ClearCast import an election definition contained in a ballot definition
file (BDF) created by ClearDesign.

Versions of ClearDesign earlier than 2.0 created unencrypted ADFs and BDFs. ClearDesign 2.0 and
later versions produce encrypted ADFs and BDFs. You can distinguish between unencrypted and
encrypted ADFs and BDFs by the ending of the filename.

File type Filename ends in

Unencrypted accessible definition file adf.zip

Encrypted accessible definition file adfx.zip

Unencrypted ballot definition file bdf.zip

Encrypted ballot definition file bdfx.zip

In this document, the general terms ADF and BDF can refer to both the unencrypted and encrypted
versions of these files.

For the specifics of the ADF and BDF file formats, see the following:

l ClearDesign Accessible Definition File Guide

l ClearDesign Ballot Definition File Guide

Contact us
Clear Ballot Group welcomes your feedback on our documentation. Please send comments to
Documentation@ClearBallot.com.

If you have questions about using your product, contact your Clear Ballot representative.

ClearDesign User Guide 18

mailto:Documentation@ClearBallot.com?subject=Documentation Feedback


Chapter 1.  Getting Started

Chapter 1. Getting Started

1.1 Objectives
After reading this chapter, you should be able to:

l Log in and out of ClearDesign

l Change and recover your password

l View the product version and installed software

l Define the termsmodel and entity

l Navigate to the Administration Home page and use ClearDesign screen components

l Describe the basic concepts of ClearDesign administration

1.2 Advice to the reader
Clear Ballot advises the following:

l If you are a new user of ClearDesign, start by reading the ClearDesign System Overview and
then read this chapter in its entirety.

l If you manage the ClearDesign system and users, also read the ClearDesign Administration
Guide.

l If you are an experienced user of ClearDesign, skip this chapter.

1.3 Logging in
To log in to ClearDesign:

1. In the address field of the browser, enter the ClearDesign web address provided by your
system administrator.

ClearDesign displays the Please sign in dialog (Figure 1-1).

Figure 1-1. Please sign in dialog
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2. In the Please sign in dialog, enter the username and password provided by your system
administrator.

3. If desired, select the following options:

l To view the password that you enter, select Show Password.

l To request the browser to store your user name and password, select Remember me.

4. Click Sign In or press Enter.

5. The next step depends on whether you are logging in to ClearDesign for the first time:

l If you have previously logged in to ClearDesign, you can skip the remainder of this topic.

l If this is your first time logging in to ClearDesign, the Change Password dialog appears
(Figure 1-2).

Figure 1-2. Change password dialog

In the Change Password dialog, do the following:
a. Enter a password in the New Password and Confirm Password fields.

b. Optionally, to view what you type in these fields, select Show Password.

If your password does not meet the requirements set by your administrator,
ClearDesign displays a message similar to Figure 1-3.

Figure 1-3. Message indicating that your password does not meet requirements

c. Click Save.

ClearDesign saves your new password.
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1.4 Changing a password
To change your password at any time:

1. Locate and click your username in the top right corner of the ClearDesign window.

2. Select Change password from the drop-down menu (Figure 1-4).

Figure 1-4. Change password drop-down menu selection

ClearDesign displays the Change Password dialog (Figure 1-5).

Figure 1-5. Change password dialog

3. Enter the new password in the Password and Confirm Password fields.

4. Optionally, select Show Password to view what you type in the Password and Show
Password fields.

5. Click Save.

The new password is now in effect.

When you log in, ClearDesign also prompts you to select a new password if your current password
has expired.

1.5 Logging back in after an inactivity timeout
ClearDesign times out after an amount of inactivity specified by the administrator. The default
inactivity value is 30 minutes.

If ClearDesign logs you out due to inactivity, a dialog appears that allows you to log in again.
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1.6 Setting up password recovery
The password-recovery capability enables you to reset your ClearDesign password if you forget it.
This capability is enabled by default for users assigned an administrator role. This capability is also
available if your administrator has enabled it for the role associated with your username.

To set up password recovery:

1. Locate and click your username in the top right corner of the ClearDesign window.

2. When the drop-down menu appears, select Generate Password Recovery File (Figure 1-6).

Figure 1-6. Generate Password Recovery—menu selection

3. When ClearDesign displays a prompt asking if you want to download the password recovery
file, click OK (Figure 1-7).

Figure 1-7. Generate Password Recovery—confirmation prompt

ClearDesign places the password recovery in your default Downloads folder and displays a
confirmation prompt (Figure 1-8).

Figure 1-8. Password recovery file created—confirmation prompt

4. Click Close to dismiss the download-confirmation prompt.

5. Clear Ballot recommends that you move the password recovery file from your Downloads
folder to a secure storage location, such as a USB drive.
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1.7 Logging out
To log out of ClearDesign:

1. In the upper right corner of the ClearDesign window, click your username.

2. Select Logout.

3. Close the browser tab.

1.8 Viewing the product version and installed software
To view the product version and installed software:

1. In the upper right corner of the ClearDesign window, click your username.

2. Select About from the drop-down menu.

ClearDesign displays the About window.

Figure 1-9. About window (partial screen)

The product version appears below the title of the About window.

The About window contains two tabs:

l ClearDesign Product Files—lists files created by Clear Ballot that make up the ClearDesign
application

l Third-Party Information—lists programs and utilities that are created by third parties and
installed on the computer to support ClearDesign

3. If desired, do any of the following:

l Select Show / hide columns to change what appears on the current tab.

l Use the Search field to locate an item on the current tab.

l Click Copy to write the content of the current tab to the clipboard.

l Print the contents of the current tab.

l Export the contents of the current tab to an Excel, PDF, or CSV file.

4. When done, click the Close button at the bottom of the window.
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1.9 Definitions: model and entity
ClearDesign uses a database structure to store information about individual elections and parts of
elections. When using and reading about ClearDesign, be aware of the database termsmodel and
entity.

In simple terms, amodel refers to category of objects to which an individual entity belongs.

Example 1 : Elections is a model. An individual election, such as ClearCounty General Election Demo,
is an entity. ClearDesign stores attributes or characteristics of an entity. Two attributes of an
individual election entity are Name and Election Date.

Example 2: Contests is a model that represents races in an election. An election can contain one or
multiple contest entities. An example of an individual contest entity is a race that has the Name
attribute “Representative to the U.S. Congress” and the Contest Type attribute of Candidate.

1.10 Viewing the Administration Home page
ClearDesign displays the Administration Home page after you log in.

Figure 1-10 shows the Administration Home page and identifies common components that appear
on ClearDesign screens.

Figure 1-10. Administration Home page and screen components

The following list defines the components that appear on the Administration Home page and other
screens of the ClearDesign application. In this list, the numbers identify the items highlighted in red
in Figure 1-10.

1. Username
Click the arrow next to your user name to select the following from a drop-down list:

l Change password (See page 21.)

l Password Recovery (See page 22.)

l Logout (See page 23.)

l About this software (See page 23.)
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2. Breadcrumbs
The Breadcrumbs show your current location and the path of screens to your current location.
Screen names are separated by the > character. Click a screen name in the path to return to that
screen.

3. Navigation pane
On the Administration Home page, ClearDesign displays the Administration menu in the navigation
pane. On this menu, Elections is selected by default. The other selections that you see on the
Administration menu depend on the permissions associated with the role assigned to your
username.

If you are a ballot designer and not an administrator, you may not see and use the non-election
settings on the Administration menu. However, you should learn the basic concepts of ClearDesign
administration. To do so, read "Overview of ClearDesign administration" on the next page.

If you are an administrator, see the ClearDesign Administration Guide for details about the non-
election settings available from the Administration menu.

4. Content pane
The Administration Home page displays the Elections view by default. This tab is the starting point
for selecting an individual election to view and change its settings. The Elections view also contains
buttons that enable you to Restore, Add, and Delete an election.

For details, see:

l "Election basics" on page 29

l "Fundamental election entities" on page 59

The Elections view is an example of a list view. A list view shows all entity instances of a given model
in a table.

5. Search field
Use the Search field to find a specific item on the current screen. This field is useful when the current
screen contains a large amount or many rows of data.
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6. Copy, PDF, Excel, CSV, Print, and Show / hide columns buttons
The following buttons appear on ClearDesign list views containing tabular data.

Button Description

Copy Copies the contents the tab to the Windows Clipboard. You can
then paste the content to an application such as Notepad.

PDF Exports the contents of the tab to a PDF file placed in your
browser-specified Downloads folder.

Excel Exports the contents of the tab to an Excel file placed in your
browser-specified Downloads folder.

CSV Exports the contents of the tab to a comma-separated values
file placed in your browser-specified Downloads folder.

Print Displays the Print dialog for your default printer where you can
select settings for printing the contents of the tab.

Show / hide columns Displays a menu for selecting which columns appear on the tab.
The currently selected columns appear highlighted.

Table 1-1. Buttons in the top right corner of a list view

1.11 Overview of ClearDesign administration
If you are an administrator, skip this section and see the ClearDesign Administration Guide for details
about the tasks available from the Administration menu.

Table 1-2 provides an overview of administration concepts. The items in the Concept column of
Table 1-2 correspond to the selections available from the Administration menu. If a non-
administrator role is assigned to your username, you may not see all the selections of the
Administration menu.
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Concept Description

Customers A customer typically represents a jurisdiction, such as a county, where
ClearDesign users create and edit ballots. ClearDesign is installed with
one customer whose name is default.

A jurisdiction can create customers for specific types of elections

Example: Suppose that a jurisdiction holds school board-only
elections. In this situation, an administrator can create a specific
customer to give the ballot developers of school board elections their
own standalone development area that is separate from the
development area for other elections.

Roles A role comprises a group of permissions. Each user is assigned a role
that determines what functions he or she can perform. An
administrator can enable or disable the permissions assigned to each
role.

For each customer, ClearDesign provides two default roles:

l Administrator–By default, the administrator role has all
permissions enabled. A user assigned the administrator role can
use all selections on the Administration menu.

l Election clerk–By default, the election clerk role has
administrative permissions disabled. A user assigned the election
clerk role can select only the following from the Administration
menu:

o Users (in view-only mode)
o System logs
o Elections

Users A user is a person who logs in to ClearDesign and performs tasks for
designing ballots. Each ClearDesign customer has a group of users.

Administrators can create and maintain users, assign roles to users,
and set passwords.

Table 1-2. Administrative concepts

ClearDesign User Guide 27



Chapter 1.  Getting Started

Concept Description

Localizations Localizations enable you to customize text embedded in the
ClearDesign user interface. Most labels and messages can be localized.
Jurisdictions can replace any localizable text string with their specific
terminology or translation.

Example: A precinct refers to a subdivision of a county, city, town, or
ward for election purposes. Some jurisdictions use the term Election
District instead of Precinct. The localization capability enables you to
display the term preferred in your jurisdiction.

The localization settings also contain the default text for write-ins.

For localizations to appear in an election, your administrator must edit
and change the localization settings before you create the election.

System logs The system log is a table that records all non-election-specific activity.

ClearDesign appends a record to the log when the following types of
events occur:

l User access

l Administrative exceptions for elections

l Functional updates

l Changes to the election database

Table 1-2. Administrative concepts (continued)
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Chapter 2. Election basics

2.1 Objectives
After reading this chapter, you should be able to:

l Navigate the Elections view and other list views of ClearDesign

l Describe the scenarios for creating elections and election templates

l Perform tasks on individual election entities, such as displaying the Info tab and adding, backing
up, restoring, and deleting elections

2.2 Advice to the reader
Clear Ballot advises the following:

l If you are a new user of ClearDesign, read "Navigating the Elections view and other list views"
on the next page.

All list views of ClearDesign operate in a similar manner. If you learn to navigate and use the
Elections view successfully, you will be able to use all other list views of ClearDesign.

l All readers should become familiar with "Scenarios for creating elections in ClearDesign" on
page 37. This topic is a key to understanding typical ClearDesign workflows and the tasks
available for individual elections described in the remainder of this chapter.

2.3 How to reach the Elections view
The Elections view is the starting point for the tasks associated with individual elections, such as
adding, restoring, deleting, and editing elections.

To reach the elections view, log in to ClearDesign as described on page 19.

After you log in successfully:

l ClearDesign displays the Administration Home page (Figure 1-10 on page 24).

l The Elections model appears selected (highlighted) on the Administration menu in navigation
pane on the left.

l The Elections view appears in the content pane on the right. This view lists all available
individual elections.

ClearDesign User Guide 29



Chapter 2.  Election basics

2.4 Navigating the Elections view and other list views
The Elections view is a list view. A list view shows all entity instances of a given model in a table.

Figure 2-1 shows the Elections view as an example of list view.

Figure 2-1. Elections view

2.4.1 Selecting which columns appear in a list view
To set the columns to display:

1. Navigate to the list view where you want to change which columns appear.

2. Click Show / hide columns.

ClearDesign displays a drop-down list containing the available columns.

For example, Figure 2-2 shows the drop-down list that appears when you click Show / hide
columns on the Elections view.

Figure 2-2. Drop-down list—Show / hide columns on the Elections view

3. Select or deselect columns from the drop-down list.

To return to the default settings, click Restore to default.

4. Click outside the drop-down list to return to the list view.
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2.4.2 Setting the default sort sequence of an entity in a list view
The sort sequence (Sort Seq) values control the default order in which entities appear in a list view.
By default, ClearDesign creates sort sequence values starting with 10 in increments of 10 as you add
entities to a list view. However, you can change the Sort Seq value of any entity to 1 or greater.

Figure 2-1 shows an example of an Elections view where the election entities are sorted in ascending
order according to the values in the Sort Seq column (10, 20, 30). Click the Sort Seq column header
to toggle between ascending and descending order.

To change the Sort Seq of an entity from a list view:

1. Click the Edit button in the row corresponding to the desired entity.

For example, suppose that you want to change the Sort Seq for the Any Count Primary on the
Elections view (Figure 2-3). Click the Edit button in the corresponding row.

Figure 2-3. Edit button for an individual election on the Election view

2. When ClearDesign displays the dialog for the entity, edit the value in the Sort Seq field and
select Save (Figure 2-4).

Figure 2-4. Election dialog—Changing the Sort Seq

ClearDesign redisplays the Elections view with the changed Sort Seq value.

If you are a new user of ClearDesign, do not change values other than the Sort Seq until you read
and become familiar with the information in the remainder of this chapter.
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ClearDesign allows you to use the same Sort Seq number on more than one entity in a list view.
However, Clear Ballot does not recommend this practice. Reusing the same sort sequence number
can produce unintended results.

2.4.3 Sorting a list view by a specific column
By default, a list view is sorted according to the Sort Seq column.

To sort a list view by a column other than the Sort Seq, click the header cell of the desired column.

For example, see the Election tab in Figure 2-5. This tab is currently sorted by default according to
the Sort Seq column.

Figure 2-5. Election tab sorted by the Sort Seq column (default)

To sort the Election tab by the Name column, click the header cell.

ClearDesign sorts the column in ascending order (alphabetical order) by Name (Figure 2-6).

Figure 2-6. Election tab sorted by the Name column in ascending order

If you click the Name header cell again, ClearDesign sorts the list view in reverse alphabetical order
by Name.
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2.4.4 Copying a list view to the Windows clipboard
Copy a list view to the Windows clipboard when you want to paste it into an application to edit and
format the contents.

To copy a list view to the clipboard:

1. Go to the list view that you want to copy.

2. Click the Copy button in the upper right of the contents pane.

ClearDesign displays a confirmation message.

Figure 2-7 shows a confirmation message after copying the Elections view to the clipboard.

Figure 2-7. Confirmation message after clicking Copy on the Elections view

3. Open the desired application and select the Paste command from the application or enter
Ctrl-V.

Figure 2-8 shows a Microsoft Word file after pasting the contents of the Elections view from
the clipboard.

Figure 2-8. Microsoft Word after pasting a list view of an Elections view from the
clipboard

4. Edit and format the application file as desired and save it.
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2.4.5 Exporting a list view to a PDF, Excel, or CSV file
The steps for exporting the contents of a list view to a PDF, Excel, or CSV file are similar. The
following example provides the steps for exporting the contents of the Elections view to a PDF file:

1. On the Elections view, click PDF in the upper right of the contents pane.

ClearDesign places the file in the downloads folder specified for your browser and displays a
filename and icon in the status bar at the bottom of the browser window (Figure 2-9).

Usually, the path to the downloads folder is C:\Users\Your_User_Name\Dowloads.

Figure 2-9. Example: Icon and filename in the status bar of the browser when
downloading a PDF file

2. To open the file in the application, click the filename in the status bar or navigate to the
Downloads folder and click the filename.

Figure 2-10 shows an example of an Elections view exported to a PDF file.

Figure 2-10. Example: an Elections view exported to a PDF file

2.4.6 Selecting entities in a list view
This topic describes how to select entities in a list view. After selecting an entity, you can perform
any of the actions available for that entity. Some actions operate on one entity at a time. Other
actions can operate on multiple entities at the same time.

Selecting and deselecting individual entities in a list view
To select an individual entity in a list view, click the box in the first column of the row corresponding
to the desired entity. A check appears to indicate that the entity is selected.

For example, Figure 2-11 shows an Elections view where a single election, Clear County General
Election, is selected.
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Figure 2-11. Selecting a single entity in a list view

To select multiple entities, click additional boxes in the first column of the corresponding rows.

To deselect entities, click the boxes containing checks. The boxes become blank to indicate that the
entities are no longer selected.

Selecting all entities in a list view
To select all entities in a list view, click the box in the first column of the header row. A check then
appears in all rows of the list view.

Figure 2-12 shows an Elections view where all entities are selected.

Figure 2-12. All entities of an Elections view selected

To deselect all entities, click the box in the first column of the header row. The checks no longer
appear in all rows of the list view.

2.4.7 Election states
The Election State is a column that appear by default on the Elections view. The election state
indicates the level of completion of the ballot-development process.
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Available election states
Table 2-1 lists and describes the ClearDesign election states.

Election State Description

1. Election Created (Default). All entities are editable.

2. Ballots Created Any actions that can change ballots are unavailable.

3. Cards Created Any actions that can change cards are unavailable.

4. Media Created Any actions that can change media are unavailable.

Table 2-1. Election State

Election states correspond to the typical ballot development process and are cumulative. The base
election state is Election Created. You can edit any entity when the election is in this base state if the
role assigned to your user name has the appropriate permissions.

Advancing the election state continues the restrictions from previous state and adds the restrictions
of the current election state.

You can return to a previous election state if revisions are necessary.

You can import data to or export data from ClearDesign only while in the Election Created state.
However, you can back up an election in any election state.

Setting the election state
You can update the election state in the following locations:

l When you edit an election, ClearDesign displays the Election dialog for the currently selected
election. You can change the Election State field of this dialog.

See "Editing an election" on page 45.

l When you click Print from the Ballot Sets tab, ClearDesign displays the Print Card dialog. If you
select (check) Set Election State To Cards Created and click OK, ClearDesign advances to that
election state.

See "Printing cards" on page 164.

l When you select Export BDF on the Info tab of an election, ClearDesign displays the Export BDF
dialog. If you select (check) Set Election State To Media Created and click OK, ClearDesign
advances to that election state.

See "Exporting a ballot definition file (BDF or BDFx)" on page 232

l When you select Export ADF on the Info tab for an election, ClearDesign displays the Export
ADF dialog. If you select (check) Set Election State To Media Created and click OK, ClearDesign
advances to that election state.

See "Exporting an encrypted accessible definition file (ADFx)" on page 233.
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2.5 Scenarios for creating elections in ClearDesign
This topic describes some scenarios for creating elections in ClearDesign from a high-level,
conceptual point of view. Later topics describe the specific step-by-step tasks involved.

2.5.1 Creating a new election for the first time
There are two methods to create (add) a new election for the first time in ClearDesign.

Method 1: use a supported import file type
1. If a state authority provides an import file containing jurisdiction- and election-specific data,

use this import file to add data to the first election that you create in ClearDesign.

See "Supported data import formats" on page 240.

2. Manually configure the ClearDesign settings that control ballot formatting and support for
ClearCount, ClearCast, and ClearAccess.

Method 2: manually enter all data required for an election, including:
1. All jurisdiction-specific and election-specific data

2. The ClearDesign settings that control ballot formatting and support for ClearCount, ClearCast,
and ClearAccess

2.5.2 Creating subsequent elections
To create subsequent elections, a jurisdiction can select one the following options:

l Repeat the steps in the previous topic (""Creating a new election for the first time" above")

or

l Create a template from the previous election

After creating a template, a jurisdiction can reuse the ClearDesign settings from the previous
election. By creating an election from a template, a jurisdiction avoids the labor-intensive steps
of reprogramming ballot formatting and support settings for other ClearVote products.
However, the process for creating a template requires significant setup as described in the next
topic (""Creating an election template" below").

2.5.3 Creating an election template
To create an election template, back up the existing election that you want to use as the baseline for
subsequent elections.

Clear Ballot recommends creating a template for each type of election.

Example: Suppose that the settings for general elections and primaries differ significantly in your
jurisdiction. In this situation, create a general-election template and a primary-election template.
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To create an election template:

1. Back up the election that you intend to use as a baseline for your template.

2. Restore the backed up baseline election and assign a name to distinguish it from any previous
election.

Clear Ballot recommends using a name in the format:

X template

where X is the election type.

Example: General election template

3. If newly created election contains import data from a state authority that was used for a
specific previous election, delete that data. Normally, delete the following fundamental
election entities:

◦ Voter Groups ◦ Splits

◦ District categories ◦ Contests

◦ Districts ◦ Candidates

◦ Precincts

If your jurisdiction does not use an import file, delete only the contests and candidates from
the previous election.

4. Once you delete any data that was specific to a previous election, back up the template so
that you can reuse it.

5. Restore the template and give it name specific to the election that you are setting up.

6. If your state provides an import file, import the file into the new election.

7. Double-check that all fundamental elections entities listed in step 3 were imported as
intended.

8. Assign vote centers to any new splits imported into the election.

9. Review the ballot layout.

10. Depending on the contents of the new election, reassign, delete, and create headers as
needed.
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2.6 Displaying the Info tab
When you click the Name cell of an entity in a list view, ClearDesign displays the corresponding Info
tab. The Info tab lists the current attributes (field values) of the entity.

For example, to display the Info tab for an individual election entity:

1. Select Elections from the Administration menu if it not already selected.

ClearDesign displays the Elections view in the contents pane on the right.

2. From the Elections view, click the Name cell for the desired election (Figure 2-13).

Figure 2-13. Selecting an election

ClearDesign displays an Info tab similar to Figure 2-14.

Figure 2-14. Info tab for an election

Buttons available from the Info tab
Buttons on the Info tab of an entity enable you to perform allowed actions on that entity.
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Example: The Info tab for an election entity contains the buttons listed in Table 2-2. Clear Ballot
recommends that you become familiar with the topics in the remainder of this chapter before using
these buttons.

Button See

Import Data "Importing data" on page 49

Export BDF "Exporting a ballot definition file (BDF or BDFx)" on page 232

Export ADF "Exporting an encrypted accessible definition file (ADFx)" on page 233

Backup "Backing up an election" on page 43

Restore "Restoring an election from a backup" on page 44

Edit "Editing an election" on page 45

Table 2-2. Buttons available on the Info tab of an election

Additional tabs available from the Info tab
Many Info tabs of entities displays additional tabs of related entities.

Example: When you display the Info tab of an election entity, ClearDesign also displays the
Languages, Voter Groups, District Categories, Election Districts, Contests, Headers, Ballot Sets, Vote
Centers, Images, Fonts, and Logs tabs.

2.7 Adding an election
To add (create) an election:

1. From the Administrationmenu, select Elections if it is not already selected.

The Elections tab appears in the content pane on the right.

2. From the Elections view, click Add.

ClearDesign displays the Election dialog (Figure 2-15).

Figure 2-15. Election dialog (Add mode)
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3. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

ClearDesign does not automatically prevent you from creating more than one election with
the same name. If you do so, both elections appear in the Elections view.

4. In Election Date, enter date in the format mm/dd/yyyy or click in the field to select a date
from the calendar tool.

ClearDesign requires you to enter or select a valid Election Date or you cannot save the
election. If you do not change the Election Date placeholder (mm/dd/yyyyy) and click Save,
ClearDesign displays the following message:

time data ' does not match format 'yyyy-mm-dd'

5. In Jurisdiction Name, enter the name of your election jurisdiction.

ClearDesign requires you to enter a Jurisdiction Name or you cannot save the election. If you
do not specify a Jurisdiction Name and click Save, ClearDesign displays the following message
under the Jurisdiction Name input field:

Field must not be empty

6. In Election Ballot Code, ClearDesign supplies an integer value from 1 to 2097151.

The Election Ballot Code is a system-supplied value that enables ClearVote products to
distinguish the ballots in the current election from the ballots in other elections. Under
normal circumstances, accept the system-supplied value.

The Election Ballot Code appears at the bottom of printed cards with the current precinct
and card style. A dash appears following the precinct and card style followed by EC: and the
Election Ballot Code as shown in Figure 2-16.

Figure 2-16. Example: Election Ballot Code at the bottom of a printed card, preceded by
the precinct

ClearDesign requires a value in Election Ballot Code field. If the field is empty, you cannot
save the election. If there is no value in Election Ballot Code field and you click Save,
ClearDesign displays the following message:

Field must not be empty
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7. (Optional) Clear Ballot recommends that you enter identifiers in the following fields:

o Official's Title
o Official's Name

8. (Optional) Import election data from a file.

You may import data when creating an election in the following situations:

l Some states provide import files containing jurisdiction-specific and election-specific data.
Using an import file avoids a large amount of manual data entry.

See "Supported data import formats" on page 240.

l In some rare situations, you may be required to import data contained in a BDF for testing
and verification.

To import data into the election:

a. In Import file, click Browse to locate and select the desired file.

b. Enter a Password, if required.

9. When you complete filling in the Election dialog, click Save.

ClearDesign displays a progress indicator as it creates the new election. When complete, the
new election appears on the Elections view.

If have specified an encrypted BDFx import file and click Save without supplying the correct
password, ClearDesign does not create the new election. Instead, ClearDesign displays the
message shown in Figure 2-17.

Figure 2-17. Error message: importing data from a BDFx and failing to supply a correct
password
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2.8 Backing up an election
This topic provides some guidelines for backing up an election and the backup procedure.

2.8.1 Guidelines for backing up elections
The following guidelines apply to backing up elections:

l ClearDesign allows you to back up and restore an election in any state.

l When you back up an election, all data is stored in CSV files that are collected in a single Zip file.
ClearDesign uses a hash of each table stored in a configuration file to ensure that no data is
modified.

l When you back up an election, you enter a Validation Code to supply when restoring the
election.

l Clear Ballot recommends storing backup files in a dedicated folder.

l For the technical and security details of backing up and restoring elections, see ClearDesign
Administration Guide.

2.8.2 Procedure for backing up an election
To back up an election:

1. From the Elections view, click the Name cell of the desired election.

2. From the Info tab, click Backup.

ClearDesign displays the Backup Election dialog (Figure 2-18).

Figure 2-18. Backup Election dialog

3. (Optional) Select Show Validation Code to display the characters as you type them in
Validation Code and Confirm Validation Code.

4. In Validation Code and Confirm Validation Code, enter the validation code provided by your
system administrator.
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5. Click OK to create the backup.

ClearDesign displays a status message while creating the backup.

When the backup is complete, ClearDesign displays the following message (Figure 2-19).

Figure 2-19. Backup complete message

6. Click Close.

7. To navigate to the location of the backup file, click the link that appears at the bottom of the
screen.

The usual location is the Downloads folder in your Windows User folder. The filename format
is:

ElectionName-yyyy-mm-dd hh-mm-backup.zip

2.9 Restoring an election from a backup
Before you restore an election from a backup Zip file, make sure that:

l The backup Zip file is available on your hard drive or USB drive.

l The backup filename ends in -backup.zip.

l You know the validation code or can get it from your system administrator.

To restore an election:

1. From the Elections tab, click Restore.

ClearDesign displays the Restore Election dialog (Figure 2-20).

Figure 2-20. Restore Election dialog

2. Click Choose File and navigate to the location of the desired backup.

3. (Optional) Select (check) Show Validation Code to display the characters as you type them in
Enter The Validation Code For File.
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4. In Validation Code, enter the code used to back up the election.

5. Click OK.

ClearDesign displays a confirmation message (Figure 2-21).

Figure 2-21. Confirmation message after restoring an election

Note: If you restore an election from a previous version of ClearDesign that did not
require an Election Ballot Code, ClearDesign generates one while restoring the
election. ClearDesign also issues a warning message to reprint any ballots and
regenerate the BDF and ADF.

6. Click Close.

The restored election appears on the Elections view in the order of the most recent sort.

7. If the name of the restored election has the same name as another election, assign a unique
name.

2.10 Editing an election
To edit settings for an existing election:

1. From the Elections view, locate the election.

2. Click the Edit button for the election.

ClearDesign displays the Election dialog (Figure 2-22).

Figure 2-22. Election dialog (Edit mode)
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3. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

For the Name of an election, use a maximum of 38 characters, including spaces, to ensure
that ClearCast and ClearCount can import the BDF or BDFx file.

4. (If necessary) In Election State, select one of: Election Created, Ballots Created, Cards
Created, or Media Created.

See "Election states" on page 35.

As you move through the process of setting up an election, the Election State becomes more
restrictive. The Election State is a safeguard that prevents you from accidentally invalidating
previous work. However, if a change is necessary, this field enables you to return the election
to an earlier state where you can make the change.

After ClearDesign has created media, do not change the Election State to a value that is
earlier than Media Created and then try to change the Name or Election Date. If you try to do
so, ClearDesign displays a warning message similar to Figure 2-23.

Figure 2-23. Warning message when changing the Name field of an election will
invalidate media.

If you proceed and change the Name or Election Date, ClearDesign replaces the existing
media hash, which makes it impossible to update the election in ClearCount. In ClearCount,
you must create a new election.

5. Modify the Jurisdiction Name if necessary.
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6. Modify the Election Ballot Code only if necessary.

Ordinarily, you will not change the Election Ballot Code. However, you may edit this field so
that the Election Ballot Code in the ADF and BDF matches the value on already-printed
ballots that will be tabulated in the current election.

If you change the Election Ballot Code after generating media, regenerate and print the cards
so that they contain the new value. If you change the Election Ballot Code and save the
election, ClearDesign displays a warning message of the effects of doing so. For example, if
you change the Election Ballot Code and save the election after printing cards, a warning
message to reprint the cards.

If you change the Election Ballot Code for an election, also generate a new ADF and BDF files.
Install the new BDF file on ClearCount and ClearCast. Install the new ADF file on ClearAccess.

7. (Optional) Clear Ballot recommends that you enter identifiers in the following fields:

o Official's Title
o Official's Name

8. (Optional) Deselect Encrypt BDF on Export.

By default, Encrypt BDF on Export is selected and ClearDesign exports an encrypted (BDFx)
file where the filename end in bdfx.zip.

Encryption reduces the vulnerability of brute-force attacks on the file's password. ClearDesign
uses the PDFKDF2 (Password-Based Key Derivation Function 2) encryption mechanism, which
is part of the RSA Laboratory Public-Key Cryptography Standards (PKCS).

To produce an unencrypted BDF file, deselect the Encrypt BDF on Export. An unencrypted
BDF filename ends in bdf.zip.

9. (Optional) Select the Straight Party Type.

The Straight Party Type field indicates how adjudication handles ambiguous cases where
marks appear in a straight-party voting (SPV) contest and in the partisan contests controlled
by the SPV contest. Table 2-3 lists the options for the Straight Party Type field.

Option Description

None (Default) If your jurisdiction does not use SPV, leave the default value of
None.

Exclusive An SPV-selected party choice applies only if all ovals of a partisan contest
are entirely blank. Otherwise, only the marked ovals are counted, and SPV is
not applied to that contest.

Table 2-3. Options for the Straight Party Type field
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Option Description

Exclusive
One Touch

This option uses the same logic as Exclusive. An exception occurs when
voting a straight-party ticket in ClearAccess and then selecting a choice
associated with a different party. In this situation, all the straight-party
choices become deselected and the choice associated with the different
party remains selected. Normal vote-selection rules apply when the
ClearAccess voter selects additional choices. For example, a voter receives a
warning if he or she tries to overvote the contest.

Override SPV overrides or ignores any existing marks in partisan contests

Combine The SPV-selected party choice is applied to the contest. If there are less
candidates for the select party than allowed choices, any marks for
additional candidates are counted. If the marked candidates plus the
candidates for the SPV-selected party will result in an overvote, only the
SPV-selected candidates are counted.

Additive The SPV-selected party choice is applied to the contest. Any marks for
additional candidates are counted. If the marked candidates plus the
candidates for the SPV-selected party will result in an overvote, the entire
contest is considered as overvoted, and no votes are counted.

Table 2-3. Options for the Straight Party Type field (continued)

10. (Optional) In Cross-Endorse Type, select one of options listed in Table 2-4.

Option Description

None
(Default)

The None option disables cross-endorsing candidates in the election.

If you select None, you can associate each candidate with only one Voter
Group in the dialog for each respective candidate. See "Adding or editing
candidates" on page 99.

On Ballot
Once

A cross-endorsed candidate receives a single oval that is endorsed by all
parties applicable to that candidate.

On Ballot for
each Voter
Group

A cross-endorsed candidate appears in a contest with unique ovals for each
party that endorses the candidate.

Table 2-4. Options for the Cross Endorse Type field
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11. (Optional) In Precinct/Split Reporting Threshold, enter the reporting threshold for use in
tabulation.

Any number of ballots less than this value appear obscured in ClearCount reports to protect
voter anonymity.

12. Click Save.

2.11 Importing data
This topic provides guidelines for importing and reimporting election data. This topic also describes
the import procedure.

2.11.1 Guidelines for importing election data
The following guidelines apply to importing election data:

l ClearDesign supports importing external data other than headers.

l Some state authorities provide jurisdictions with import files that contain jurisdiction and
election-specific information.

See "Supported data import formats" on page 240.

l During import, ClearDesign tests the data for required fields and formatting. If blue warning
messages appear when importing data into ClearDesign, check with the provider of the import
data to ensure that file contains the appropriate data and formatting.

l Import an election from a BDF or BDFx only for testing and data verification. Do not import
from a BDF or BDFx to create a new election.

2.11.2 Guidelines for reimporting election data
The following guidelines apply to reimporting election data:

l When you reimport a data source, ClearDesign compares the imported entities to existing
entities and does the following:

l o Adds new entities
o Updates existing entities as needed

l ClearDesign never deletes entities during the import process.

l Because importing can result in unintended results, do so only with the guidance of Clear Ballot
Technical Support.

l When you start to import new election data on top of an existing election, ClearDesign displays
a warning. If you proceed, ClearDesign bundles the two elections into one.
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2.11.3 Importing data into existing elections

Note: Before you import data into an existing election, contact Clear Ballot Technical Support.

To import data into an existing election:

1. Do one of the following:

l Select the election under development.

l Create an empty election.

ClearDesign displays the Info view for the election.

2. Click Import Data.

ClearDesign displays the Import Data Files dialog.

Figure 2-24. Import Data Files dialog

3. Click Browse.

The browser-specific File Upload dialog appears.

4. Locate and select the required data file.

5. Click OK to start importing data.

ClearDesign determines the format of the import file. See "Supported data import formats"
on page 240.

A status bar displays progress and a confirmation message appears upon completion.

6. Click Close.
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2.12 Deleting elections

Note: Before you delete an election, make sure to back it up. If you delete an election that
you have not backed up, you cannot recover it. See "Procedure for backing up an
election" on page 43.

To delete one or more elections:

1. From the Elections tab, select (check) the desired elections and click Delete.

2. When ClearDesign displays a confirmation message, click OK (Figure 2-25).

Figure 2-25. Example: confirmation message when deleting an election

ClearDesign deletes the elections and refreshes the screen.
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Chapter 3. Adding fonts and images

3.1 Objectives
After reading this chapter, you should be able to add fonts and images to an election.

3.2 Managing fonts
This section describes font management.

If you are required to add a font to an election, Clear Ballot recommends that you do so at an early
stage of election development after you have created or imported the election. Any font changes
can affect ballot text and layout.

3.2.1 Font support for languages
ClearDesign provides fonts for the following languages:

l Chinese

l English

l Korean

l Spanish

l Vietnamese

For additional fonts to support languages other than those listed above, contact Clear Ballot
Technical Support.

ClearVote products support up to 15 languages per election. In addition to the five languages
previously listed, the following languages are also supported:

l Danish

l Dutch

l Flemish

l French

l German

l Italian

l Japanese

l Norwegian

l Portuguese

l Swedish

3.2.2 Supported character sets
ClearDesign supports Unicode and the non-Latin character set, but not right-to-left languages.
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3.2.3 Installed font files
The following fonts are installed with ClearDesign:

l Noto-Sans-Ext.ttf supports the languages listed in Table 3-1.

l NotoSansCJKtc.ttf—Provides characters for the following languages:
o Chinese
o Japanese
o Korean

Language Fonts

Arabic NotoKufiArabic, NotoNaskhArabic, NotoNastaliqUrdu

Armenian NotoSansArmenian

Bengali NotoSansBengali

Gujarati NotoSansGujarati

Hindi NotoSansDevanagari

Persian NotoKufiArabic, NotoNaskhArabic, NotoNastaliqUrdu

Punjabi NotoSansGurmukhi

Urdu NotoNastaliqUrdu

Tagalog NotoSansTagalog

Telugu NotoSansTelugu

Table 3-1. Fonts in Noto-Sans-Ext.ttf

3.2.4 Displaying the Fonts view
To display the Fonts view, select one of these options:

l From the Election menu, click Fonts.

l From the Info View of an election, click the Fonts tab.

ClearDesign displays the Fonts view (Figure 3-1 on page 54).
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Figure 3-1. Fonts view (default columns shown)

Default fonts
The Fonts view displays the default fonts and any user-added fonts.

The default fonts, which you cannot delete, include:

l Inherit

l Noto Sans

l Noto Serif

l Noto Mono

The Noto fonts support Latin character-set languages, Russian, and Vietnamese.

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, and Code.

Action buttons available from the Fonts view
Table 3-2 lists the actions buttons available from the Fonts view.

Button Description

Add See "Adding a font to an election" on the next page.

Delete To delete a user-added font:

1. Select the check box corresponding to the desired font.

2. Click Delete.

Table 3-2. Actions buttons available from the Fonts view
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3.2.5 Adding a font to an election
To add a font to an election:

1. From the navigation pane, choose Fonts.

ClearDesign displays the Fonts view.

2. Click Add.

ClearDesign displays the Font dialog.

Figure 3-2. Font dialog

3. In Name, enter the user-defined name.

The font Name can contain only the characters a-z. A- Z, 0-9, - , or space.

If you leave the Name or Font Family fields blank, ClearDesign supplies the filename of the
font that you selected when using the Choose File button.

Note: Once saved, the Name cannot be changed.

4. In Font Family, supply a name.

Use the Font Family field to define a hierarchical list of fonts from left to right. If the first font
is unavailable, the browser tries the next font.

The following example shows a list for the Font Family field.

Example: "notosans, notosans-ext, notosans-ckj, sans-serif"

In this example, the browser does the following:

1. The browser tries to render the first font, notosans.

2. If notosans is unavailable, the browser tries to render the next font, notosans-ext.

3. The browser moves through the font list from left to right until it locates a font that
can render the desired character.

If none of the fonts listed can render a particular character, the default Windows black border
characters appear instead. In this situation, use an alternate font. Because ClearDesign's
installed fonts support all necessary languages, you can use them in this situation.

For a list of fonts installed with ClearDesign, see "Managing fonts" on page 52.
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5. In Sort Seq, enter the sorting index.

6. For Font File, click Choose File to navigate to and select a font file.

7. Click Save.

ClearDesign installs the font, and the user-defined name appears in the Font Name list in the
Ballot Text editor across the election.

3.3 Managing images
You can upload image files, such as party logos, signature facsimiles, and filled vote target
illustrations, and then add them to ballot headers. You cannot create or modify images within
ClearDesign.

ClearDesign supports all standard image file formats. However, for best performance, Clear Ballot
recommends using JPEG and PNG files. Because of their large size, bitmap (.bmp) files can slow
performance.

3.3.1 Displaying the images view
To display the Images view, select one of the following options:

l From the Election menu, click Images.

l From the Info view of an election, click the Images tab.

Figure 3-3 shows an example of the Images view.

Figure 3-3. Images view

Selectable columns
Selectable columns include: Sort Seq and Name.

Action buttons available from the Images tab
Table 3-3 on page 57 lists the action buttons available from the Images view.
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Button Description

Add See "Adding image files to an election" below.

Delete To delete an image:

1. Select the check box in the row corresponding to the desired image.

2. Click Delete.

Table 3-3. Action buttons available from the Images view

3.3.2 Adding image files to an election
To add an image file to an election:

1. From the Images view, click Add.

ClearDesign displays the Image dialog (Figure 3-4).

Figure 3-4. Image dialog

2. Do as follows:

a. Click Browse.

b. Navigate to the desired image on your computer and select it.

For optimal performance, Clear Ballot recommends using images in the 20 to 40 kB
range. If you navigate to and select an image that is 100 kB or larger, ClearDesign issues
the following warning message (Figure 3-5).

Figure 3-5. Warning message when uploading an image that is 100 kB or larger

c. Click Open.
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3. (Optional) In Name, modify the local filename.

4. (Optional) In Sort Seq, modify the sorting index.

5. Click Save.
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Chapter 4. Fundamental election entities

4.1 Objectives
After reading this chapter, you should be able to describe, add, and manage fundamental election
entities, which include:

◦ Voter Groups ◦ Splits

◦ District categories ◦ Contests

◦ Districts ◦ Candidates

◦ Precincts

You add and edit fundamental election entities after creating an election by entering data manually
or by using a template. See "Scenarios for creating elections in ClearDesign" on page 37.

4.2 Fundamental election entities: definitions
This section defines fundamental election entities.

Clear Ballot recommends that you become familiar with these basic definitions before reading the
details in the remainder of this chapter because the entities are related to one another.

Example: A contest entity, such as a race for president, is related to the individual candidate entities
who represent the individuals running for that office.

This section lists the entity definitions in the order in which you set them up in a typical election
workflow. This is the same order in which the remainder of this chapter presents these entities.

Voter group
Represents a political party.

Examples: Democrat, Republican, Libertarian

District category
A classification of geographic areas called districts. A district category enables a jurisdiction
to assign distinct geographic areas to certain types of public offices.

Example: Suppose that a jurisdiction has the following divisions for various public offices:

l Three zoning board districts that each elect a zoning officer. Zoning board is the
district category.

l Four school board districts that each elect two board members. School board is the
district category.
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l A mayor's race that covers the entire jurisdiction. Jurisdiction wide is the district
category.

District
A geographic subdivision of a jurisdiction associated with a type of public office that
represents the district.

Examples: First Congressional District, Second School Board District, and Third Zoning
Board District

See also the previous definition district category.

Precinct
A precinct is generally the smallest regional division in a jurisdiction. A given district may be
comprised of several precincts. A precinct is called an election district in some jurisdictions.

Split
Usually, a precinct is the smallest unit of organization for an election. In a precinct split or
split, some voters in a precinct elect an official for a given office in one district, while other
voters elect an official for the same office in another district.

Example: Suppose that a jurisdiction draws a boundary line for the 1st and 2nd School
Board districts straight through the middle of precinct ABC. In this situation, the ballots are
set up as follows:

l The voters on one side of the boundary line receive a ballot containing the candidate
choices for the seat of the 1st School Board district.

l The voters on the other side of the boundary line receive a ballot containing the
candidate choices for the seat of the 2nd School Board district.

In ClearDesign, each split is associated with a single precinct and only one district of each
district category.

Contest
A contest entity represents a single votable decision in an election.

Examples: A race for president or a referendum question

Candidate
A candidate entity represents a single votable choice for a contest.
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4.3 Voter groups
This topic describes how to manage voter groups.

4.3.1 Nonpartisan voter group
ClearDesign supplies a default voter group called Nonpartisan for each election that you create. By
default, ClearDesign assigns the Nonpartisan voter group to any entity that lacks a partisan voter
group affiliation.

ClearDesign does not allow you to delete the Nonpartisan voter group.

4.3.2 Displaying the Voter Groups view
To display the Voter Groups view of an election:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info tab, click the Voter Groups tab.

ClearDesign displays a Voter Groups view that is similar to Figure 4-1.

Figure 4-1. Voter Groups view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, and Track Registration.

Click Show / hide columns to select which columns appear in this view.

Action buttons available from the Voter Groups view
Table 4-1 on page 62 lists the action buttons available from the Voter Groups view.
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Button Description

Add "Adding or editing a voter group" below.

Delete To delete voter groups:

1. Select the check boxes in the rows corresponding to the voter groups that you
want to delete.

2. Click Delete.

You cannot delete the default Nonpartisan voter group.

Table 4-1. Action buttons available from the Voter Groups view

4.3.3 Adding or editing a voter group
1. Select one of the following options:

l To create a new voter group, click Add from the Voter Groups view.

l To edit the settings of an existing voter group, click Edit in one of the following locations:

o In the row corresponding to the desired voter group in the Voter Groups view
o In the Info view of the desired voter group

ClearDesign displays the Basic tab of the Voter Group dialog (Figure 4-2).

Figure 4-2. Voter Group dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.
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Note: The voter group with the lowest Sort Seq becomes the default for all for
unendorsed candidates in an election.

3. (Optional) Select (check) Endorse Contests.

By default, Endorse Contests is deselected.

If you select Endorse Contests, you can associate the voter group with contests. You select
this field to identify contests within a political party in a primary election.

After you select Endorse Contests, the Contests tab appears, but remains empty until you add
contests to the election and associate contests with the current voter group.

4. (Optional) Select (check) Track Registration.

By default, Track Registration is deselected.

If you select Track Registration, ClearCount can maintain a count of voter registration for the
current voter group.

After you select Track Registration, the Registration tab appears, but remains until empty you
add precincts and splits to the election.

5. (Optional) In the Ballot text editor, edit and format the text associated with the voter group.

Examples

The ballot text for a voter group is usually the name of a political party, such as "Democratic",
"Republican", or "Libertarian".

Text entry and formatting in the Ballot text editor
Text entry and formatting options in the Ballot Text editor are similar those in word
processing applications. For details, see "Formatting toolbar: Ballot Text editor" on page 243.

Inherited default formatting in the Ballot Text editor
Any formatting in the Ballot Text editor overrides any inherited formatting according to the
following precedence:

1. The Ballot Text editor inherits formatting from the Layout Style field value specified
for the first ballot set listed in the Ballot Sets view.

2. The Layout tab of the current entity overrides the formatting inherited from the
Layout Style field of the first ballot set.

3. Any local formatting in the Ballot Text editor of the current entity overrides the
formatting specified in the Layout tab of the current entity.
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Language tabs in the Ballot Text editor
The Ballot text editor has one tab for each language in the election. By default, languages
other than English inherit their formatting from the English tab. You can use the language
tabs to customize the text and formatting according to language.

If you add languages to an election, Clear Ballot recommends that you do so after all English
ballot text is stable. See "Adding languages and changing language settings" on page 206.

See Chapter 9, "Managing languages, device messages, and audio" on page 203.

6. Click Save.

If the change will delete registration counts, invalidate cards, and invalidate election media,
ClearDesign displays a confirmation message. The following image shows an example (Figure
4-3).

Figure 4-3. Confirmation message for changes to a voter group

7. Click OK to confirm the changes.

4.3.4 Displaying the Info tab for a voter group
To display the Info tab for an individual voter group, click the corresponding Name cell in the Voter
Groups view.

Figure 4-4 shows an example of an Info tab for a voter group whose Name is Democratic.

ClearDesign User Guide 64



Chapter 4.  Fundamental election entities

Figure 4-4. Info tab of a voter group

Basic section of the Info tab of a voter group
Most fields in the Basic section of an Info tab of a voter group are common to all entities. See
"Common attributes of entities" on page 241.

The only voter-group specific field that appears is Track Registration. The value of this field is True
when you have configured ClearDesign to keep a count of voter registration for the current voter
group.

The Ballot Text field displays a string associated with the voter group that is used as a label. For a
voter group, this string is an identifier for a political party, such as "Democratic."

Contest section of the Info tab of a voter group
This section lists all contests endorsed by the voter group. This list appears when a voter group is
configured to endorse contests, such as in a primary election. Each contest listed links to the
corresponding Info tab for that entity.

Additional tabs available from the Info tab of a voter group
Table 4-2 lists the tabs available from the Info tab of each individual voter group.
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Tab Description

Contests Displays a list of contests endorsed by the current voter group. See
"Displaying a Contests view" on page 83.

Candidates Displays a view of candidates affiliated with the current voter group.
See "Displaying a Candidates view" on page 97.

Voter Counts See "Managing voter counts" on page 77.

Logs The tab lists all events in the change history of this voter group.

Table 4-2. Tabs available from the Info tab of a voter group

Edit button on the Info tab of voter group
Click Edit to display the Voter Group dialog. See "Adding or editing a voter group" on page 62.

4.4 District categories
This topic describes how to manage district categories.

4.4.1 The default Jurisdiction Wide district category
ClearDesign supplies a default district category called Jurisdiction Wide for each election that you
create. ClearDesign provides this default to classify districts where voters in the entire jurisdiction
decide a contest, such as a race for mayor. Also, small jurisdictions may not need more than one
district category.

ClearDesign does not allow you to delete the Jurisdiction Wide district category.

4.4.2 Displaying the District Categories view
To display the District Categories view:

1. From the Administration menu, expand the Elections selection and click the name of the
desired election to select it.

ClearDesign displays the Election menu in the left navigation pane and the Info tab for the
selected election in the content pane.

2. From the Info tab of the election, click one of the following:

l The District Categories tab that appears in the same row as the Info tab in the content
pane.

l The District Categories selection from the Election menu in the navigation pane.

ClearDesign displays a District Categories view that is similar to Figure 4-5.
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Figure 4-5. District Categories view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Districts Count, Districts, Unassigned Splits Count, and Unassigned
Splits.

Click Show / hide columns to select which columns appear in this view.

Action buttons available from the District Categories view
Table 4-3 lists the action buttons available from the District Categories view.

Button Description

Add "Adding or editing a district category" on the next page.

Delete To delete district categories:

1. Select the check boxes in the rows corresponding to the district categories that
you want to delete.

2. Click Delete.

You cannot delete that default Jurisdiction Wide district category.

Table 4-3. Action buttons available from the District Categories view

Districts tab available from the District Categories view
The Districts tab that is available from the District Categories view displays a view of all districts
contained in an election. See "Displaying a Districts view" on page 70.
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4.4.3 Adding or editing a district category
1. Select one of the following options:

l To create a new district category, click Add from the District Categories view.

l To change settings of an existing district category, click Edit in one of the following
locations:

o In the row corresponding to the desired district category in the District Categories view
o In the Info view of the desired district category

ClearDesign displays the District Category dialog (Figure 4-6).

Figure 4-6. District Category dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Click Save.

4.4.4 Displaying the Info tab for a district category
To display the Info tab for an individual district category, click the corresponding Name cell in the
District Categories view.

Figure 4-7 shows an example of an Info tab for a district category.
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Figure 4-7. Info tab for a district category

Basic section of the Info tab of a district category
The fields in the Basic section of the Info tab of a district category are common to all entities. See
"Common attributes of entities" on page 241.

Splits by Districts section of the Info tab of a district category
This section lists the districts within the current district category and the splits assigned to each
district. For example, the Splits by District section in Figure 4-7 shows one district: Madison City
Limits Proper (not greater area). This district contains a single split: 01-center (Madison City Area) 10.
In this section, the names of districts and splits link to the Info tab for the corresponding entity.

Unassigned Splits section of the Info tab of a district category
This section lists any splits in the election that are not assigned to any district. The name of each split
in this section links to the Info tab of the corresponding entity.

Additional tabs available from the Info tab of a district category
Table 4-4 lists the tabs that are available from each Info tab of a district category.

Tab Description

Districts Displays a view of districts in the current district category. See "Displaying a Districts
view" on the next page.

Splits Displays a tab listing all splits for the current district category.

Logs The tab lists all events in the change history of this district category.

Table 4-4. Tabs available from the Info tab of a district category
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Action buttons available from the Info tab of a district category
The Info tab for a district category contains two action buttons: Add and Edit. See "Adding or editing
a district category" on page 68.

4.5 Districts
This topic describes how to manage districts.

4.5.1 The default Jurisdiction Wide district
ClearDesign supplies a default district called Jurisdiction Wide for each election that you create.
ClearDesign assigns this default district to the Jurisdiction Wide district category. See "The default
Jurisdiction Wide district category" on page 66.

4.5.2 Displaying a Districts view
ClearDesign provides two classes of Districts views:

l A Districts view of all districts in an election

To display this view:

1. From the Election menu, select District Categories.

2. When the District Categories tab appears, select the Districts tab

l A Districts view of only the districts in a specific district category

To display this view:

1. From the Election menu, select District Categories.

2. When the District Categories tab appears, click the Name cell of the desired district
category.

3. When ClearDesign displays the Info tab the for the selected district category, click the
Districts tab.

Figure 4-8 shows a Districts view that lists all districts in an election.

Figure 4-8. Districts tab showing all districts in an election
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Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, District Category, Precincts Count, Precincts, Splits Count, Splits, Contests Count, and
Contests.

Click Show / hide columns to select which columns appear in this view.

Delete button of a Districts view
To delete a District from a Districts View, select the check boxes corresponding to the districts that
you want to delete.

4.5.3 Adding or editing districts
To add a district to a district category or edit a district:

1. From the Election menu, select District Categories.

ClearDesign displays the Info tab for the district category.

2. Select one of the following options:

l To add a district, click Add District on the Info tab for the desired district category.

l To edit an existing district:

a. Click the Districts tab on the Info tab for the desired district category

b. On the Districts tab, click the Edit button in the row corresponding to the district that
you want to edit.

ClearDesign displays the District dialog with the Basic tab selected (Figure 4-9).

Figure 4-9. District dialog, Basic tab

3. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.
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Short names for districts must be unique.

4. In District Category, select the required district category.

5. Select the Splits view.

6. Check all splits required for the district.

Splits can be added and chosen later.

7. Click Save.

4.5.4 Displaying the Info tab for a district
To display the Info tab for a district, click the corresponding Name cell in the Districts view.

Figure 4-10 shows an example of an Info tab for a district.

Figure 4-10. Info tab for a District

Basic section of the Info tab of a district
Most fields in the Basic section of an Info tab of a voter group are common to all entities. See
"Common attributes of entities" on page 241.

The only district-specific field that appears is District Category. This field identifies the district
category to which the district belongs. This field links to the Info tab of the corresponding district
category entity.

Splits section of the Info tab for a District
The Splits section lists the splits for the current district. The name of each split links to the Info tab of
the corresponding entity.

Edit button on the Info tab of a district
Click Edit to display the District dialog. See Figure 4-10 on page 72.

Additional tabs available from the Info tab of a district
The Contest and Splits tabs list the contests and split entities associated with the current district.

The Log tabs lists all events in the change history of this contest.
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4.6 Precincts
This topic describes how to manage precincts.

Note: Some jurisdictions use the term election district instead of precinct. The term that you
see on ClearDesign screens depends the localization settings specified by your system
administrator.

4.6.1 Displaying the Precincts view
To display the Precincts view:

1. From the Administration menu, expand the Elections selection and click the name of the
desired election to select it.

ClearDesign displays the Election menu in the left navigation pane and the Info tab for the
selected election in the content pane.

2. From the Info tab of the election, select one of the following:

l The Precincts tab that appears in the same row as the Info tab in the content pane.

l The Precincts selection available from the Election menu in the navigation pane.

ClearDesign displays a Precincts view that is similar to Figure 4-11 on page 73.

Figure 4-11. Precincts view

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Splits Count, Splits, Districts, Contests, Ballot Groups, Ballots.

Click Show / hide columns to select which columns appear in this view.

Action buttons available from the Precincts view
Table 4-5 lists the action buttons available from the Voter Groups view.
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Button Description

Add See "Adding or editing a precinct" below.

Delete To delete precincts:

1. Select the check boxes in the rows corresponding to the
precincts that you want to delete.

2. Click Delete.

Voter Count See "Displaying voter counts" on page 77.

Import Voter Counts See "Importing voter counts" on page 78.

Export Voter Counts See "Exporting voter counts" on page 78.

Table 4-5. Action buttons available from the Precincts view

4.6.2 Adding or editing a precinct
To add a precinct:

1. Select one of the following options:

l To create a new precinct, click Add from the Precincts view.

l To change the settings of an existing precinct, click Edit in one of the following locations:

o In the row corresponding to the desired precinct in the Precincts view
o In the Info view of the desired precinct

ClearDesign displays the Basic tab of the Precincts dialog (Figure 4-12).

Figure 4-12. Precincts dialog, Basic tab
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2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. In Languages, uncheck any languages that are not needed for this precinct.

4. In Precinct Type, select Standard or Consolidated.

The Standard Precinct Type is the default. Use Standard except in special cases.

The Consolidated Precinct Type reduces the number of printed ballot styles in specific
situations by lumping a copy of all existing splits in other precincts into a new consolidated
precinct. This arrangement enables printing of the ballots for the consolidated precinct "by
style." The trade-off is the inability to report voter turnout by precinct.

Note: You cannot change the Precinct Type after saving the precinct settings.

Setup of consolidated precincts
When using consolidated precincts, assign them a unique ballot set to allow for ballots
printed by style within the consolidated precinct rather than for each split.

ClearCount reports lump all consolidated ballots under the consolidated precinct. Therefore,
the ballots cannot be filtered across geography.

The summary of voter turnout in ClearCount includes the consolidated precinct ballots in the
total. At the precinct level, the consolidated precinct ballots will not appear because they lack
geographical assignments.

5. For a standard precinct, select the Districts tab.
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6. Select the districts for the precinct.

Figure 4-13. Precinct dialog, Districts tab

7. Click Save.

4.6.3 Displaying the Info tab for a precinct
To display the Info tab for an individual precinct, click the corresponding Name cell in the Precincts
view.

Figure 4-14 on page 76 shows an example of an Info tab for a precinct. On this tab, the values of
some fields link to the Info tab for the corresponding entity.

Figure 4-14. Info tab for a precinct

ClearDesign User Guide 76



Chapter 4.  Fundamental election entities

Basic section of the Info tab of a precinct
Most fields in the Basic section of an Info tab of a voter group are common to all entities. See
"Common attributes of entities" on page 241.

The Info tab of a precinct also displays the following precinct-specific fields:

l Precinct Type is one of the following:
o The Standard Precinct Type is the default. Use Standard except in special cases.
o The Consolidated Precinct Type reduces the number of printed ballot styles in specific

situations by lumping a copy of all existing splits in other precincts into a new consolidated
precinct. This arrangement enables printing of the ballots for the consolidated precinct
"by style." The trade-off is the inability to report voter turnout by precinct.

l Splits—lists the splits into which the current precinct is subdivided

l Languages—lists the languages in which ballots are available in the current precinct

Districts section of the Info tab of a precinct
This section lists the District Categories and the individual districts within these categories that are
assigned to the current precinct.

Contests section of the Info of a precinct
This section lists all races available to voters in the current precinct.

Ballots section of the Info tab of precinct
This section lists the ballots available to votes in the current precinct.

4.6.4 Managing voter counts
This topic describes how to manage voter counts.

Also, see "Tracking registration counts by split" on page 83.

Displaying voter counts
To display voter counts, click Voter Count from the Precincts view.

ClearDesign displays the VoterCount dialog (Figure 4-15).

Figure 4-15. Voter Count dialog
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To clear voter counts, click Clear All and Save.

Importing voter counts
To import voter counts:

1. From the Precincts view, click Import Voter Counts.

ClearDesign displays the Import Voter Counts dialog.

Figure 4-16. Import Voter Counts dialog

2. (Optional) Check Add untracked Voter Group totals to the Nonpartisan total.

Some jurisdictions have voter registration files that include voter registration for both major
and minor parties. Only major parties normally get dedicated ballots in primary races, but the
jurisdictions still have minor party voters registered as belonging to a partisan party. If minor
parties are not expected to have a card, but the voters can vote in the election, Clear Ballot
recommends checking this box to reflect their totals in the non-partisan voter group.

Voter groups that do not have their own card in a split will report their voter registration
counts under the special "Registrants Without a Card" voter group.

3. In Select The Voter Counts File To Import, browse to and select the file.

4. Click OK.

Exporting voter counts
Precincts export voter counts for the following reasons:

l To update the voter registration file as a CSV file

l To convert data to the supported format so it can be reimported with different values

To export voter counts:

1. From the Precincts view, click Export Voter Counts.

ClearDesign displays the Export Voter Counts dialog (Figure 4-17).

Figure 4-17. Export Voter Counts dialog

2. Click OK.
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4.7 Splits
This topic describes how to manage splits, which are also called precinct splits.

4.7.1 Split identifiers
Split identifiers are relative ballot sequence numbers for ballot styles used within a precinct.
ClearDesign performs the sequencing. Users can choose between displaying split names or relative
numbers at the bottoms of ballot pages. Formats are:

l General elections: PrecinctId.BallotStyleIdWithinPrecinct

l Primary elections: PrecinctId.PartyId.BallotStyleIdWithinPrecinct

In a primary election, the total number of Party IDs is one more than the number of parties to allow
for nonpartisan choices.

4.7.2 Displaying a Splits view
ClearDesign provide two classes of splits views:

l A view of all splits in an election

To display this view:

1. From the Administration menu, select the desired election.

2. From the Election menu or Elections view, select Precincts.

3. From the Precincts view, click the Splits tab.

l A view of the splits of an individual precinct

To display this view:

1. From the Precincts view, click the Name cell of the desired Precinct.

2. When the Info tab of the precinct appears, click the Splits tab.

Figure 4-18 shows a Splits view that lists all splits of a precinct. The Splits view of an election has a
similar appearance but does not contain an Add button.

Figure 4-18. Splits view of a precinct
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Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Precinct, Precinct Sort Seq, Districts Count, Districts, Contests
Count, Contests, Ballot Groups Count, and Ballot Groups.

Click Show / hide columns to select which columns appear in this view.

4.7.3 Adding or editing splits
To add a split to a precinct or edit a split:

1. Select one of the following options:

l To edit an existing split from the view of all splits in an election:

1. From the Election menu, select Precincts.

2. When the Precincts view appears, click the Splits tab.

ClearDesign displays a view of all available splits in the election.

3. From the Splits view, click the Edit button in the row corresponding to the desired
split.

l To edit an existing split from the Splits view for an individual precinct:

1. Display the Info tab for a precinct by expanding Precincts in the Election menu and
clicking the name of an individual precinct or clicking the Name cell for an individual
Precinct in the Precincts view.

2. When the Info tab for the Precinct appears, click Add Split.

ClearDesign displays the Split dialog (Figure 4-19).

Figure 4-19. Split dialog
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2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

Note: Clear Ballot recommends a unique abbreviation for each split. If the
abbreviations are not unique, ballot generation appends _1, _2, and so on to
ballot IDs.

3. In Precinct, select the required precinct.

4. In Languages, uncheck languages that are not required.

5. Select the District tab.

6. Check all districts required for the split.

7. Click Save.

4.7.4 Displaying the Info tab of a split
To display the Info tab of a split, click the corresponding Name cell in the Splits view.

Figure 4-20 shows an example of an Info tab for a split. On this tab, the values of some fields (shown
in blue) link to the Info tab for the corresponding entity.

Figure 4-20. Info tab of a split
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Basic section of the Info tab of a split
Most fields in the Basic section of the Info tab of a split are common to all entities. See "Common
attributes of entities" on page 241.

The Basic section also displays some split-specific fields:

l Precinct—The name of the precinct that contains the current split

l Languages—The languages in which ballots are available in the split

Districts section of the Info tab of a split
This section lists the district categories and districts to which the split belongs.

Contests section of the Info tab of a split
This section lists the races that voters in the split can decide.

Ballots section of the Info tab of a split
This section lists the ballots that are available to voters in the split.

4.7.5 Associating splits with a language
You associate a split with a language to generate a ballot for that language for any applicable ballot
sets for the split.

To associate splits with a language:

1. From the navigation pane, choose Languages.

The Languages view appears.

2. Locate the language you want to associate with splits.

3. Click the Edit button to the desired language.

ClearDesign displays the Languages dialog.

4. Select the Splits tab.

5. Select (check) each split that you want to associate with the language.

Unchecked splits are not associated with the language.

6. Click Save.
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4.7.6 Tracking registration counts by split
To track registration counts by split:

1. From the navigation pane, choose Precincts.

ClearDesign displays the Precincts view (Figure 4-11 on page 73).

2. From the main pane, select the Splits tab.

3. Click the Edit button for the split.

ClearDesign displays the Split dialog (Figure 4-19 on page 80).

4. Select the Registration tab.

Note: Registration tracking must be enabled for the tab to be visible. If necessary, see
"Adding or editing a voter group" on page 62 for instructions.

5. For any entity in the Voter Group column, increase or decrease the headcount in the
Registration Count column.

6. Click Save.

Also, see "Managing voter counts" on page 77.

4.8 Contests
This topic describes how to manage contests.

4.8.1 Displaying a Contests view
ClearDesign displays two types of Contests views:

l A view of all contests in an election

To display this view, take one of the following actions:
o From the Election menu, click Contests.

or
o Follow these steps:

1. From the Election view, click the Name cell for the desired election.

2. When the Info tab for the desired election appears, click the Contest tab that appears
between the Precincts and Headers tabs.
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l A view of contests endorsed by a specific voter group

To display this view, do the following:

1. From the Election menu, select Voter Group.

2. When the Voter Group view appears, click the Name cell of the desired voter group.

3. When the Info tab of the desired voter group appears, click the Contests tab that appears
next to the Info tab.

ClearDesign displays a Contests view that is similar to Figure 4-21.

Figure 4-21. Contests view—all contest in an election (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Contest Type, District, Voter Groups, Vote For, Contest Rotation,
#Cand, Candidates, Pref Contest, Straight Party Contest, Recall Contest, Warn Overvote, Warn
Undervote, and Warn Blank Vote.

Click Show / hide columns to select which columns appear in this view.

Actions buttons available from the Contests view
Table 4-6 lists the action buttons available from the Contests view.

Button Description

Add "Adding or editing contests" on the next page"Adding or editing contests" on the next
page.

Delete To delete contests:

1. Select the check boxes of the contests that you want to delete.

2. Click Delete.

Table 4-6. Action buttons available from the Contests view
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Candidates tab
See "Displaying a Candidates view" on page 97.

4.8.2 Adding or editing contests
Select one of the following options:

l To create a new contest, click Add from the Contests view.

l To edit the settings of an existing contest, click the Edit button in one of the following locations:
o In the row corresponding to the desired contest in the Contests view
o In the Info view of the desired contest

ClearDesign displays the Contest dialog with the Basic tab selected by default (Figure 4-22).

Figure 4-22. Contest dialog, Basic tab

Editing the Basic tab of a contest
To edit the basic tab of a contest:

1. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

The Short Name of a contest must be unique.

Controlling contests (Straight Voter Group or Primary Preference) must have lower Sort Seq
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values than the contests they control. ClearDesign validates this requirement.

2. In Contest Type, choose from the selections listed in Table 4-7.

Contest type Purpose Prerequisites

Candidate (Default) A standard contest where a voter
selects one or more candidates for an
office depending on value of the Vote For
field.

N/A

Question A question or measure with only Yes and
No choices. ClearDesign automatically
adds the Yes and No choices as
candidates.

N/A

Retention Similar to a Question with Yes and No
choices. ClearDesign automatically adds
the Yes and No choices as candidates.

N/A

Recall Similar to a Question with a Yes choice.
ClearDesign automatically adds a single
Yes choice as a candidate. You can
manually add a No choice if it is
appropriate for your jurisdiction.

N/A

Table 4-7. Guidelines for selecting the Contest Type
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Contest type Purpose Prerequisites

Primary Preference This selection designates the controlling
contest for a primary preference contest.

For this Contest Type, the contests of
multiple parties and Nonpartisan contests
appear on a single ballot. The voter can
choose which party's contests to vote for.

ClearDesign automatically creates choices
corresponding to each partisan voter
group (political party) and the Nonpartisan
voter group that can endorse candidates.

After you create this contest, the Pref
Contest drop-down appears on the Basic
Contest tab when the Contest Type is
Candidate.

See "Guidelines for primary preference
contests in ClearDesign" on page 104 and
"Setting up primary preference contests"
on page 105.

At least two voter
groups that can
endorse contests
must exist in the
election.

ClearDesign does not
support primary
preference contests
with cross-endorsed
candidates.

Straight Voter
Group

The controlling contest where a voter
chooses a party for straight party voting.
Votes will be assigned to choices on
contests controlled by this contest
according to the rules of the straight party
type selected.

After you create this contest, the Straight
Party Contest drop-down appears on the
Basic tab of each Candidate contest.

See "Setting up straight party contests" on
page 108.

The Straight Party
Type must be set
appropriately in the
main Election
Information tab.

Table 4-7. Guidelines for selecting the Contest Type (continued)
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Contest type Purpose Prerequisites

Judge's Initials Used if a box for judge initials is a required
(or optional) feature on the ballot.

The contest creates a single default choice
with a line for the initials; more choices
can be created.

If judge initials are required, the default
behavior is to reject the ballot if no judge
initials are found on the ballot. The values
ofWarn Undervote andWarn Blank Vote
must be Reject.

If judge initials are optional, do not use
Reject as the values ofWarn Undervote
andWarn Blank Vote. Use any other
available value for these fields (Inherit,
Warn, No).

N/A

Table 4-7. Guidelines for selecting the Contest Type (continued)

If you select a Contest Type of Primary Preference or Straight Voter Group, ClearDesign
displays an additional tab that lists their controlled contests.

For straight party elections and open primaries, Clear Ballot recommends that jurisdictions
edit device messages to suit their specific requirements and circumstances.

3. Fill in the fields of the Contests dialog that are listed in Table 4-8 on page 89.

The fields listed in this table that appear in the Contest dialog depend on the Contest Type
that you selected.

ClearDesign User Guide 88



Chapter 4.  Fundamental election entities

Field Description

Vote For Select the number of candidates that voters can choose
according to the voting rules for the contest.

Applies to Contest Type: Candidate and Judge's Initials.

Autogenerate Write-ins Select if applicable. This option creates a number of write-in
candidates equal to the vote rule when you save the
contest. If you select this option before adding other
candidates, the write-ins have lower sequence numbers and
will appear on the ballot. You can change the sequence
number of each write-in candidate individually.

Applies to Contest Type: Candidate and Retention

District Select the applicable district.

Applies to Contest Type: Candidate, Question, Retention,
Recall, Straight Party Contest.

Voter Groups Select the political party applicable to the contest.

Applies to Contest Type: Candidate, Question, Retention,
Recall.

Pref Contest Select No Primary Preference or select the name of the
Primary Preference contest if you want primary preference
rules to apply to the current contest.

The Pref Contest field appears only if you have previously
created a Primary Preference contest.

Table 4-8. Contest-specific fields of the Contest dialog
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4. Select a Contest Rotation value listed in Table 4-9

The Contest Rotation field applies to a Contest Type of Candidate. Different types of
rotations groups have different requirements.

Regardless of the rotation type, the following requirements must be met to edit the Contest
Rotation field values:

l The election must be in the Election Created state.

l At least one Voter Group must exist have Endorse Contests selected (checked).

By default, the Nonpartisan Voter Group that is created with the election has Endorse
Contests selected.

l ClearDesign requires that one Voter Group must be assigned to the contest before
rotation can take place.

By default, the Nonpartisan Voter Group is assigned to the contest.

Several rotation types depend on voter counts. The following criteria apply to rotation types
that depend on voter groups:

l The applicable voter groups must have Track Registration selected (checked).

l The Voter Count dialog must contain values for the listed precincts. (See "Displaying voter
counts" on page 77.)

Rotation Groups: To set Rotation Groups, enter an integer value in the Rotation Group field
of the Candidate dialog when you add candidates. (See "Adding or editing candidates" on
page 99.)

The following integer values apply to rotation order:

l -1—does not rotate.

l 0 or higher—rotates in a group.

Example: All candidates assigned an integer value of 0 rotate within a group; all candidates
assigned an integer value of 1 rotate within a group; and so on.

Value Description

No Rotation If you select No Rotation, the card and card style are equivalent.

Precinct
Rotation

Precincts are sorted by their Sort Seq value. The rotation of candidates
occurs every time a new precinct is selected when producing ballots.
The candidates move by one position.

District
Rotation

The list of candidates rotates on each district in the district category
that is selected in the District Category field. The candidates move by
one position.

Table 4-9. Selections for the Contest Rotation field

ClearDesign User Guide 90



Chapter 4.  Fundamental election entities

Value Description

Voter Count
Precinct
Rotation

Precincts are sorted by their voter registration counts in descending
order to determine the choice order. The rotation of candidates occurs
every time a new precinct is selected when producing ballots.

Grouped
Precinct
Rotation

Precincts are combined into groups based on the number of rotations
needed and the voter registration counts of each precinct. This rotation
method ensures that the name of each candidate will appear at the top
of the list of candidates on an equal number of ballots.

The following criteria apply to Group Precinct Rotation:

l The number of rotations needed for a contest is based on the
number of candidates.

l ClearDesign determines the base average of voter registrations
per possible precinct group.

l Precincts are added to a group only in sort-sequence order.

l Each precinct is added to a group until the voter registration count
is approximately equal within each grouping.

l When a contest is cross-endorsed by two or more parties,
ClearDesign uses the sum of the voter registration counts of all
applicable parties.

Balanced
Precinct
Rotation

Balanced precinct rotation differs from Grouped Precinct Rotation in
that precincts may be added to groups out of sort sequence order.

The following criteria apply to Balanced Precinct Rotation:

l The number of rotations needed for a contest is based on the
number of candidates.

l ClearDesign determines the base average of voter registrations
per possible precinct group.

l Precincts are added to groups out of sort-sequence order.

l Each precinct is added to a group until the voter registration count
is approximately equal within each grouping.

l When a contest is cross-endorsed by two or more parties,
ClearDesign uses the sum of the voter registration counts of all
applicable parties.

Table 4-9. Selections for the Contest Rotation field (continued)
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5. Select values for the remaining fields of the Contest dialog as listed in Table 4-10.

Field Description

Rotation
District
Category

Select Jurisdiction Wide or a particular district.

For District Rotation, the list of candidates rotates on each district in
the district category.

Applies only when Contest Rotation = District Rotation.

Straight Party
Contest

Select No Straight Voter Group or select the name of the Straight Voter
Group contest if you want Straight Voter Group rules to apply to the
current contest.

The Straight Party Contest field appears only if you have selected a
Straight Party Type for the election and have added a controlling
contest.

Applies to Contest Type: Candidate

Recall contest Select No Recall or select a recall contest from the list.

Applies to Contest Type: Candidate

Warn
Undervote

Select one of: Inherit, Warn, No, or Reject

For a Contest Type of Judge's Initials, selectWarn Undervote = Reject
andWarn Blank Vote = Reject if judge initials are required for the
ballot to be valid.

Warn Overvote

Warn Blank
Vote

Table 4-10. Additional contest-specific fields

6. (Optional) In the Ballot Text editor, edit and format the text associated with the contest.

Examples
l For a Contest Type of Candidate, the Ballot Text is the name of the office, such as

"President of the U.S."

l For a Contest Type of Question, the Ballot Text can be a referendum decision, such as:
Proposition 101: Shall the budget of the Parks Board be increased by $2,000,000 to
construct a fire-prevention facility?"

Text entry and formatting in the Ballot text editor
Text entry and formatting options in the Ballot Text editor are similar those in word
processing applications. For details, see "Formatting toolbar: Ballot Text editor" on page 243.
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Inherited default formatting in the Ballot Text editor
Any formatting in the ballot text editor overrides any inherited formatting according to the
following precedence:

1. The Ballot Text editor inherits formatting from the Layout Style field value specified
for the first ballot set listed in the ballot sets view.

2. The Layout tab of the current entity overrides the formatting inherited from the
Layout Style field of the first ballot set.

3. Any local formatting in the Ballot text editor of the current entity overrides the
formatting specified in the Layout tab of the current entity.

Language tabs in the Ballot Text editor
The Ballot text editor has one tab for each language in the election. By default, languages
other than English inherit their formatting from the English tab. You can use the language
tabs to customize the text and formatting according to language.

If you add languages to an election, Clear Ballot recommends that you do so after all English
ballot text is stable. See "Adding languages and changing language settings" on page 206.

Editing the Layout tab of a contest
Before you use the Layout tab, make sure that you understand how the formatting of ballot text is
inherited. See "Inherited default formatting in the Ballot Text editor" above.

To edit contest layouts:

1. Select the Layout tab (Figure 4-23).

Figure 4-23. Contest dialog, Layout tab

2. Configure contest-specific layout options as follows:

a. (Optional) In Num Columns, select the number of columns to span on the ballot.

b. (Optional) In Candidate Columns, select the number of columns for candidates or choices
to span within the contest.
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c. (Optional) In Candidate Rows, select the amount of space to insert between candidates
or choices.

3. Edit the Default Style section of Contest dialog.

The Default Style section has tabs where you can customize some settings according to the
languages in the election.

4. When you complete editing the contest, click Save.

4.8.3 Displaying the Info tab for a contest
To display the Info tab for a contest, click the corresponding Name cell in the Contest view.

Figure 4-24 shows an example of an Info tab for a contest.

Figure 4-24. Info tab of a contest

Basic section of the Info tab for a contest
Most fields in the Basic section of an Info tab for a contest are common to all entities. See "Common
attributes of entities" on page 241.

ClearDesign User Guide 94



Chapter 4.  Fundamental election entities

For an explanation of the contest-specific fields in the Basic section of the Info tab, see Table 4-7 on
page 86 and Table 4-8 on page 89.

The Ballot text field in the Basic section contains a string that identifies the public office that the
contest will decide. The Ballot text field contains a tab for each language supported in the election.

Candidates section of the Info tab for a contest
This section lists the candidates that are running for office in the current contest.

Layout section of the Info tab for a contest
For more information, see "Editing the Layout tab of a contest" on page 93.

Additional tabs available from the Info tab for a contest
Table 4-11 lists the additional tab that are available from the Info tab for a contest.

Tab Description

Candidates See "Displaying a Candidates view" on page 97.

Splits See "Displaying a Splits view" on page 79.

Ballot Styles See "Displaying the Ballot Styles view" on page 175

Ballots "Displaying the Ballots view" on page 176

Card Styles "Displaying the Card Styles view" on page 180

Cards See "Displaying the Cards view" on page 182

Card Style Contests This tab lists all the cards for the contest and the location of the
contest on the card.

Candidate Voter Groups This tab lists all candidates in an election and the voter group
(political party) associated with each candidate.

Log The tab lists all events in the change history of this contest.

Table 4-11. Additional tabs available from the Info tab for a contest

Action buttons available from the Info tab for a contest
Table 4-12 lists the action buttons that are available from the Info tab for a contest.

Button Description

Edit See "Adding or editing contests" on page 85.

Add Candidate See "Adding or editing candidates" on page 99.

Table 4-12. Action buttons available from the Info tab for a contest
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4.8.4 Endorsing contests by voter group
When working with primary elections, it is often important to associate contests with one or more
voter groups. Associating a contest with more than one voter group is calledmulti-party contest
endorsement.

In open primaries, where all contests appear on the same ballot, a jurisdiction may want to endorse
contests belonging to a particular voter group so that the contests are affected by a corresponding
header.

For example, suppose that a jurisdiction wants the following arrangement on a ballot:

l Column 1— Democratic contests

l Column 2—Republican contests

l Column 3—Nonpartisan contests

In this situation, the jurisdiction imports the contests into ClearDesign in a mixed sequence. To
obtain the desired column arrangement, the jurisdiction can the endorse the contests by their
respective voter groups.

When applying a contest header endorsed by a particular voter group across all these contests, only
the contests belonging to a particular voter group move into the corresponding header's column.
Thus, a jurisdiction can sort mixed voter-group endorsed contests into different columns by using
this method.

In closed primaries, a jurisdiction may want each voter group to have a separate ballot. If the option
Separate Voter Group Ballots is selected on the ballot set, the contests for a partisan voter group
appears on the ballot corresponding to that voter group and not on other ballots.

Note: Nonpartisan endorsed contests appear on all ballots. Use nonpartisan endorsed
contests for measures that are not partisan-specific.

If a larger political party allows members of a smaller political party to vote on a ballot measure, the
voter groups for both parties must endorse the contest. The major party must appear first in the
voter-group sequence order. ClearCount reports only by the first endorsement on a given contest.
Therefore, it is important for the larger party to have a lower sort sequence. Otherwise, the contest
results get reported under the smaller party's results.

To endorse contests by voter group:

1. Ensure the required contests are created.

2. From the navigation pane, choose Voter Groups.

The Voter Groups view appears.

3. Click the Edit button for the voter group.

The Voter Group dialog appears.
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4. Ensure Endorse Contests is clicked On.

5. Select the Contests tab (Figure 4-25).

Figure 4-25. Voter Group dialog—Contests tab

6. Select all contests required for the voter group.

7. Click Save.

Alternatively, the nonpartisan voter group or one or more partisan voter groups can endorse a
contest. To set the endorsements on a contest:

1. Go to the Contests view, locate the desired contest, and click the Edit button.

See "Displaying a Contests view" on page 83.

2. When the dialog for the desired Contest appears, select (check) the desired options in the
Voter Groups field and click Save.

If a desired option does not appear in the Voter Groups field, edit the corresponding voter group to
allow contest endorsements. You can then select that voter group as shown in Figure 4-25 or edit
the contest.

If a contest is endorsed by multiple voter groups and contains non-partisan candidates, only the first
party's endorsement will be applied to the candidates for the sake of reporting or determining
straight party vote applicability. If multiple party endorsements for the sake of straight party voting
or reporting are required, the non-partisan candidates must be endorsed specifically by all required
parties.

4.9 Candidates
This topic describes how to manage candidates.

4.9.1 Displaying a Candidates view
ClearDesign provides three types of Candidates views:

l A view of all candidates in an election

To display this view:

1. From the Election menu, select Contests.

2. Click the Candidates tab next to the Contest tab in the content pane.

ClearDesign User Guide 97



Chapter 4.  Fundamental election entities

l A view of the candidates in a specific contest

To display this view:

1. From the Election menu, select Contests.

2. When the Contests view appear, click the Name cell for the desired contest.

3. When the Info tab for the select contest appears, click the Candidate tab that appears next
to the Info tab in the content pane.

l A view of candidates affiliated with a specific voter group

To display this view:

1. From the Elections menu, select Voter Groups.

2. When the Voter Groups view appears, click the Name cell for the desired voter group.

3. When the Info tab for the selected voter group appears, click the Candidates tab that
appears between the Contest and Voter Counts tabs.

Figure 4-26 shows an example of a view of all candidates in an election.

Figure 4-26. Candidates view—all candidates in an election (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Contest Type, District, VoterGroups, Vote For, Contest Rotation,
#Cand, Candidates and Pref Contest.

Click Show / hide columns to select which columns appear in this view.

Action buttons available from a Candidates view
Table 4-13 lists the buttons available from a Candidates view.
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Button Description

Add The Add button is available only from the view of all candidates in specific contest.

See "Adding or editing candidates" below

Delete To delete a candidate:

1. Select the check boxes in the rows corresponding to the candidates that you
want to delete.

2. Click Delete.

Table 4-13. Buttons available from a Candidates view

4.9.2 Adding or editing candidates
To add a candidate to a contest:

1. Select one of the following options:

l To add a candidate to an election:

1. From the Contests view, click the Name cell of the contest where you want to add a
candidate.

2. When the Info tab for the contest appears, click Add Candidate.

l To edit an existing candidate, click the Edit button in the row corresponding to the desired
candidate from the Candidates view for the entire election or from the Candidates view
for an individual contest.

ClearDesign displays the Candidate dialog

Figure 4-27. Candidate dialog

If the Contest Type is Question or Retention, ClearDesign automatically creates Yes and No
choices.
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If the Contest Type is Recall, ClearDesign automatically creates a Yes choice.

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Edit the candidate-specific fields listed in Table 4-14.

Field Description

Contest Select Straight Voting or a specific contest.

Candidate
Type

Select one of the following:

l Candidate is a votable choice related to the oval that appears beside it.

l Write-in is where a voter can write a choice.

l Label is used for informational purposes.

Voter
Groups

Select a voter group.

If Candidate Type is Write-in, the endorsement must be nonpartisan.
ClearDesign does not allow partisan endorsement of write-in candidates.

Specify the Ballot Order.

If the candidate is cross-endorsed, click Add and enter the required values
in Voter Groups and Ballot Order once for each additional cross-
endorsement.

Rotation
Group

Enter an integer value for rotation order.

The following integer values apply to rotation order:

l -1—does not rotate.

l 0 or higher—rotates in a group.

Example: All candidates assigned an integer value of 0 rotate within a
group; all candidates assigned an integer value of 1 rotate within a group;
and so on.

This field is tied to the Contest Rotation field on the Contest dialog. (See
"Adding or editing contests" on page 85 for more information).

If Contest Rotation = No Rotation, this field is not enabled and any integer
values entered will not affect rotation.

Table 4-14. Candidate-specific fields
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4. (Optional) In the Ballot Text editor, enter and format text associated with the candidate.

Examples
The ballot text associated with a candidate is his or her name. For example, in the 2016 U.S.
president, the ballot text for the Democratic candidate was "Hillary Clinton". The ballot text
for the Republican candidate was "Donald Trump".

Text entry and formatting in the Ballot text editor
Text entry and formatting options in the Ballot Text editor are similar those in word
processing applications. For details, see "Formatting toolbar: Ballot Text editor" on page 243.

Inherited default formatting in the Ballot Text editor
Any formatting in the Ballot Text editor overrides any inherited formatting according to the
following precedence:

1. The Ballot Text editor inherits formatting from the Layout Style field value specified
for the first ballot set listed in the Ballot Sets view.

2. The Layout tab of the current entity overrides the formatting inherited from the
Layout Style field of the first ballot set.

3. Any local formatting in the Ballot Text editor of the current entity overrides the
formatting specified in the Layout tab of the current entity.

Language tabs in the Ballot Text editor
The Ballot text editor has one tab for each language in the election. By default, languages
other than English inherit their formatting from the English tab. You can use the language
tabs to customize the text and formatting according to language.

If you add languages to an election, Clear Ballot recommends that you do so after all English
ballot text is stable. See "Adding languages and changing language settings" on page 206.

See "Adding languages and changing language settings" on page 206.

5. Click Save.

4.9.3 Displaying the Info tab for a candidate
To display the Info tab for a candidate, click the corresponding Name cell in the Candidates view.

Figure 4-28 shows an example of an Info tab for a candidate.
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Figure 4-28. Info tab for a candidate

Basic section of the Info tab for a candidate
Most fields in the Basic section of an Info tab of a candidate are common to all entities. See
"Common attributes of entities" on page 241.

The Basic section also contains some candidate-specific fields. See Table 4-14 on page 100.

The Ballot Text field of the Basic section contains the name of the candidate as it appears on the
ballots. This field contains a tab for each supported language in the election.

Edit button
See "Adding or editing candidates" on page 99.
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Chapter 5. Setup of advanced election types

5.1 Objectives
This topic describes the tasks associated with advanced election types. Advanced election types
include general elections that support straight party voting and the various types of primaries. You
set up advanced election types after entering the basics for an election as described in "Scenarios for
creating elections in ClearDesign" on page 37.

After reading this chapter, you should be able to:

l Describe the various type of elections: general election, primary election, and the various types
of primary elections

l Describe the differences between setting up general elections and primaries

l Set up the following:
o A general election that supports straight party contests
o Open and closed primaries
o Primary preference contests

5.2 General elections, primary elections, and classification of
primaries
This topic defines the terms general and primary election. This topic also describes the classification
of primaries according to voter eligibility. It is helpful to understand these terms and their
applicability to your jurisdiction when performing advanced election-setup tasks.

general election
A general election allows voters to choose among candidates for a slate of public offices.
General elections occur at local, state, and federal levels, and typically occur at regular
intervals. (In some situations, special elections may occur at irregular times to elect a
replacement for a seat vacated by death, resignation, or removal from office.)

primary election
A primary election narrows the field of candidates or determines the nominees of political
parties for public offices that will run in a general election. A primary election occurs some
time before a general election.

In general, primary elections are of two types:

l In a partisan primary, voters select a candidate to be a political party's nominee for a
given office in the general election.

ClearDesign User Guide 103



Chapter 5.  Setup of advanced election types

l Nonpartisan primaries narrow the field of candidates for nonpartisan offices before a
general election.

The rules for participating in a primary can vary by jurisdiction, political party, and political
office. The methods for determining the results of a primary can also vary according to
jurisdiction.

Table 5-1 classifies primaries in terms of voting eligibility.

Primary type Description

Open A voter is not required to affiliate with a political party or can
declare a party affiliation on the day of the primary, even if
the voter previously affiliated with a different party.

Closed A voter must declare an affiliation with a political party and
receives a ballot containing only candidates from the
affiliated party and any nonpartisan contests. Voters who do
not affiliate with a political party usually receive a ballot
containing only nonpartisan contests.

Semi-closed Previously unaffiliated voters can cast a ballot in the partisan
primary of their choice. Voters who previously affiliated with
a political party can vote only in that party's primary.

Top-two All candidates appear on the same primary ballot. The top
two candidates who receive the most votes for an office,
regardless of party, advance to the general election. As the
result of the top-two primary, two candidates from the same
party can face off for the same office in a general election.

Table 5-1. Classification of primaries according to voter eligibility

5.3 Guidelines for primary preference contests in ClearDesign
This topic provides some guidelines for primary preference contests based on the type of primary.

Open primaries
If your jurisdiction runs an open primary, Clear Ballot recommends setting up a primary preference
contest to guard against cross-voting between political parties. (For implementation details and an
example, see the next section "Setting up primary preference contests" on the next page.) Cross-
voting occurs when a voter marks ovals for multiple parties in a primary race. Most jurisdictions
disallow cross-voting and disqualify the entire ballot when it contains any cross-voted contests.
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Closed or semi-closed primaries
If your jurisdiction runs closed or semi-closed primaries, follow these guidelines:

l When you set up the ballot set, select the Separate Voter Group Ballots check box.

ClearDesign generates a ballot for each voter group that includes contests endorsed by the
voter group and any nonpartisan contests. The generated ballots include a ballot for the
Nonpartisan voter group that unaffiliated voters receive.

l When you set up each voter group, select Endorse Contests.

Top-two primaries
The setup for a two-two primary is similar to a general election. All candidates of all parties appear
as choices for a given contest. No special setup is necessary for top-two primaries.

5.4 Setting up primary preference contests
The primary preference functionality allows a jurisdiction to include the candidates of multiple
parties for the same political offices on a single ballot for a primary election.

A primary preference contest entity links to partisan contests and controls them. First, you set up the
primary preference contest and then link to it from the individual partisan contests. To set up the
links, select the name of the primary preference contest in the Pref Contest fields of the individual
partisan contests. ClearDesign then populates the controlling primary preference contest with the
names of the controlled contests.

When casting a vote in a primary preference contest, a voter must specify a political party. Only
choices for the selected party get counted. Choices for any other party are ignored. If the voter does
not select a party for the primary preference contest, ClearCount or ClearCast detects a cross-voted
ballot, rejects it as invalid, and indicates that it requires a review.

For example, suppose that a jurisdiction holds a primary election that includes races for the following
political offices:

l President of the United States

l U.S. Senate

To set up this primary preference example, follow these guidelines:

1. Create an election from scratch or from a template.

See "Scenarios for creating elections in ClearDesign" on page 37.

For this example, suppose that the Name of the election is March 2019 Primary Preference.

2. Edit the fundamental election entities according to the requirements of your jurisdiction and
the guidelines provided in the remainder of this procedure.

See "Fundamental election entities" on page 59.
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3. To meet the requirements for a primary preference election, make sure that you have
defined at least two voter groups and that you have selected the Endorse Contests check box
in the Voter Group dialogs.

See "Adding or editing a voter group" on page 62.

For this example, the election contains the following voter groups:

l Nonpartisan—The required default voter group that ClearDesign automatically creates.

l Republican

l Democratic

4. Set up the controlling contest for the primary preference election.

The controlling contest links the partisan contests for the same office.

To set up the controlling contest for this example:

a. From the Contests view, click Add.

See "Adding or editing contests" on page 85.

b. When ClearDesign displays the Contest dialog, assign a meaningful Name, such as:
Primary Preference Controlling Contest.

c. Fill in the common attributes and other fields of the Contest dialog to meet your
requirements.

d. In the Contest Type, select the value Primary Preference.

The Party Controlled Contests tab appears but remains unpopulated until you add the
contests controlled by the Primary Preference Controlling Contest.

e. Click Save.

5. Set up a partisan contest associated with each voter group for each political office in the
election.

(If you import data in a supported format when you create the election, you do not have to
complete the manual setup described in the remainder of this step.)

To follow through with the example described earlier in this topic, suppose that a primary
preference election includes races for President of the United States and the U.S. Senate. In
this situation, set up two contests for President and two contests for U.S. Senate. The result
will be the following contests:

l President of the President of the U.S.-Republican

l President of the President of the U.S.-Democratic

l U.S. Senate-Republican

l U.S. Senate-Democratic
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For example, to set up the contest for president associated with the Democratic voter group:

a. From the Contests View, click Add.

See "Adding or editing contests" on page 85.

b. When ClearDesign displays the Contest dialog, assign a Name to identify the contest
associated with a voter group such as: President of the U.S-Democratic.

c. Fill in the common attributes and other fields to meet your requirements.

d. In Pref Contest, select the name of the controlling contest.

In this example, select Primary Preference Controlling Contest.

e. Select the voter group to associate with this contest.

In this case, select Democratic. This selection includes the contest on the Democratic
partisan ballot and associates the contest with the headers for the Democratic party.

f. Add the candidates to the contest.

See "Adding or editing candidates" on page 99.

To set up the remaining contests, use the previous steps as a guideline.

After you set up the controlling contest, partisan contests, and candidates associated with the
contests, go to the Contest view and click the Name cell of the controlling contest Primary
Preference Controlling Contest. When ClearDesign displays the Info tab for the Primary
Preference Controlling Contest, the Primary Party Controlled Contests section shows the
associated partisan contests as shown in Figure 5-1.

Figure 5-1. Example: Primary Party Controlled Contest section of an Info tab for a
controlling contest

If you click the Edit button on the Info tab of a contest, ClearDesign displays the Contest
dialog. On the Contest dialog, click the Primary Party Controlled Contests tab to edit the
associated partisan contests. Figure 5-2 shows an example.

Figure 5-2. Example: Primary Party Controlled Contests tab of the Contests dialog.
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5.5 Setting up straight party contests
This topic defines straight party voting, describes its characteristics, and provides guidelines for
setting up straight party contests.

What is straight party voting?
Straight party voting is the practice of allowing a voter to select all candidates endorsed by a specific
voter group (political party) in an election. Depending on the requirements of the jurisdiction, a
voter may be able to override the choices endorsed by a voter group for individual contests. Straight
party contests are used for general elections.

Characteristics of straight party contests: dynamic and conditional
A straight party contest is dynamic because it gets automatically populated with the choices based
on voter group options associated with a particular ballot style.

A straight party contest is also considered conditional:

l If a given ballot style does not contain candidates endorsed by a particular voter group, that
voter group does not appear on the ballot style. However, that voter group appears on other
ballot styles associated with that voter group.

l If no valid partisan voter groups appear on a given ballot, the straight party contest also does
not appear on that ballot style because there are no options to select.

Guidelines for setting up straight party contests
Follow these guidelines to set up straight party contests:

1. Create an election from scratch or from a template.

See "Scenarios for creating elections in ClearDesign" on page 37.

2. Open the Election dialog and set the values for the following fields:

l For Straight Party Type, select one of the available selections applicable to your
jurisdiction.

See Table 2-3 on page 47.

l In Cross-Endorse Type, make sure to select the option that aligns with the requirements
of your jurisdiction.

See Table 2-4 on page 48.

3. Edit the fundamental election entities according to the requirements of your jurisdiction and
the guidelines provided in the remainder of this procedure.

See "Fundamental election entities" on page 59.

ClearDesign User Guide 108



Chapter 5.  Setup of advanced election types

4. Set up a controlling contest.

To set up a controlling contest:

a. From the Contests view, click Add.

See "Adding or editing contests" on page 85.

b. When ClearDesign displays the Contests dialog, assign a meaningful name such as: SP
Controlling Contest.

c. Fill in the common attributes and other fields to meet your requirements.

d. In Contest Type, select Straight Voter Group.

The Straight Party Controlled Contests tab appears but remains unpopulated until you
add the contests associated with the SP Controlling Contest.

e. Click Save.

f. In Voter Groups, select Nonpartisan.

g. Click Save.

5. Set up the contests for each political office in the election.

To add an individual contest:

a. From the Contests view, click Add.

b. When ClearDesign displays the Contest dialog, assign a meaningful name to identify
the contest.

c. Edit the common attributes to meet your requirements.

d. In Contest Type, select Candidate.

e. In Voter Groups, select Nonpartisan

f. In Straight Party Contest, select the name of the controlling contest.

g. Click Save.

6. For the contest representing each political office in the election, add a candidate endorsed by
each voter group participating in that contest.

See "Adding or editing candidates" on page 99.

After you set up the controlling contest, the contests for each office, and the candidates for each
contest, go to the Contests view and click the Name cell of the controlling contest. When
ClearDesign displays the Info tab for the controlling contest, the Straight Party Controlled Contests
section lists the individual contests as shown in Figure 5-3 on page 110.
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Figure 5-3. Straight Party Controlled Contests section of Info tab of a controlling contest

If you click the Edit button on the Info tab of a controlling contest, ClearDesign displays the Contests
dialog. On the Contests dialog, click the Straight Party Controlled Contests tab to edit the associated
individual contests. Figure 5-4 shows an example.

Figure 5-4. Example: Straight Party Controlled Contests tab of the Contests dialog

Conditions that invalidate cards for Straight Party contests
Certain changes affecting straight party contests invalidate some existing card layouts. When you try
to save any of the following changes, ClearDesign issues a confirmation message and requires you to
click OK to continue:

l Adding, changing, or removing a party on a controlling contest

l Changing any of the following on an individual straight party contest:
o Adding a candidate
o Changing the party affiliation (voter group) of a candidate
o Changing the controlling contest (updating the Straight Party Contest field)
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Chapter 6. Adding support for downstream products

6.1 Objectives
This chapter describes ClearDesign entities that support downstream products in the ClearVote
family. Downstream products include ClearAccess, ClearCast, and ClearCount.

After reading this chapter, you should be able to:

l Define and manage vote center categories, vote centers, and device types

l Describe the following relationships:
o Vote centers and device types
o Device types and ClearCount, ClearCast, and ClearAccess

l Define and manage counter groups and explain their relationship to ClearCount

6.2 Definitions of entities that support downstream products
This topic defines vote center categories, vote centers, and device types.

Vote center category
A vote center category entity is a classification of the types of venues where voters cast ballots. Two
typical vote center categories are:

l Early voting—A location where voters can cast ballots during a state-designated number of days
before election day

l Election day—A location where voters can cast ballots during designated hours on election day

Vote center
A vote center entity represents a physical location, such as a school, firehouse, or municipal building,
where voters cast ballots and the ballots are processed. The precincts allowed at a vote center entity
in ClearDesign mirror the physical organization of voters and election workers for an election.

Vote centers can be associated with all splits or with specific splits in an election. ClearCast and
ClearAccess must be associated with a specific vote center. ClearCast and ClearAccess are restricted
to accepting or producing ballots only for the associated splits of the vote center.

Examples:

l A central-count vote center for handling absentee and mail-in ballots can receive and process
ballots from voters who live in all precincts.

l A precinct-based, election-day vote center admits only voters from specified precinct splits.
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Device types and devices
Vote center entities are associated with device types. There are two device types:

l Paper scanner

The ballot definition file (BDF), created by ClearDesign and uploaded to the paper-tabulation
products ClearCount and ClearCast, supports the paper scanner device type.

Associating a vote center with a paper scanner enables ClearCast to select this vote center.

l Accessible marker

The accessible definition file (ADF) file, created by ClearDesign and uploaded to ClearAccess,
supports the accessible marker device type.

Associating a vote center with the accessible marker allows ClearAccess to select this vote
center during election setup on a given machine.

By default, ClearDesign creates one paper scanner and one accessible marker device type for each
election. Both device types are unconfigured.

Counter groups
A counter group identifies a group of voters by code for reporting purposes. The names, IDs, and
number of counter groups can vary by jurisdiction.

Examples:

l Election Day (ED)

l Provisional (PR)

l Absentee (AB)

l Early voting (EV)

Various ClearCount reports can display or filter vote totals by counter group. See the ClearCount
Reporting Guide.

6.3 Displaying the Vote Center Categories view
To display the Vote Center Categories view, click the corresponding menu selection from the Election
menu.

Figure 6-1 on page 113 shows an example of a Vote Center Categories view. This view shows two
categories: Election Day and Early Voting. ClearDesign automatically creates the Election Day vote
center category by default for each election.
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Figure 6-1. Vote Center Categories view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Vote Centers, Vote Centers Count, Device Types, Device Types Count,
Counter Groups, Counter Groups Count, Print Zero Count, and Print Result Count.

Click Show / hide columns to select which columns appear in this view.

Action buttons available from the Vote Center Categories view
Table 6-1 lists the action buttons available from the Vote Center Categories view.

Button Description

Add See "Adding or editing a vote center category" on the next page.

Delete To delete a vote center category:

1. Select the check boxes in the rows corresponding to the vote centers that you
want to delete.

2. Click Delete.

Table 6-1. Action buttons available from the Vote Center Categories view

Additional tabs available from the Vote Center Categories view
Table 6-2 list the additional tabs available from the Vote Center Categories view.

Tab Description

Vote Centers Displays a view of all vote centers in an election.

See "Displaying a Vote Centers view" on page 117.

Device Types Displays a view of all device types in an election.

See "Displaying the Device Types view" on page 120.

Counter Groups Displays a view of all counter groups in an election.

See "Displaying the Counter Groups view" on page 127.

Table 6-2. Additional tabs available from the Vote Center Categories view
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6.3.1 Adding or editing a vote center category
To add or edit a vote center category:

1. From the Election menu, select Vote Center Categories.

2. When the Vote Center Categories view appears, do one of the following:

l To edit an existing vote center category, follow one of these paths:

Path 1:

a. From the Vote Center Categories view, click the desired Name cell.

b. When the Info tab for the select vote center category appears, click Edit.

Path 2:

From the Vote Center Categories view, click the Edit button in the row corresponding to
the desired vote center.

l To create a new vote center category, click Add in the Vote Center Categories view.

The Vote Center Category dialog appears (Figure 6-2).

Figure 6-2. Vote Center Category dialog

3. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.
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4. Edit the fields specific to vote center categories described in Table 6-3.

Field Description

Auto Create Vote
Centers

Select this check box to create a vote center automatically for
any precinct that does not already have a vote center
associated with it.

Each vote center category is treated independently. If a
precinct is used by a vote center in a different vote center
category, but not by the one being currently autogenerated, it
still generates a vote center.

Devices By default, ClearDesign provides one device for each vote
center. You can edit the Device Type and Ballot Set values
associated with this device, but you cannot delete it.

To add devices, do the following:

1. Click Add to append a row.

2. In Device Type, select one of: Paper Scanner or
Accessible Marker.

3. In Ballot Set, select All or the name of a specific ballot
set.

Counter Groups Select the appropriate check boxes to associate counter
groups with the current vote center category.

Print Zero Count The number of reports printed as the ClearCast unit boots. The
reports should zero out all candidates and contests to show
that no vote has been cast.

Print Result Count The number of reports printed when the polls close.

Table 6-3. Fields specific to vote center categories

5. Click Save.

Multiple ballot sets and vote center categories
If your election has multiple ballot sets, make sure to set the Ballot Set values in each Vote Center
Category dialog correctly. You can create multiple instances of a Device Type to cover multiple ballot
sets if you want to include more than one (but not all) ballot sets. Figure 6-3 on page 116 shows an
example. In this example, the Device Type Accessible Marker is associated with Ballot Set 20 and
Ballot Set 30.

Ballot sets not included in any vote center category are unavailable in ClearAccess for the Device
Type Accessible Marker or ClearCast for the Device Type Paper Scanner.
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Figure 6-3. Example: multiple ballot sets associated with Device Type Accessible Marker

6.3.2 Displaying the Info tab for a vote center category
To display the Info tab for a vote center category, click the corresponding Name cell in the Vote
Center Categories view.

Figure 6-4 shows an example of an Info tab for a vote center category.

Figure 6-4. Info tab for a Vote Center Category
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Fields on the Info tab for a vote center category
Most fields on the Info tab for a vote center category are common to all entities. See "Common
attributes of entities" on page 241.

The Auto Create Vote Centers, Devices, and Counter Groups fields are specific to vote center
categories. See Table 6-3 on page 115.

Action buttons available from the Info tab of a vote center category
Table 6-4 lists the action buttons available from the Info tab of a vote center category.

Button Description

Edit "Adding or editing a vote center category" on page 114.

Add Vote Center See "Adding or editing vote centers" on the next page.

Table 6-4. Action buttons available from the Info tab for a vote center category

6.4 Displaying a Vote Centers view
ClearDesign provides two types of Vote Centers views:

l A view of all vote centers in an election

To display this view:

a. Display the Vote Center Categories view.

b. Click the Vote Centers tab.

l A view of all vote centers in a specific vote center category

To display this type of view:

a. Display the Vote Center Categories view.

b. From the Vote Center Categories view, click the Name cell of a vote center category.

c. When ClearDesign displays the Info tab for the desired vote center category, click the Vote
Centers tab.

When you create a new election from scratch, no vote centers are present. ClearDesign requires you
to add one vote center before you can generate election media.

Figure 6-5 show example of a view of all vote centers in an election.
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Figure 6-5. Vote Centers view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, and Vote Center Category.

Action buttons available from the Vote Centers view
Table 6-5 lists the action buttons available from the Vote Centers view.

Button Description

Add The Add button is available only from the view of all vote centers in a specific vote
center category. See "Adding or editing vote centers" below.

Delete To delete a vote center:

1. Select the check boxes in the rows corresponding to the vote centers that you
want to delete.

2. Click Delete.

Table 6-5. Action buttons available from a Vote Centers view

6.4.1 Adding or editing vote centers
When you create a new election from scratch, no vote centers are present. ClearDesign requires you
to add one vote center before you can generate election media.

To add a vote center to a vote center category:

1. Do one of the following:

l To edit an existing vote center:

a. From a Vote Centers view, click the Name cell of the desired vote center.

b. When ClearDesign displays the Info tab for the vote center, click Edit.
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l To add a new vote center:

a. Display the Vote Center categories view.

b. From the Vote Center categories view, click the Name cell for the desired vote center.

c. When ClearDesign displays the Info tab for the selected vote center, click Add Vote
Center.

ClearDesign displays the Vote Center dialog (Figure 6-6).

Figure 6-6. Vote Center dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Specify the Number of Devices.

See "The number of devices associated with each vote center" on the next page.

4. In the Precincts section, select All Precincts or select the check boxes for each individual
precinct that you want to add to the current vote center.
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6.4.2 The number of devices associated with each vote center
The Vote Center dialog of ClearDesign enables you to specify the number of devices configured for
each vote center in an election.

Why ClearDesign stores the numbers of devices associated with each vote center
Jurisdictions import elections defined in ClearDesign into ClearCount. When jurisdictions import
election results into ClearCount, they must reconcile the number of devices programmed for an
election with the number of devices specified for each vote center.

This arrangement ensures that a jurisdiction has not lost a USB drive containing data from a given
scanner or failed to load the data.

Tracking of accessible markers is optional. A jurisdiction that tracks additional markers can print a
report showing the number of devices sent to each location.

Storing the number of paper scanners in the BDF
When you export an election to a BDF, ClearDesign stores the number of paper scanners for each
vote center in the votecenters.csv file of the BDF. The field is called NumPaperScanners.

Paper scanners are equivalent to ClearCast units. Jurisdictions use the number of scanners value to
confirm that they have accounted for all USB drives before certifying an election. If the number of
ClearCast units or USB drives changes after the initial rollout of an election, update the number of
paper scanners and export a new BDF. Then merge the BDF into ClearCount election to update the
record of the expected number of paper scanners.

Specifying the number of accessible markers
Although you can specify the number of Accessible Markers in ClearDesign, the BDF does not
currently store this value.

6.5 Device types
By default, ClearDesign creates one paper scanner and one accessible marker device type for each
election. Both device types are unconfigured.

This section describes how to configure and manage the paper scanner and accessible marker device
types.

6.5.1 Displaying the Device Types view
To display the Device types view:

1. From the Election menu, select Vote Center Categories.

2. From the Vote Center Categories view, select the Device Types tab.
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Figure 6-7 shows the Device Types view with the default paper scanner and accessible marker device
types.

Figure 6-7. Device Types view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Device Class, Warn Overvote, Warn Undervote, Warn Blankvote, Warn Crossover, Warn
Partyover, Warn Prefover, Warn Blankcard, Warn StraightParty, Print Override, Sound On, Print
Ovals Only, Offset X, Offset Y, Media Date, Media Version, Media Copy, Media Hash, Encryption Key
ID, and Election Key ID.

Media fields for a device type
ClearDesign stores the status of a device type in four system-generated fields listed in Table 6-6.
These fields remain blank until you export the election to a BDF.

Field Description

Media Date Date and time of the export.

Media Version Version identifier, starting with 1. This number only increments with
the next download if the data in the election has changed. (This
includes changes to items such as ballots styles, card layouts, contests,
or candidates.)

Media Copy Number that increments with each download of the media file,
regardless of whether the data in the election has changed.

Media Hash Changes when any of the following are modified:

l Election identity (name or date)

l Card IDs or positioning

Use theMedia Hash to verify the integrity of the BDF and ADF files.
Both the ADF and BDF store the Media Hash in the config.json file.

Table 6-6. Media fields for a device type
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6.5.2 Configuring a paper scanner device type
The paper scanner device type refers to ClearCount and ClearCast. To configure a paper scanner
device type:

1. From the Device Type view, click Edit in the row corresponding to a paper scanner.

The Device Type dialog appears (Figure 6-8).

Figure 6-8. Device Type dialog, paper scanner selected

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Edit the fields listed in Table 6-7.
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Field Optional,
Req., Read only

Description

Device Class Read only Paper Scanner

Show Passwords Optional When selected, passwords appear in the Device
Type dialog as you type them.

Election
Password,
Confirm Election
Password

Required The election password for ClearCount and
ClearCast.

Pollworker
Password,
Confirm
Pollworker
Password

Required The poll worker password for ClearCast.

Encryption Key
ID

Read only The value of the last 4 digits of the sha256 hash of
the encryption key in hex format. This allows you to
identify the encryption key in use.

Reset Encryption
Key

Optional Select this check box to change the encryption key
used for encrypting the BDFx file.

Election Key ID Read only The value of the last 4 digits of the sha256 hash of
the election key in hex format. This allows you to
identify the election key in use.

Reset Election
Key

Optional Select this check box to change the election key
used for authentication of the BDFx file.

The followingWarnmessages apply to ClearCast. When you select the check box
associated with a given type of warning, ClearCast issues a warning when the applicable
event occurs.

You can also set warnings on individual contests. See "Adding or editing contests" on
page 85.

Warn Overvote Optional Issue a warning upon detecting an over vote

Warn Undervote Optional Issue a warning upon detecting an under vote

Table 6-7. Fields for the Paper Scanner Device Type
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Field Optional,
Req., Read only

Description

Warn Blank Card Optional Issue a warning upon detecting a blank card. You
can enable the blank card warning only on the
Device Type dialog. You cannot set this value for an
individual contest.

Warn Straight
Voter Group
Overvote

Optional Issue a warning upon detecting an over vote for a
straight party contest

Warn Primary
Preference
Overvote

Optional Issue a warning upon detecting an over vote for a
primary preference contest

Print Override Optional This field is not currently operational. It is reserved
for future use.

Inactivity
Timeout

Optional This field is not currently operational; it is reserved
for future use.

Cancel Timeout Optional This field is not currently operational; it is reserved
for future use.

Table 6-7. Fields for the Paper Scanner Device Type (continued)

4. Click Save.
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6.5.3 Configuring the accessible marker device type
An accessible marker type refers to ClearAccess. To configure the accessible marker device type for a
vote center:

1. From the Device Type view, click Edit in the row corresponding to an accessible marker.

The Device Type dialog appears (Figure 6-9).

Figure 6-9. Device Type: Accessible Marker dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Edit the fields listed in Table 6-8.

ClearDesign User Guide 125



Chapter 6.  Adding support for downstream products

Field Optional,
Req., Read
only

Description

Device Class Read only Accessible Marker

Show Passwords Optional When selected, passwords appear in the Device Type
dialog as you type them.

Election Password,
Confirm Election
Password

Required The election code used in ClearAccess to load the
election ADFx.

Pollworker
Password, Confirm
Pollworker Password

Required The poll worker code for ClearAccess.

Voting Password,
Confirm Voting
Password

Required The voter code for the ClearAccess election.

Encryption Key ID Read only The value of the last 4 digits of the sha256 hash of
the encryption key in hex format. This allows you to
identify the encryption key in use.

Reset Encryption Key Optional Select this check box to change the encryption key
used for encrypting the ADFx file.

Election Key ID Read only The value of the last 4 digits of the sha256 hash of
the election key in hex format. This allows you to
identify the election key in use.

Reset Election Key Optional Select this check box to change the election key used
for authentication of the ADFx file.

Warn Under Vote Optional Issue a warning upon detecting an undervoted
contest

Warn Blank Vote Optional Issue a warning upon detecting an unvoted contest

IfWarn Blankvote andWarn Undervote are both
checked,Warn Blankvote is used for vote for 1
contests.

Warn Straight Voter
Group Change

Optional Issue a warning upon detecting an over vote for a
straight party contest

Table 6-8. Fields for the Accessible Marker Device Type
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Field Optional,
Req., Read
only

Description

Sound On Optional Enables audible sound

Print Ovals Only Optional This field is not currently operational; it is reserved
for future use.

Inactivity Timeout Optional After this amount of inactivity on the ClearAccess
unit, a pop-up window appears. This window asks if
the voter wants to continue.

Cancel Timeout Optional ClearAccess logs the voter out after this amount of
inactivity following an Inactivity Timeout message.

Table 6-8. Fields for the Accessible Marker Device Type (continued)

4. Click Save.

6.6 Displaying the Counter Groups view
To display the Counter Groups view:

1. From the Election menu, select Vote Center Categories.

2. From the Vote Center Categories view, select the Device Types tab.

Figure 6-10 shows an example of a Counter Groups view.

Figure 6-10. Counter Groups view

Selectable columns
Selectable columns include: Name, Short Name, Abbreviation, Import ID, Export ID, Last Edit By, Last
Edit Time, Log Count, and Sets Precincts Reporting.

Action buttons available from the Counter Groups view
Table 6-9 lists the action buttons available from the Counter Groups view.
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Button Description

Add See "Adding or editing a counter group" below.

Delete To delete a counter group:

1. Select the check boxes in the rows corresponding to the counter groups that
you want to delete.

2. Click Delete.

Table 6-9. Action buttons available from the Counter Groups view

6.6.1 Adding or editing a counter group
To add or edit a counter group:

1. Do one of the following:

l To add a new counter group:

a. From the Election menu, select Vote Center Categories.

b. From the Vote Center Categories view, select the Counter Groups tab.

c. When ClearDesign displays the Counter Group view, click Add.

l To edit an existing counter group:

a. From the Election menu, select Vote Center Categories.

b. From the Vote Center Categories View, click Edit in the row corresponding to the
desired counter group.

ClearDesign displays the Counter Group dialog (Figure 6-11).

Figure 6-11. Counter Group dialog
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2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

ClearCount uses the value of the Abbreviation field of a counter group in data presented by
web reports and on target cards (which conventionally use two-character alphabetic codes).
Inform Clear Ballot of all counter group abbreviations before your target cards are prepared.

3. (Optional) Select Sets Precincts Reporting.

The Sets Precincts Reporting check box affects the ClearCount PDF report headers and the "X
precincts reported out of Y total" message on the ClearCount Dashboard. The value X
indicates the number of precincts that have scanned ballots, and the value Y indicates the
total number of precincts.

In ClearCount, it is possible to manually override a precinct as reported. This is useful when
no ballots are scanned in a reporting counter group for a given precinct. For more
information, see the ClearCount Reporting Guide.

Note: In the count of reporting precincts, consolidated precincts are counted as a
regular precincts.

Default values: The default Sets Precincts Reporting values for the three counter groups
automatically created by ClearDesign are:

l Election Day (ED)—True

l Early Voting (EV)—False

l Absentee (AB)—False

Example 1: Suppose that Sets Precincts Reporting is true for a counter group that has
scanned three regular precincts and one consolidated precinct. In this situation, the message
on the ClearCount Dashboard appears as "4 precincts reported out of 4 total".

Example 2: Suppose that Election 2 has Absentee and Election Day ballots. However, the
jurisdiction considers only the Election Day ballots in the count of precincts that have scanned
ballots.

For this election, the jurisdiction keeps the default value of true for the Sets Precincts
Reporting check box of the Election Day counter group. No matter how many absentee
ballots are scanned, ClearCount considers only Election Day ballots when displaying the
number of precincts that have scanned ballots. If no Election Day ballots end up being cast in
a particular precinct, the ClearCount administrator can manually mark the precinct as
reported.

ClearDesign User Guide 129



Chapter 6.  Adding support for downstream products

Example 3: A jurisdiction wants to include Election Day, Absentee, and Early Voting ballots
when counting the number of precincts that have scanned ballots for Election 2.

For this election, all three corresponding counter groups must have a Sets Precincts
Reporting value of true. Any precinct that scans a ballot in any of the three counter groups is
counted in the "X precincts reported out of Y total" message.

If a precinct scans even a single ballot, it is counted in the "X precincts reported out of Y total"
message.

4. Select at least one of the Vote Center Categories.

5. Click Save.

6.6.2 Displaying the Info tab for a counter group
To display the Info tab for a counter group, click the corresponding Name cell in the Counter Groups
view.

Figure 6-12 shows an example of an Info tab for a counter group.

Figure 6-12. Info tab for a counter group

To change any of the setting for this counter group, click the Edit button and follow the steps in
"Adding or editing a counter group" on page 128
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Chapter 7. Setting up and laying out ballots

7.1 Objectives
This topic describes the tasks for setting up and laying out ballots.

After reading this chapter, you should be able to set up and lay out ballots and manage the entities
associated with these tasks. For definitions of the entities associated with ballot setup and layout,
see the next section.

7.2 Definitions of entities associated with ballot setup and layout
This topic defines entities associated with ballot setup and layout.

If you are a new user of ClearDesign, become familiar with these terms before reading the remainder
of this chapter. This topic presents the terms in the order that they appear in the remainder of this
chapter.

Header
Headers are the main tool for formatting ballots. Settings of headers determine the position of
contests on ballots. Headers also manage non-contest text, such as titles, instructions, and
separators.

Ballot
A ballot is an entity that contains all contests in an election. A contest can represent a decision on a
candidate for a particular office or a decision such as a referendum question or the recall of a
previously elected official.

The physical representation of a ballot can vary. For example, a ballot can appear on a printed card
or on the screen of an accessible voting device.

Ballot set
A ballot set is a group of ballots the share the same dimensions and stylization. The first ballot set in
an election, called Standard, must contain all contests. However, additional ballot sets can contain
only a subsection of contests.

Jurisdictions often use additional ballot sets to create ballots that have formatting and dimensions
that differ from the Standard ballot set.

Jurisdictions can also create ballots sets for categories of voters that can vote only on subsets of
contests in an election. For example, some jurisdictions allow nonresident property owners to vote
on certain referendum questions.

All ballot groups, ballot styles, and ballots roll up into a ballot set.

ClearDesign User Guide 131



Chapter 7.  Setting up and laying out ballots

ClearDesign creates the default ballot set called Standard. The abbreviation for the Standard ballot
set is STD. This abbreviation appears in the names of PDF and BDF files.

Note: ClearDesign generates the following entities. You cannot manually create these entities
but you can edit their common attributes if the role associated with your username has
the appropriate permissions:

l Ballot groups

l Ballot styles

l Ballot group styles

l Card styles

l Cards

Ballot group
A ballot group is a set of ballots designated for a split.

Ballot style
A ballot style is a unique collection of card styles that a voter sees. For example, a primary election
can have distinct ballot styles for Democratic and Republican voters.

Ballot group style
A ballot group style groups all the splits that have the same contests and therefore share the same
set of ballot styles. For general elections and open primaries, there is a one-to-one relationship of
ballot group styles to ballot styles. However, in a closed primary, there are multiple ballot styles per
ballot group style: there is one ballot style for each voter group.

Card style
A card style is the individual, nonrotated version of a card.

Cards
A card is the rotated version of a card style.

Card template
A card template determines the dimensions of the card, the number of columns on the front and
back, the oval position, and the orientation.

ClearDesign provides some card templates. You can also add, edit, and delete any user-defined card
templates.

Layout styles
Layout styles are design themes that control the appearance of the rendered ballot.
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ClearDesign provides two layout styles:

l Color and Border

l Border

7.3 Setting up headers
This topic describes headers.

7.3.1 Displaying the Headers view
To display the Headers view, click the Headers tab from the Election menu or from the Info view of
an election.

Figure 7-1 shows an example of a Headers view.

Figure 7-1. Headers view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Header Type, Voter Group, From Contest, To Contest, Location, Start Column, Num
Columns, and Placement.

Select Show / hide columns to select which columns appear in this view.

Action buttons available from the Headers view
Table 7-1 lists the action buttons available from the Headers view.
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Button Description

Add See "Adding or editing a header" on page 137.

Delete To delete a header:

1. Select the check boxes in the rows corresponding to headers that you want to
delete.

2. Click Delete.

Table 7-1. Action buttons available from the Headers view

7.3.2 Header Type values
ClearDesign provides several types of headers as described in Table 7-2. You specify a Header Type
value in the Basic view of the Header dialog when you set up a header as described in "Adding or
editing a header" on page 137.

Note the following in Table 7-2:

l "Choose Ballot Set?" column
o Yes—The specified Header Type requires you to indicate a Ballot Set to which the Header

Type applies.
o No—The Ballot Set field does not apply to the specified Header Type and does not appear

on the Basic view of the Header dialog.

l "Applies to selected range of contests?" column
o Yes—Supply values in the From Contest and To Contest fields for the specified Header

Type.
o No—A range does not apply to this Header Type. The From Contest and To Contest fields

do not appear on the Basic view for the specified Header Type.

l Header Types that begin with "Sample"

"Sample" headers apply to the sample ballot. The sample header entity types do not support
layout options. You can change the text of "Sample" headers, but you cannot change the
format.
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Header Type Purpose Choose
Ballot Set?

Applies to a
selected
range of
contests?

Contest
Header

Inserts a header box above the selected contests. A
contest header often labels categories of contests,
such as "Federal Offices", "Municipal Offices", or
"Measures."

Yes Yes

Contest
Footer

Inserts a footer box below the selected contests. A
contest footer often does the following:

l Indicates the end of the ballot

l Notifies the voter to continue voting on the next
side of the ballot

Yes Yes

Card Header Appears at the top of the card. The card header
contains a label for the card. The card header can
contain:

l Logos for the jurisdiction

l Election-title information

l Any custom identifiers for the ballot

Yes No

Card Footer Appears at the bottom of the card. A card footer can
contain:

l Contact information for the voting office

l Disclaimers

l Notices to continue voting the next side of the
ballot

Yes No

Table 7-2. Header Type values

ClearDesign User Guide 135



Chapter 7.  Setting up and laying out ballots

Header Type Purpose Choose
Ballot Set?

Applies to a
selected
range of
contests?

Card Stub
Top

Adds an additional field above the ballot's scannable
area that requires longer paper sizes. The area
containing the stub has a perforation to tear off
before processing.

A stub at the top of a card can contain:

l ID barcodes

l Other tracking information for the jurisdiction.

Ballots that include top or bottom ballot stubs do not
have any default margins. To include a margin, use the
settings on the Layout tab of the Header dialog.

Yes No

Card Stub
Bottom

Similar to Card Stub Top but appears at the bottom of
the ballot.

Yes No

Sample
Cover

If you add a Header Type of Sample Cover to an
election, a cover page appears when you print a
sample ballot in PDF and HTML formats.

No No

Sample Filler Modifies the empty-space message which appears on
the sample ballot.

No No

Sample End Adds a footer to the end of the sample ballot. No No

Sample
Eligible

Displays text above each contest. Normally, indicates
that a contest is eligible for voting. The Sample Eligible
header type cannot be turned off.

No No

Sample
Header
Continued

If a header is too long for one side of the sample
ballot, this header modifies the custom message
indicating that the content continues on the next side.

No No

Sample
Contest
Continued

At the end of each column, a message appears
notifying the voter that the contests continue in the
next column.

No No

Sample Next
Column

At the end of each column, a message appears
notifying the voter that the contests continue in the
next column.

No No

Table 7-2. Header Type values (continued)
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Header Type Purpose Choose
Ballot Set?

Applies to a
selected
range of
contests?

Sample Next
Page

At the end of each side, a message appears notifying
the voter that the ballot continues on the next side.

No No

Table 7-2. Header Type values (continued)

7.3.3 Adding or editing a header
To add or edit a header:

1. From the Election menu, select Headers.

2. When the Headers view appears, select one of the following options:

l To edit an existing header, follow one of these paths:

Path 1:

1. From the Headers view, click the desired Name cell.

2. When the Info tab for the selected header appears, click Edit.

Path 2:

From the Headers view, click the Edit button in the row corresponding to the desired
header.

l To create a new header, click Add from the Headers view.

ClearDesign displays the Basic tab of the Header dialog (Figure 7-2).

Figure 7-2. Header dialog, Basic tab
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Editing the Basic tab of the Header dialog
To edit the Basic tab of the Header dialog:

1. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

2. In Header Type, select one of values listed in Table 7-2.

The default value for the Header Type field is Contest Header.

3. In Voter Group, select one of the options listed in Table 7-3.

Selection for the Voter
Group field

Description

All Applies the header to all contests in the election.

Nonpartisan Applies the header to nonpartisan contests in the election, such as
referendum questions.

The name of a voter
group

Applies the header to contests associates with the named voter group
(political party).

Table 7-3. Header dialog—Voter Group selections

In a closed primary, where each party (voter group) gets its own ballot, choosing Nonpartisan or a
specific voter group makes the header appear only on that specific ballot.

To generate separate ballots for each voter group, select the Separate Voter Group Ballots check
box on Ballot Set dialog. See "Adding or editing a ballot set" on page 170.

Example: Suppose the following setup:

l A closed primary election has Republican, Democratic, and Nonpartisan voter groups.

l The field Separate Voter Group Ballots is selected on the Ballot Set dialog.

This election produces three ballots: Republican, Democratic, and Nonpartisan (for nonparty-
affiliated contests such as referendum questions).

4. If the selected Header Type requires you to choose a Ballot Set, select one from the drop-
down list.

You must select Ballot Set value for all Header Types except the Sample* Header Types where
you cannot select a Ballot Set.

You can also select a Ballot Set if desired for formatting purposes.
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The default for Ballot Set is All, which applies the Header Type to all ballot sets.

5. If the Header Type is Contest Header or Contest Footer, select the following:

a. In From Contest, select the first contest related to the header.

b. In To Contest, select the last contest related to the header.

If you do not set values for From Contest and To Contest for a Contest Header or Contest
Footer, the header or footer does not display.

Examples:

l A Contest Header can label a category of contests such as "Federal Offices."

l A Card Header can contain the logo of the jurisdiction and the name of the election such as
"Clear County November 2019 General Election."

Editing header text in the Ballot Text editor
The Ballot Text editor appears at the bottom of the Basic tab of the header dialog. Use the Ballot
Text to enter, edit, and format the text of the header.

Example: Figure 7-2 on page 137 shows the Header dialog of a Contest Header where the Ballot Text
editor contains "Header 10."

Text entry and formatting options in the Ballot Text editor are similar those in many word processing
applications. For details, see "Formatting toolbar: Ballot Text editor" on page 243

You can use macros to insert variables in the Ballot Text Editor. See "Using Macros" on page 145.

If you insert a table in the Ballot Text editor of a header, do not use any of the table-alignment
properties. ClearDesign sets the table to match the width of containing header. Setting the table-
alignment properties of a table in a header can result in undesirable formatting in the printed ballot.

Inherited default formatting in the Ballot Text editor
Any formatting in the Ballot Text editor overrides any inherited formatting according to the following
precedence:

1. The Ballot Text editor inherits formatting from the Layout Style field value specified for the
first ballot set listed in the Ballot Sets view.

2. The Layout tab of the current entity overrides the formatting inherited from the Layout Style
field of the first ballot set.

3. Any local formatting in the Ballot Text editor of the current entity overrides the formatting
specified in the Layout tab of the current entity.
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Language tabs in the Ballot Text editor
The Ballot text editor has one tab for each language in the election. By default, languages other than
English inherit their formatting from the English tab. You can use the language tabs to customize the
text and formatting according to language.

If you add languages to an election, Clear Ballot recommends that you do so after all English ballot
text is stable. See "Adding languages and changing language settings" on page 206.

Editing the Layout tab of the Header dialog
Click the Layout tab of the Header dialog to begin editing it.

Figure 7-3 shows an example of a Layout tab of the Header dialog for a Header Type of Card Header.

Figure 7-3. Layout tab of the Header dialog for a Header Type of Card Header

The top portion of the Layout tab of the Header dialog contains several fields depending on the
Header Type. The remainder of this section describes these fields and which fields apply to which
Header Types.

Placement field—Layout tab of the Header dialog
The Placement field appears in the top portion of the Layout tab of Header dialog of the following
Header Types:

l Card Header

l Card Footer

l Contest Header

l Contest Footer

l Card Stub Top

l Card Stub Bottom

The Placement field does not appear on the Layout tab when the value of the Header Type field
begins with Sample.
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The selections available for the Placement field depend on the value of the Header Type field as
indicated in Table 7-4.

Placement option Applies to Header Type values

Each Card
Each Side
Front Only
Back Only

All Header Type values other than values that begin with Sample

Front of First Card Only Card Header, Card Footer

Front of All Except First Card

Card Footer

Front with Contest on Back

Last Side*

Back of Last Card

Back of All Except Last Card

Each Column

Contest FooterEach Column Front Only

Each Column Back Only

Table 7-4. Placement field options—Layout tab of the Header dialog

* Last side refers to that last side of a card that contains contests.

Start Column and Num Columns fields—Layout tab of the Header dialog
The Start Column and Num Columns fields appear in the top portion of the Layout tab of the Header
dialog of the following Header Types:

l Card Header

l Card Footer

l Contest Header

The Start Column and Num Columns fields do not appear on the Layout tab of any Sample Header
Types.

The Start Column field is an integer that indicates the column of the ballot where the header begins.
A Start Column value of 0 means the current column.

Note: If header contains a Num Columns value larger than number of columns on the card,
ClearDesign will size the header to fit the card.

The Num Columns field indicates the number of columns that the header spans.
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Location field—Layout tab of the Header dialog for a Header Type of Contest Header
The top portion of the Layout tab of the Header dialog for a Header Type of Contest Header contains
the Location field in addition to the Placement, Start Column, and Num Columns fields.

Figure 7-4 shows an example of the Layout tab of a Header dialog for a Header Type of Contest
Header.

Figure 7-4. Example: Layout tab of a Header dialog for a Header Type of Contest Header

The Location field enables you to select one of the following possible values for the position of the
Contest Header:

l Current Column

l Next Column

l Next Side

l Next Card

When the Start Column value of a header is greater than zero, it affects the Location field as
described in Table 7-5.

Location field value Behavior when Start Column > 0

Next Column Next Column is ignored.

Next Side The header and associated contests are placed on the back of the card.

Next Card The header and associated contests are placed on the front of the next
card.

Table 7-5. Effects of Start Column > 0 on Location field values

Placement and Height field—Layout tab for Header Types of Card Stub
ClearDesign provides the Header Types values Card Stub Top and Card Stub bottom to format ballots
containing tear-off stubs that jurisdictions can use for barcodes or other identifying information.
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The top of the Layout tab of the Header dialog for a Header Type of Card Stub Top or Card Stub
Bottom contains the Placement and Height fields. Figure 7-5 shows an example.

Figure 7-5. Example: Layout tab of the Header dialog for a Header Type of Card Stub Top

For a description of the Placement field, see Table 7-4 on page 141.

The Height field specifies a number of inches at the top or bottom of the card for the stub. The
default is 1.0.

Default Style pane—Layout tab of the Header dialog
The lower portion of the Layout tab of the Header dialog contains a Default Style pane as shown in
Figure 7-3 on page 140 and Figure 7-4 on page 142. This pane enables you to change the default
inherited font and formatting options of a header.

Note: Before you edit the Default Style pane of the Header dialog, make sure that you
understand how style inheritance works in ClearDesign. See "" on page 139 and
"Inheritance of layout styles" on page 186. Any settings changed in the Default Styles
pane of the Header dialog override any inherited default settings.

Settings for each language

The top section of the Default Style pane of the Header dialog contains a tab for each language in the
election. By default, languages other than English inherit their settings from English unless you
explicitly change the settings for an individual language.

Table 7-6 lists the settings for each language in the election.
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Setting Description

Font Name The font name. You can select any font installed with ClearDesign or
any font that you have added to the election. The default font is Noto
Sans. Chapter 3, "Adding fonts and images" on page 52.

Size The font size in points.

Justify Justified text is spaced so that both the left and right side of the text
block have an even, clean edge. Selections are: Inherit, Left, Center,
and Right

Background Color The hex code or name of an HTML color. This field also supplies a
color picker that enables you to click the desired color.

Letter Spacing The amount of space between a group of letters to affect density in a
line or block of text. Selections are: Inherit, Compressed, Normal,
Expanded, and Very Expanded

Line Spacing The vertical distance between lines of text.

Option The available options can vary depending on the selected font. One of
the following: Inherit, Normal, Bold, Italic, Underline, Bold Italic, Bold
Underline, Italic Underline, and Bold Italic Underline

Text color The hex code or name of an HTML color. This field also supplies a
color picker that enables you to click the desired color.

Table 7-6. Settings for each language in the election

Margins, borders, and padding in the Default Style pane—Layout tab of the Header dialog

The lower section of the Default Style Pane of the Layout tab of the Header dialog contains settings
for margins, borders, and padding. (For examples of the Default Style pane, see Figure 7-3 on page
140 and Figure 7-4 on page 142.)

To conceptualize margins, borders, and padding, imagine that text is contained in a box. The box has
the margin, border, and padding attributes as shown in Figure 7-6.

Figure 7-6. Margins, border, and padding
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Figure 7-6 shows the following:

l The margin is the space outside the border up to the edge of the box.

l The border is the optional outline that separates the margin and the padding.

l The padding is the space between the border and the content.

If desired, use the Default Style pane to change the inherited default margin, border, and padding
settings.

Language Position and Separator in the Default Style pane—Layout tab of the Header dialog

The last row of the Default Style pane on the Layout tab of the Header dialog contains the field
Language Position and Separator. These fields apply to multi-language ballots.

If an election contains multi-language ballots, a header inherits the Language Position and Separator
values from the layout style for the ballot set. (See "Inheritance of layout styles" on page 186.)
Update the Language Position and Separator fields on the Default Style pane of the Header dialog to
override the inherited default values.

7.4 Using Macros
Macros are placeholders for variable data that appear in headers.

You can also use macros in device messages.

Example of using a macro in a header
For example, suppose that you set up a template for creating new elections. If you insert a macro
representing the election name in various headers in the template, you can avoid manually updating
the election name in every location each time you create a new election. Instead, the election-name
macro picks up value of the Name field specified in the Election dialog.

How macros appear in the Ballot Text editor of a header
Figure 7-7 on page 146 shows an example of how macros appear in the Ballot Text editor of a
header. This header contains two macros:

l ~{card.voterGroup.name} is a placeholder for the name of the voter group (political party)
associated with the card.

l ~{split.precinct.name} is a placeholder for the name of the precinct associated with the split.
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Figure 7-7. Example: macros in a header

Viewing macros when previewing and printing cards and ballots
When you preview or print the cards and ballots, the actual names of the voter group and precinct
appear instead of the macros.

Note: When you click Layout Preview from a Card Style and Ballot Style view, ClearDesign
may not display all values for the macros in the associated preview. Therefore, Clear
Ballot recommends previewing and proofing macros by using the Ballot view and Card
view tabs.

7.4.1 Adding macros to headers
To add a macro to a header:

1. From the Headers view of the election, locate the desired header.

2. Click the Edit button for the header.

The Header dialog appears.

3. In the Ballot Text editor section of the Header dialog, click the location where you want to
add the macro.

4. Type the macro using the syntax <tilde>{MacroName}.

ClearDesign allocates space for the macro based on its name.

5. Click Save.

7.4.2 Previewing macros
To preview macros:

1. Open the associated cards in the Layout Preview page to review macro substitutions.

2. Fix any macros that appear as undefined.
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3. Lay out the cards so that ClearDesign will process the macros.

You cannot view macros if you have only generated ballots.

7.4.3 Macro and alias definitions
This topic lists macros according to categories based on ClearDesign entities and their attributes.

The information in this topic assumes an understanding of entities, the various attributes (fields) of
entities, and the relationships between entities. To review this information for a specific entity, read
the topic in this User Guide that describes how to create and edit a particular entity.

Hierarchy of macro definitions
Macro definitions follow a hierarchy that goes from left to right. Each individual element in the
macro hierarchy ends with a period.

The following macro definition is an example:

~{split.ballot.ballotStyle.ballotSet.abbreviation}

The hierarchy of this macro definition is as follows:

1. This macro is associated with a split (precinct split) entity, which has an associated ballot.

2. The ballot associated with the split has a related ballot style, which is turn, is associated with
ballot set.

3. Therefore, this macro is a placeholder for the abbreviation that identifies the ballot set in this
hierarchy.

Aliases
Some macros have associated aliases. An alias is a shorthand abbreviation for a macro. In the lists of
macros in the remainder of this topic, an alias appears indented in the row below its associated
macro. Because an alias is shorter than its associated macro, use an alias to save space in the Ballot
Text editor.

{ballot}

{ballot.id}

{ballot.name}

{ballot.shortName}

{ballot.abbreviation}

{ballot.ballotStyle}

{ballot.ballotStyle.id}

Ballot macros
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{ballot.ballotStyle.sortSeq}

{ballot.ballotStyle.name}

Ballot macros (continued)

{election}

{election.id}

{election.name}

{election.sortSeq}

{election.shortName}

{election.abbreviation}

{election.electionDate}

Election macros

{ballotGroup}

{ballotGroup.id}

{ballotGroup.sortSeq}

{ballotGroup.name}

{ballotGroup.shortName}

{ballotGroup.abbreviation}

{ballotGroup.ballotGroupStyle}

{ballotGroup.ballotGroupStyle.id}

{ballotGroup.ballotGroupStyle.sortSeq}

{ballotGroup.ballotGroupStyle.name}

{ballotGroup.ballotGroupStyle.shortName}

{ballotGroup.ballotGroupStyle.abbreviation}

Ballot group macros

{ballotGroupStyle}

{ballotGroupStyle.id}

{ballotGroupStyle.sortSeq}

{ballotGroupStyle.name}

{ballotGroupStyle.shortName}

{ballotGroupStyle.abbreviation}

Ballot Group Style macros
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{ballotStyle}

{ballotStyle.id}

{ballotStyle.sortSeq}

{ballotStyle.name}

{ballotStyle.shortName}

{ballotStyle.abbreviation}

{ballotStyle.ballotSet}

{ballotStyle.ballotSet.id}

{ballotStyle.ballotSet.sortSeq}

{ballotStyle.ballotSet.name}

{ballotStyle.ballotSet.shortName}

{ballotStyle.ballotSet.abbreviation}

Ballot style macros

{ballotSet}

{ballotSet.id}

{ballotSet.sortSeq}

{ballotSet.name}

{ballotSet.shortName}

{ballotSet.abbreviation}

Ballot set macros

{card}

{card.id}

{card.name}

{card.VoterGroup}

{card.voterGroup.id}

{card.voterGroup.name}

{card.voterGroup.sortSeq}

{card.voterGroup.shortName}

{card.voterGroup.abbreviation}

{card.cardSequence}

Card macros
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{precinct}

{precinct.id}

{precinct.name}

{precinct.sortSeq}

{precinct.shortName}

{precinct.abbreviation}

Precinct macros

{split}

{split.id}

{split.name}

{split.sortSeq}

{split.shortName}

{split.abbreviation}

{split.ballotSequence}

{split.precinct}

Alias: {precinct}

{split.precinct.id}

{split.precinct.name}

{split.precinct.sortSeq}

{split.precinct.shortName}

{split.precinct.abbreviation}

{split.ballotGroup}

Alias: {ballotGroup}

{split.ballotGroup.id}

{split.ballotGroup.sortSeq}

{split.ballotGroup.name}

{split.ballotGroup.shortName}

{split.ballotGroup.abbreviation}

{split.ballotGroup.ballotGroupStyle}

Alias: {ballotGroupStyle}

{split.ballotGroup.ballotGroupStyle.id}

Split macros
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{split.ballotGroup.ballotGroupStyle.sortSeq}

{split.ballotGroup.ballotGroupStyle.name}

{split.ballotGroup.ballotGroupStyle.shortName}

{split.ballotGroup.ballotGroupStyle.abbreviation}

{split.ballot}

Alias: {ballot}

{split.ballot.id}

{split.ballot.sortSeq}

{split.ballot.name}

{split.ballot.shortName}

{split.ballot.abbreviation}

{split.ballot.ballotStyle}

Alias: {ballotStyle}

{split.ballot.ballotStyle.id}

{split.ballot.ballotStyle.sortSeq}

{split.ballot.ballotStyle.name}

{split.ballot.ballotStyle.shortName}

{split.ballot.ballotStyle.abbreviation}

{split.ballot.ballotStyle.ballotSet}

Alias: {ballotSet}

{split.ballot.ballotStyle.ballotSet.id}

{split.ballot.ballotStyle.ballotSet.sortSeq}

{split.ballot.ballotStyle.ballotSet.name}

{split.ballot.ballotStyle.ballotSet.shortName}

{split.ballot.ballotStyle.ballotSet.abbreviation}

{split.ballotGroup.ballotGroupStyle.abbreviation}

{split.ballot}

{split.ballot.id}

{split.ballot.sortSeq}

{split.ballot.name}

{split.ballot.shortName}

{split.ballot.abbreviation}

Split macros (continued)
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{split.ballot.ballotStyle}

{split.ballot.ballotStyle.id}

{split.ballot.ballotStyle.sortSeq}

{split.ballot.ballotStyle.name}

{split.ballot.ballotStyle.shortName}

{split.ballot.ballotStyle.abbreviation}

{split.ballot.ballotStyle.ballotSet}

{split.ballot.ballotStyle.ballotSet.id}

{split.ballot.ballotStyle.ballotSet.sortSeq}

{split.ballot.ballotStyle.ballotSet.name}

{split.ballot.ballotStyle.ballotSet.shortName}

{split.ballot.ballotStyle.ballotSet.abbreviation}

Split macros (continued)

In the following macros, the data enclosed in [] is the district category abbreviation.

Example: Suppose that split 1 is in the district US Senate 51 and the abbreviation for the US Senate
district category is "USSEN". The macro ~{split.districts[USSEN].name} displays the following:

US Senate 51

{split.districts[].id}

{split.districts[].name}

{split.districts[].shortName}

{split.districts[].abbreviation}

Split macros containing the district category abbreviation

7.4.4 Barcode macros
The following formats macros generate barcodes:

~{code128A(macro_names)}

~{code128B(macro_names)}

~{code128C(macro_names)}

~{code25(macro_names)}

In barcode macros, multiple macro names can be included between the parentheses.

ClearDesign User Guide 152



Chapter 7.  Setting up and laying out ballots

Guidelines for using barcode macros
l ClearDesign ignores invalid characters when generating barcodes.

l The Code25, Code128A, Code128B, and Code128C macros extract only numeric values.

l If a barcode value contains an odd number of digits, ClearDesign adds a leading zero.

Example 1
To create a 2 of 5 barcode using the numbers in the Ballot Set ID, enter the following:

~{code25(ballotSet.id)}

This example contains the following items:

l The ~ { and } delimit the beginning and end of the macro, respectively.

l The string code25 indicates the barcode format.

l The parentheses following the barcode format enclose the macro data to be encoded in the
barcode.

Example 2
Suppose that the precinct abbreviation is 01-234 and the split.ballotSequence is 5. The following
macro contains the barcode value 012345.

~{code25(precinct.abbreviation.split.ballotSequence)}

Font for barcodes
To display data as barcode, use barcode font code128.ttf provided by Clear Ballot. To get this font,
contact Clear Ballot.

7.4.5 Auxiliary format functionality for macros
An auxiliary format enables you:

l Select and capture only a portion of a string represented by a macro

l Add leading zeroes or spaces to the string represented by a macro

Syntax for auxiliary formats
A macro that uses an auxiliary format has the following syntax:

~{macro[auxiliary_format]}

The auxiliary_format specifies a formula indicating which portion of the macro to capture.
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Examples
Suppose that:

l The macro precinct.name represents the string '1234-567'.

l The macro split.name represents the string 'ABDEFGHIJK'.

Table 7-7 on page 154 lists examples of auxiliary formats that capture parts of the strings
represented by these macros or add zeros or spaces to these strings.

Description Macro Values captured

Skip two characters from the left. Capture
the third character.

~{precint.name[2]} 3

~{split.name[2]} C

Capture the fifth character from the right. ~{precinct.name[-5]} 4

~{split.name[-5]} G

Skip two characters from the left. Capture
from the third character to the end of the
string.

~{precinct.name[2:]} 34-567

~{split.name[2:]} CDEFGHIJK

Count five characters from the right.
Capture from that character through the
end of the string.

~{precinct.name[-5:]} 4-567

~{split.name[-5:]} GHIJK

Skip two characters on the right. Capture
from the third character to the sixth
character.

~{precinct.name[2:6]} 34-5

~{split.name[2:6]} CDEF

Add spaces to the beginning of the string
for a total of 12 characters

~{precinct.name[:12]} <space><space><space>
<space><space>1234-567

~{split.name[:12]} <space>ABCDEFGHIJK

Add zero to the beginning of the string for
a total of 12 characters.

{precinct.name[:012]} 00001234-567

{split.name[:012]} 0ABCDEDGHIJK

Table 7-7. Examples of auxiliary formats

7.4.6 Using a macro for a serial number in a stub
ClearDesign contains a macro that can insert a placeholder for a serial number in headers for stubs.
This macro enables jurisdictions to insert a placeholder for a unique number in a stub appearing at
the top or bottom of a card. When the ADF for the elections gets loaded into ClearAccess or
PrintNow, an administrator can specify the starting value for the serial number.
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To insert a serial number in a stub, use the Ballot Text editor for Header Type of Card Stub Top or
Card Stub Bottom.

The basic format of the macro for the serial number is:

~{serialNumber}

This basic format inserts a number that increments each time a card is printed. The basic format
does not contain any leading zeros.

To specify the number of digits in a serial number, use an auxiliary format, such as:

~{serialNumber[0:4]}

This example is a placeholder for a serial number containing four digits. Unused digits are printed as
leading zeros.

7.4.7 Using macros for page numbers in a card header or footer
ClearDesign contains macros that can insert placeholders for the current page number and total
number of pages in a given ballot. These macros enable jurisdictions to display the current page
number and total number of pages at the top or bottom of each card (e.g. "Page 1 of 8").

To insert the current page number and total number of pages in a card header or footer, use the
Ballot Text editor for Header Type of Card Header or Card Footer.

The basic format for each page number macro is:

~{pageNum} = Current page number. This number increments each time a card is printed.

~{numPages} = Total number of pages.

To display the current and total page count together (e.g. "Page 1 of 8"), insert the page number
macros in the following format:

Page ~{pageNum} of ~{numPages}

The number of pages (numPages macro value) includes the blank backs of cards except for the back
of the last card if it does not have any contests on it.

7.4.8 Macros that conditionally set the background color or other CSS
properties
It is possible to set the background color of a header using macros. For example, if you wanted to set
the background color of a header to red (hex value #ff0000) for the party with abbreviation Party1,
and green (hex value #00ff00) for the party with abbreviation Party2, you would use the following
color macro:

~{color(card.voterGroup.abbreviation, Party1: #ff0000, Party2: #00ff00)}
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In addition to the color macro, you can use the more general css macro to set arbitrary css
properties conditionally. When specifying the css property name, use the JavaScript camel case
format for the name. For example, you could also set the background color in the previous example
using this syntax:

~{css(card.voterGroup.abbreviation, backgroundColor, Party1: #ff0000, Party2: #00ff00)}

If you wanted to conditionally set the text color instead of the background color, you could use the
css property name “color” in this way:

~{css(card.voterGroup.abbreviation, color, Party1: #ff0000, Party2: #00ff00)}

7.5 Setting up ballot sets
This topic describes how to set up ballot sets.

7.5.1 The workflow for creating ballots
The ballot-creation workflow is as follows:

1. Add an election.

See "Scenarios for creating elections in ClearDesign" on page 37.

2. Build the election by entering the jurisdictional information and the election definition.

See "Fundamental election entities" on page 59.

3. If required, set up primary preference and straight party contests.

See "Setup of advanced election types" on page 103

4. If necessary, reset ballot styles to remove any previously generated ballots, cards, and card
IDs.

See "Resetting ballot styles" on page 160.

5. From the Ballot Sets view, click Generate.

Generating ballots sets consists of identifying and correlating contests to splits and creating
ballot styles.

See "Generating ballot styles" on page 159.

6. From the Ballot Sets view, click Layout.

This is the stage in which ballots are laid out on physical cards to create card styles.

7. Preview the ballot layout.

8. Repeat steps 4 through 6 as needed.
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7.5.2 Displaying the Ballot Sets view
To display the Ballot Sets view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info view of the election, click the Ballot Sets tab.

ClearDesign displays a Ballots Sets view that is similar to Figure 7-8.

Figure 7-8. Ballot Sets view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Separate Ballots, Precinct Type, Card Template, Split Identifier,
PDF Naming Convention, Layout Style, and Ballot Styles Count.

Action buttons available from the Ballot Sets view
Table 7-8 describes the action buttons available from the Ballot Sets view.

Button See

Generate "Generating ballot styles" on page 159

Reset "Resetting ballot styles" on page 160

Layout "Laying out card styles" on page 161

Print "Printing cards" on page 164

Sample Ballot "Printing sample ballots" on page 168

Add "Adding or editing a ballot set" on page 170

Delete To delete a ballot set:

1. From the Ballot sets view, select the desired ballot sets.

2. Click Delete.

3. When the confirmation message appears, click OK.

You cannot delete the Standard ballot set.

Table 7-8. Action buttons available from the Ballot Sets view

ClearDesign User Guide 157



Chapter 7.  Setting up and laying out ballots

Additional tabs available from the Ballot Sets view
The following tabs are available from the Ballot Sets view (Table 7-9).

Tab See

Ballot Group Styles "Setting up ballot group styles" on page 172

Ballot Groups "Setting up ballot groups" on page 173

Ballot Styles "Setting up ballot styles" on page 174

Ballots "Setting up ballots" on page 176

Card Styles "Setting up card styles" on page 180

Cards "Setting up cards" on page 181

Card Templates "Setting up card templates" on page 183

Layout Styles "Layout Preview" on page 195

Table 7-9. Additional tabs available from the Ballot Sets view
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7.5.3 Generating ballot styles
The Generate action creates ballot styles for all contests for each split in an election. The Generate
action is required in the following situations:

l Initially after you perform all the setup for a new election

l If you add or remove contests or headers from a ballot or split

The Generate action does not create cards. It only sets the header and contest relationship data for a
given ballot. This capability allows changes to formatting or aspects of the ballot without requiring
you to regenerate the ballots again. The ballot is laid out to reflect any new changes in real time.

The Layout Action generates the static cards for final review. (See "Laying out card styles" on
page 161.)

To generate a ballot style:

1. From the Ballot Sets view, click Generate.

The Generate Ballot Styles dialog appears.

Figure 7-9. Generate Ballot Styles dialog

2. Click OK.

A status bar displays progress until the confirmation message appears. The message provides
the count of generated ballot styles (Figure 7-10).

Figure 7-10. Generate Ballot Styles confirmation

If ClearDesign detects no changes when you click the Generate button, it displays the
following message (Figure 7-11 on page 160).

ClearDesign User Guide 159



Chapter 7.  Setting up and laying out ballots

Figure 7-11. Ballot Styles already generated

3. Click Close.

7.5.4 Resetting ballot styles
To reset ballot style:

1. From the Ballot Sets view, click Reset.

The Reset Ballot Styles dialog appears.

Figure 7-12. Reset Ballot Styles dialog

2. Choose one of the following:

l Reset all Ballot and Cards?—Removes all previously generated ballot set information.

l Reset all Cards only?—Removes card style information (created by clicking Layout) but
not ballot style information (created by clicking Generate).

3. (Optional) Check Also Reset Card IDs to remove previously generated Card IDs and restart
numbering at 1.

Do not reset card IDs if any cards are already sent for printing.

4. Click OK.

Resetting the ballot set removes previously generated information.

Resetting ballot sets invalidates previously generated BDFs, BDFxs and ADFxs.

If you regenerate an election that already exists in ClearCount or ClearAccess, make sure to
do the following:

a. Generate a new ADFx, BDF, and BDFx files in ClearDesign.

b. Delete any existing data for the election in ClearCount and ClearAccess.
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c. Load the new BDF or BDFx into ClearCount and ClearCast and the new ADFx into
ClearAccess.

Loading the new BDF, BDFx, and ADFx files removes all previous data for the election.

7.5.5 Laying out card styles
To lay out the card styles in a ballot set:

1. Ensure ballots are generated.

2. From the navigation pane, choose Ballot Sets.

3. Click Layout.

The Layout Card Styles dialog appears.

Figure 7-13. Layout Card Styles dialog

The message All card styles already laid out indicates that regeneration is required because
the deletion of content removed some cards from the ballot set; however, none of the
remaining cards were affected.

4. Click OK.

A status bar displays progress until the confirmation message appears. The message provides
the count of generated card styles.

5. Click Close.

Ballot styles and ballot layout can change after the cards are laid out. These changes usually occur
because ClearDesign displays previously unrendered macros. The card layout is more accurate and
will be printed. If you generate the ballots, but do not lay out the cards, the layout may change.

Suppose that you manually change a layout in the Layout Preview window. If you then launch an
automatic layout that can overwrite the manual change, ClearDesign issues a warning message.
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7.5.6 The logic for card layout
This topic describes the logic that ClearDesign uses to lay out cards.

A header that specifies a start column and more than one column
Contests can wrap under a header that specifies a start column and more than one column.

For example, suppose the following:

l A header starts in column 1 and specifies two columns

l The associated contests are one column wide

l The contests are placed in column 1, then column 2, and then on the back of the card in
column 1.

In this situation, ClearDesign attempts to start contests and their associated headers on the front of
the card when they are attached to a header that specifies the column.

This arrangement may cause contests to appear out of order on the ballot.

Note: If a contest is attached to more than one header that specifies a start column,
ClearDesign uses the last header's start column.

Additional options when a header specifies a start column
If a header specifies a start column and one of the following:

l Next-column—Next column is ignored.

l Next-side—The header and associated contests are placed on the back of the ballot.

l Next-card—The header and associated contests are placed on the front of the next card.

Linked contests
Another case involves a contest that is linked to:

l A header that specifies a start column

l A subsequent header that specifies a next column

In this case, the contest and subsequent header are placed in the next column after the specified
column.

For example, in Figure 7-14 on page 163, if the first header specifies the start column of 1, the
second header and contest are placed in column 2. (If there is no column 2, they are placed on the
next side.)
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Figure 7-14. A linked contest with multiple headers

Another case is a contest that meets the following criteria:

l The contest is not the first contest that specifies a start column

l The contest does not fit the specified column.

In this situation, the following logic applies:

l If the header that specifies the start column also specifies more columns than the contest
specifies, the contest is placed in the next column, as long as it fits within the header's columns.

For example, if a header specifies two columns and the contests all specify one column, the
contests are placed first in column 1 and then in column 2.

l If the contest does not fit beneath the header, it moves to the next side of the specified
column.

Figure 7-15. A linked contest spread across the front and back of a card

7.5.7 Selecting the right ballot set options
The following distinctions apply when you are managing ballot sets:

l Generating ballot styles organizes the contest information for each split. It does not lay out
physical cards.
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l If you add or delete a contest or candidate, you need to regenerate the ballot styles.

l Laying out the card set creates the physical card images.

l If you make an editorial change that does not change the underlying contests or candidates,
ClearDesign requires you to lay out the cards again, but you do not have to regenerate the
ballot style. (Editorial changes include correcting typos, editing header text, changing the order
of contests on the ballot, and so on.)

7.5.8 Printing cards
A Print button appears at the top of the Ballot Sets view. Clicking this button displays a dialog when
you can select the options for generating a Zip file containing the PDF images for the various cards
associated with the election.

To generate a zip of PDF images for the cards in a ballot set:

1. From the Ballot Sets view, click Print.

ClearDesign displays the Print Cards dialog (Figure 7-16).

Figure 7-16. Print Cards dialog

2. From the Print Cards drop-down list, select an option listed in Table 7-10 to generate a file
with the specified naming convention:

Print Cards Option Naming convention for the output file

For each Precinct ElectionName-card_precincts.zip

For each Split ElectionName-card_splits.zip

Table 7-10. Options the Print Cards drop-down list
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Print Cards Option Naming convention for the output file

For each Card - for proofing only ElectionName-cardStyles.zip

For each Card Style - for proofing only ElectionName-cardStyles.zip

Table 7-10. Options the Print Cards drop-down list (continued)

Important: Depending on your selected Split Identifier, some of the preceding options
may be unavailable. For details, see "Naming conventions for PDF files
associated with splits" on the next page.

3. From the Ballot Set drop-down list, select All or Standard.

4. From the Language drop-down list, select one of the following:

l All—(Default) Prints the cards for all languages

l A specific language name—Prints only the cards for the specified language

5. (Optional) Select (check) Print Stubs.

The Print Stubs check box appears only when the ballot set contains a header containing a
Header Type value of Card Stub Top or Card Stub Bottom. By default, the Print Stubs check
box is selected.

6. (Optional) Select (check) Show Serial Number.

If the ballot contains a serial number macro, selecting this option displays the serial number
on the printed ballots. The number displayed will be 0, formatted according to the macro
specification; if the macro does not show a number, spaces will be used instead.

7. (Optional) Add a visible watermark to each ballot image:

a. Check Show Proof Mark.

b. In Proof Mark, enter the text of the watermark.

When printing cards or card styles, you cannot deselect Show Proof Mark because a
watermark is required. However, you can customize the watermark text in Proof Mark. This
functionality prevents someone from using a proof as an actual card. Proofs are not
scannable.

8. (Optional) Select Set Election State to Cards Created.

9. (Optional) Select Include Election Backup to back up the election.

Selecting Include Election Backup enables the Validation Code field.

10. (Required if election is backed up) In Validation Code and Confirm Validation Code, enter the
validation code for restoring the backup.
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11. Click OK.

A status bar tracks the progress (Figure 7-17). To stop generating the files, click the Cancel
button.

Figure 7-17. Status message when generating a Zip of PDF card images

When the process is finished, a link to the location of the Zip file appears at the bottom of the
browser window. ClearDesign downloads the file to Google Chrome's default Downloads
folder. Usually, this location is:

c:\Users\Your User Name\Downloads

You can change default this location by editing the Downloads area of the Settings in Google
Chrome.

12. Click Close.

13. Obtain the files from the default download folder.

The files can include:

l ElectionName-bdf.zip

l ElectionName-backup.zip (if election backup is selected)

l All the PDF images for the various cards associated with the election

14. Print the files locally or send them to a vendor.

Naming conventions for PDF files associated with splits
The naming conventions for PDF files associated with splits depend on the type of Split Identifier
and the PDF Naming Convention used for the ballot set. See Table 7-11.

Split
Identifier
setting

Card Style First naming convention for the
PDF file

Precinct First naming convention for the
PDF file

Name Card ID-Precinct Name-Split Name(s)-
Ballot Set Abbreviation-Voter Group
Abbreviation-Language
Abbreviation.pdf

Precinct Name-Split Name(s)-Card ID-
Ballot Set Abbreviation-Voter Group
Abbreviation-Language Abbreviation.pdf

Table 7-11. Naming conventions for PDF files—based on the Split Identifier setting
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Split
Identifier
setting

Card Style First naming convention for the
PDF file

Precinct First naming convention for the
PDF file

Ballot
Sequence

Card ID-Precinct Name-Ballot Sequence-
Ballot Set Abbreviation-Voter Group
Abbreviation-Language Abbreviation.pdf

Precinct Name-Ballot Sequence-Card ID-
Ballot Set Abbreviation-Voter Group
Abbreviation-Language Abbreviation.pdf

Table 7-11. Naming conventions for PDF files—based on the Split Identifier setting (continued)

The subsections that follow provide additional details and examples.

Split Identifier—Name
When you choose "Name" for the Split Identifier, ClearDesign uses the precinct name plus the split
name to identify your ballot PDFs. If the split name begins with the precinct name, ClearDesign lists
the precinct name once in the naming convention and does not duplicate it.

If similar styles within a precinct are combined by choosing to print by precinct, ClearDesign uses the
first applicable split name as the identifier for a given precinct and card style combination. See
"Printing cards" on page 164.

The Card Information appears at the bottom of the PDF images. ClearDesign lists all applicable splits
for the card in square brackets. ClearDesign allows a total of 40 characters for the combined split
name and precinct names. If there are more splits that exceed the 40-character limit, ClearDesign
appends '...' to the list to indicate that splits in addition to those listed apply to the card.

The card style also appears at the bottom of the card in the format (CS CardStyleNumber).

Split Identifier—Ballot Sequence
When you choose "Ballot Sequence" as the Split Identifier, ClearDesign uses the precinct name and
a ballot sequence number to identify your ballots. Ballot sequence numbers increment (1, 2, 3, and
so on) for every new card in a precinct. When ClearDesign calculates a new precinct, the sequence
number increments—starting from 1 again—for every unique card style within the precinct.

When printing PDFs, only the option to print by "precinct" is enabled because this option does not
support printing splits with duplicate styles. If one ballot set is defined as printing by Name and
another by Ballot Sequence, regardless of the printing method selected for the Name ballot set, the
Ballot Sequence ballot set always prints by "precinct."

A precinct can contain some splits with no contests. In this situation, ClearDesign assigns a sequence
number for empty splits in that precinct to the first applicable split. The sequence number for the
empty split does not appear among the printed cards. This situation can cause ballot sequences to
skip a number when counting up.
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Example: PDF files associated with splits
For example, suppose the following:

l Precinct name: 10

l Split name: 10-003

In this situation, the split information appears on the card information and in the title of the PDF file
as:

10-003

Table 7-12 lists how the data from this example appears in the card information and in the PDF file
name based on the selected type of Split Identifier.

Selected
type of Split
Identifier

Card
information

PDF file name with card style first PDF file name with precinct first

Name 10 [003] (CS
1)

1-10-003-STANDA-_NP_-EN.pdf 10-003-1-STANDA-_NP_-EN.pdf

Ballot
Sequence

10-1 (CS 1) 1-10-1-STANDA-_NP_-EN.pdf 10-1-1-STANDA-_NP_-EN.pdf

Table 7-12. Example: Card information and PDF file name based on the selected type of Split
Identifier

Truncation occurs when the precinct name and split name match. If the two names differ, no
truncation occurs.

7.5.9 Printing sample ballots
The sample ballot lists all contests in an election. The sample ballot does not represent the finalized
format of the actual ballot.

Special header types apply to sample ballots. See "Header Type values" on page 134.
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To print a sample ballot for all contests in an election:

1. From the navigation pane, select Ballot Sets.

2. Click Sample Ballot.

The Print Sample Ballot dialog appears.

Figure 7-18. Print Sample Ballot dialog

3. In Output Type, select HTML (the default) or PDF.

4. In Page Size, select Letter (the default), Legal, or Tabloid.

5. In Orientation, select Portrait or Landscape.

6. In Oval Position, select Left or Right.

7. In Layout Style, select one of: None, Color & Border, Border, or a user-defined layout style.

8. In Number Columns enter the number of columns to render.

9. In Language, select English or another language defined for the election.

10. Click OK.

ClearDesign displays the sample ballot.

If you select PDF for the Output Type, the sample ballot appears in a browser window. To
download the ballot in PDF format in this situation:

a. Move the cursor to the upper right of the browser window and click the download
icon when it appears.

b. If you receive the message "Failed - Network Error" in the status bar at the bottom of
the screen, click the Print icon at the top of the screen or enter Ctrl-P.

c. When the Print dialog appears, change the Destination field to Microsoft Print to PDF.

d. When the Save Print Output As dialog appear, designate a File name and select a
location to save the PDF file. The default location is your Windows Downloads folder.

ClearDesign User Guide 169



Chapter 7.  Setting up and laying out ballots

7.5.10 Adding or editing a ballot set
To edit a ballot set:

1. Select one of the following options:

l To add a ballot set:

a. Select the Ballot Sets tab.

b. Click Add.

ClearDesign displays the Ballot Set dialog (Figure 7-19).

l To edit an existing ballot set, click the Edit button in the row corresponding to the desired
ballot set.

ClearDesign displays the Ballot Set dialog (Figure 7-19).

Figure 7-19. Ballot Set dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. In Card Template, select the card template that controls ballot size and orientation.

4. In Layout Styles, select the layout style that controls visual appearance.
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5. (Optional) In Split Identifier, if permitted, select one of:

l Name—Prints the split name at the bottom of the ballot.

For additional information, see "Split Identifier—Name" on page 167.

l Ballot Sequence—Prints the ballot sequence number at the bottom of the ballot.

For additional information, see "Split Identifier—Ballot Sequence" on page 167.

6. (Optional) In PDF Naming Convention, select Card Style First or Precinct First:

l Card Style First is the default, and it produces card PDF filenames that begin with the card
style number.

l If you select Precinct first, card PDF filenames will begin with the precinct name.

7. (Optional) Check Combine Similar Ballots, if permitted, to consolidate ballots where possible.

By default, this option is not checked. If Combine Similar Ballots and Separate Voter Group
Ballots are both checked, it can result in a card that contains only nonpartisan measures and
is shared among multiple voter groups. This complicates the display of voter registration
counts in ClearCount reports because the shared card will be associated with a special
“Combined Party Card” voter group, as a card can only be associated with a single voter
group. If it is important for your jurisdiction to be able to report voter registration totals by
voter group for all cards, Clear Ballot recommends that you do not use Combine Similar
Ballots.

8. (Optional) Check Separate Voter Group Ballots to generate separate ballots for each voter
group.

Headers are affected when you generate separate ballots for each voter group. See Table 7-3,
"Header dialog—Voter Group selections" on page 138.

9. (Optional) In Precinct Type, select Standard or All.

The Standard selection is the default.

If you have a consolidated precinct, set the Precinct Type to All or create a separate ballot set
for the consolidated precinct.

10. In the Contests area, do one of the following:

l Check All Contests if the ballot set is to contain all of the contests in the election.

l To select individual contests, check All Contests and then uncheck specific contests. Check
only those contests to be included in the ballot set.

When you edit the first ballot set of an election, the All Contests check box is selected in the
Contests section. You cannot change this setting.

11. Click Save.
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7.6 Setting up ballot group styles
This topic describes how to:

l Display the ballot group styles that ClearDesign automatically generates

l Edit the common attributes of ballot group styles

7.6.1 Displaying the Ballot Group Styles view
To display the Ballot Group Styles view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info view of the selected election.

2. From the Info view, click the Ballot Sets tab.

ClearDesign displays the Ballot Sets view.

3. From the Ballot Sets view, click the Ballot Group Styles tab.

ClearDesign displays the Ballot Group Styles view (Figure 7-20).

Figure 7-20. Ballot Group Styles view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Ballot Group Style, Splits Count, Splits, Contests Count, Contests, Ballot Groups Count,
Ballot Groups, Ballot Styles Count, and Ballot Styles.
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7.6.2 Editing the common attributes of a ballot group style
To edit the common attributes a ballot group style:

1. From the Ballot Group Styles view, click Edit in the row corresponding to the desired ballot
group style.

ClearDesign displays the Ballot Group Style dialog.

Figure 7-21. Ballot Group Styles dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Click Save.

7.7 Setting up ballot groups
This topic describes how to:

l Display a list of ballot groups that ClearDesign generates for the current election

l Edit the common attributes of a ballot group

7.7.1 Displaying the Ballot Groups view
To display the Ballot Groups view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info view of the selected election.

2. From the Info view of the election, click the Ballot Sets tab.

ClearDesign displays the Ballot Sets view.

3. From the Ballot Sets view, click the Ballot Groups tab.

ClearDesign displays the Ballot Groups view (Figure 7-22).
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Figure 7-22. Ballot Groups view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last
Edit By, Last Edit Time, Log Count, Ballot Group Style, Ballot Set, Splits Count, Splits, Contests Count,
Contests, Ballots Count, and Ballots.

7.7.2 Editing the common attributes of a ballot group
To edit the common attributes of ballot group:

1. From the Ballot Groups view, click Edit in the row corresponding to the desired ballot group.

ClearDesign displays the Ballot Group dialog (Figure 7-23).

Figure 7-23. Ballot Group dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Click Save.

7.8 Setting up ballot styles
This topic describes how to:

l Display a list of previously generated ballot styles

l Edit the common attributes of ballot styles
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7.8.1 Displaying the Ballot Styles view
To display the Ballot Styles view:

1. From the Elections view, click the name of the desired election.

2. From the Info view of the election, click the Ballot Sets tab.

3. When ClearDesign displays the Ballot Sets view, click the Ballot Styles tab.

ClearDesign displays the Ballot Styles view (Figure 7-24 on page 175).

Figure 7-24. Ballot Styles view (default columns shown)

7.8.2 Editing the common attributes of a ballot style
To edit the common attributes of a ballot style:

1. From the Ballot Styles view, click Edit in the row corresponding to the desired ballot style.

ClearDesign displays the Ballot Style dialog.

Figure 7-25. Ballot Style dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Click Save.
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7.8.3 Previewing the layout of a ballot style
To preview the layout of a ballot style:

1. Click Layout in the row corresponding to the desired ballot in the Ballot Styles view.

ClearDesign populates the Layout Preview with the selected ballot style.

2. Review and modify the layout as needed.

See "Layout Preview" on page 195.

7.9 Setting up ballots
This section describes how to:

l Display the Ballots view

l Edit the common attributes of a ballot

l Preview an accessible ballot

7.9.1 Displaying the Ballots view
To display the Ballots view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info view, click the Ballot Sets tab.

ClearDesign displays the Ballots Sets view.

3. From the Ballot Sets tab, click the Ballots tab.

ClearDesign displays the Ballots view (Figure 7-26).

Figure 7-26. Ballots tab (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Ballot Style, Ballot Set, Card Template, Voter Group, Ballot Groups, Contest Count, Contest
Rotations, Contests, Card Count, Cards, Split Counts, and Splits.
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7.9.2 Editing the common attributes of a ballot
To edit the common attributes of a ballot:

1. From the Ballots view, click Edit in the row corresponding to the desired ballot.

ClearDesign displays the Ballot dialog.

Figure 7-27. Ballot dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. Click Save.

7.9.3 Previewing the layout of a printed ballot
To preview the layout of a printed ballot:

1. Click Layout in the row corresponding to the desired ballot in the Ballots view.

ClearDesign populates the Layout Preview with the selected ballot.

2. Review and modify the layout as needed.

See "Layout Preview" on page 195.

7.9.4 Previewing the layout of an accessible ballot
For more information about accessible ballots, see the ClearAccess Supervisor Guide.
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To preview ballot appearance on an accessible device:

1. In the Ballots tab (Figure 7-26), click HTML Layout for the ballot you want to preview.

The following window appears (Figure 7-28 on page 178)

Figure 7-28. Selecting a language

2. Click to the appropriate button to select the desired language.

The following screen appears (Figure 7-29).

Figure 7-29. How to vote screen
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3. Do any of the following:

l To move forward, click Next.

l To move backward, click Back.

l To change the zoom, color, sound, or screen, click Settings (Figure 7-30).

Figure 7-30. Settings screen

On the Settings screen, the Zoom settings control the font size. All font sizes specified for
a contest text are converted to a relative font size when you preview an accessible ballot.

Examples: A font size of 10 is equal to 100%. A font size of 16 is equal to 160%.

l To view a summary of the voter's actions, click Review votes.

4. To return to the Ballots view, click Cancel.
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7.10 Setting up card styles
This topic describes card styles.

Previously generated election media become invalid when any of the following details of card styles
change:

l Card layouts—Contests, candidates, voter groups, headers, ballot text (including margins,
borders, padding, fonts, justification and colors)

l Candidates—Addition or removal

l Voter groups

l Rotation settings

l Ballot order

7.10.1 Displaying the Card Styles view
To display the Card Styles view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info view, click the Ballot Sets tab.

ClearDesign displays the Ballots Set view.

3. From the Ballot Sets view, click the Card Styles tab.

ClearDesign displays the Cards Styles view (Figure 7-31).

Figure 7-31. Card Styles view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Card Sequence, Voter Group, Card Template, Layout Style, Ballot Styles Count, Ballot
Styles, Cards Count, Cards, Contests Count, and Contests.
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7.10.2 Editing the common attributes of a card style
To edit a card style:

1. From the Cards Styles view, click Edit in the row corresponding to the desired card style.

ClearDesign displays the Card Style dialog.

Figure 7-32. Card Styles dialog

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

The Layout Style field is read only.

3. Click Save.

7.10.3 Previewing the layout of a card style
To preview the layout of a card style:

1. Click Layout in the row corresponding to the desired card style in the Card Styles view.

ClearDesign populates the Layout Preview with the selected card style.

2. Review and modify the layout as needed.

See "Layout Preview" on page 195.

7.11 Setting up cards
This topic describes how to:

l Display the Cards view

l Edit the Card dialog

l Preview the layout of a card

ClearDesign User Guide 181



Chapter 7.  Setting up and laying out ballots

7.11.1 Displaying the Cards view
To display the Cards view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info view, click the Ballots Sets tab.

ClearDesign displays the Ballots Sets view.

3. From the Ballot Sets view, click the Cards tab.

ClearDesign displays the Cards View (Figure 7-33).

Figure 7-33. Cards view (default columns shown)

Selectable columns
Selectable columns include: Sort Seq, Name, Short Name, Abbreviation, Import ID, Last Edit By, Last
Edit Time, Card Style, Voter Group, Card Sequence, Card Template, Contests Count, Contests, Splits
Count, and Splits.

7.11.2 Editing the common attributes of a card
To edit the common attributes of a card:

1. From the cards view, click Edit in the row corresponding to the desired card.

Clear Ballot displays the Card dialog (Figure 7-34).

Figure 7-34. Card dialog
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2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

The Card Style field is read only.

3. Click Save.

7.12 Setting up card templates
This topic describes how to:

l Display the card templates view

l Add or edit a card template

7.12.1 Displaying the Card Templates view
To display the Card Templates view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info tab for the selected election.

2. From the Info view of the election, click the Ballot Sets tab.

ClearDesign displays the Ballots Set view.

3. From the Ballot Sets view, click the Card Templates tab.

ClearDesign displays the Cards Templates view.

Figure 7-35. Card Templates view
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7.12.2 Adding or editing a card template
To add a card template:

1. Select one of the following options:

l To edit an existing card template, click Edit in the row corresponding to the desired card
template in the Card Templates view.

l To create a new card template, click Add in the Card Templates view.

ClearDesign displays the Card Template dialog (Figure 7-36).

Figure 7-36. Card Template dialog

2. If necessary, edit the fields listed in Table 7-13.

Field Description

Height Height in inches

Front Orientation Portrait or Landscape for the front of the template

Back Orientation Portrait or Landscape for the back of the template

Front Number Columns The number of columns on the front of the template

Back Number Columns The number of columns on the back of the template

Oval Position Right or Left position of the vote targets relative to
the candidate names

Table 7-13. Fields of the Card Templates dialog

3. Click Save.
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7.13 Setting up layout styles
Layout styles control the overall look and feel of a ballot set.

7.13.1 Displaying the Layout Styles view
The Layout Styles view enables to add, delete, or change a layout style.

To display the Layout Styles view:

1. From the Elections view, click the name of the desired election.

ClearDesign displays the Info view of the selected election.

2. From the Info view, click the Ballot Sets tab.

ClearDesign displays the Ballot Sets view.

3. From the Ballot Sets view, click the Layout Styles tab.

ClearDesign displays the Layout Styles View (Figure 7-37).

Figure 7-37. Layout Styles view

Selectable columns
Selectable columns include: Sort Seq and Name.

Default layout styles
ClearDesign provides two default layout styles:

l Color & Border

l Border

To display the settings for these entities, click the corresponding Edit button in the Layout Styles
view.

Action buttons available from the Layout Styles view
Table 7-14 lists the action buttons available from the Layout Styles view.

ClearDesign User Guide 185



Chapter 7.  Setting up and laying out ballots

Button Description

Add See "Adding or editing a layout style" on the next page.

Delete To delete layout styles:

1. Select the check boxes in the rows corresponding to the desired
layout styles.

2. Click Delete.

You cannot delete the default layout styles: Color & Border and Border.

Table 7-14. Action buttons available from the Layout Styles view

7.13.2 Inheritance of layout styles
Layout styles are hierarchical and inherit their values from their parent element by default.

ClearDesign also supplies default entity style types that other styles inherit. This arrangement allows
you to specify an attribute in one place for each language.

The hierarchy of the styles for inheritance is as follows:

1. Layout Style of the ballot set
An entity first inherits style formatting from the Layout Style specified for the ballot set as follows:

a. The language of the entity subtype (card header, contest header, candidate contest, question
contest, and so on) in the layout style for the ballot

b. The layout for the entity type (header, contest, choice, voter group) default in the layout style
for the ballot

c. The language for the Default option in the layout style for the ballot

2. Layout tab of the entity
If an entity contains a Layout tab, the style specified by language on this tab override any styles
inherited from the Layout Style specified for the ballot set.

3. Local formatting in the Ballot Text editor of an entity
Any local formatting by language in the ballot text editor of an entity overrides any formatting
inherited from the Layout tab of an entity and any layout styles specified for the ballot set.

Example
Suppose that the font family is specified only in the Default layout entity style. In this situation, you
can globally change the font family for each language by setting it in the default layout entity style. If
the font family is specified for a contest's default language, all languages in that contest will use that
font family.
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If you want a different font only for the candidate names, add the Choice Candidate option and set
the alternative font at this level by language. With this arrangement, the Choice Candidate option
overrides the Default option, but only for Candidates.

7.13.3 Adding or editing a layout style
To add or edit a layout style:

1. Select one of the following options:

l To add a new layout style, click the Add button from the Layout Styles view.

l To edit an existing layout style, click the Edit button in the row corresponding to the
desired layout style in the Layout Styles view.

ClearDesign displays the Layout Style dialog (Figure 7-38).

Figure 7-38. Layout Style dialog

The remainder of this topic describes the settings available from the Layout Styles dialog.

Ballot-level settings
Ballot-level settings appear at the of Layout Style dialog. Table 7-15 describes these settings.

Setting Description Default

Name Name of the layout style NA

Sort Seq Editable sort sequence for the layout style NA

Table 7-15. Ballot-level settings
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Setting Description Default

Voter Group Position Position of the voter group name relative to candidate name.

One of the following:

l None (no voter group name)

l Beside

l Below

Beside

Voter Group Width Distance between the candidate name and voter group name
when they appear together.

If you select a Voter Group Position of Beside, enter a
percentage for the Voter Group Width.

If no Voter Group is desired, set this value to 0 to allocate
maximum space for the candidate or choice name.

If the Voter Group Width is 0, the text goes to the bottom
right and flows into the name of the candidate.

35

Write-in Line
Position

Sets the position of the write-in line in relation to the write-in
label.

One of the following:

l Above—The write-in line appears above the write-in
label.

l Below—The write-in line appears below the writer-in
label.

l None—The write-in line does not appear.

By default, ClearDesign places the line for the bottom write-in
choice on top of the bottom border line of the contest when
the write-in line is below the write-in label or when there is
no label. To ensure that the write-in line is visible in this
situation, select the Choice Default entity style and set a
sufficiently large Padding Bottom value.

Above

Multi-language
Ballot

If checked, text for all languages defined appear on the same
ballot. Language options in the entity-level settings define
how the multiple languages are displayed for each entity
type.

Table 7-15. Ballot-level settings (continued)

ClearDesign User Guide 188



Chapter 7.  Setting up and laying out ballots

Entity-levels settings for each language
The Layout Style dialog contains some settings related to each language in the election.

Table 7-16 lists the entity settings related to each configured language.

Setting Description

Font Name The font name

Size The font size in points.

Justify The alignment of the text. Selections are: Inherit, Left, Center, and
Right

Background Color An HTML color hex code or name

Letter Spacing The amount of space between a group of letters to affect density in a
line or block of text. Selections are: Inherit, Compressed, Normal,
Expanded, and Very Expanded

Line Spacing The vertical distance between lines of text.

Option Options for the font. The available options can vary depending on the
selected font. One of the following: Inherit, Normal, Bold, Italic,
Underline, Bold Italic, Bold Underline, Italic Underline, and Bold Italic
Underline

Text color An HTML color hex code or name.

Table 7-16. Entity-level settings for each configured language

Entity-level settings for margins, borders, and padding
Because ClearDesign layout is based on a table model, each entity can be considered as a "box." Each
box has margin, border, and padding attributes that interact as shown in Figure 7-39

Figure 7-39. Margin, border, and padding
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Figure 7-39 shows the following:

l The margin is the space outside the border up to the edge of the entity's box.

l The border is the optional outline that separates the margin and the padding.

l The padding is the space between the border and the content.

The Layout Style Editor contains settings for margins, borders, and padding. You can specify that the
language-specific settings inherit values from a parent entity or you can a pixel value in the range of
0 to 18.

Entity-level settings for multi-language ballots
When the Multi-language Ballot setting is checked, all the languages defined are displayed together
for each entity type. The entity-level Language Position setting determines how the languages are
placed, with options Inherit, Single, Stack, Merge, and Float. When Float is selected, a character can
be specified in the Language Separator setting to separate the languages.

Figure 7-40. Example: multi-language ballot with two languages defined

Figure 7-40 demonstrates the following settings for an election with two languages defined:

l The Default Entity Style has the Language Position set to Merge.

This means that paragraphs of text are merged by language individually. Where there are blank
lines between the paragraphs, only one blank line will be merged, and the others will be
removed; there should be an equal number of paragraphs in each language for the merging to
work best.

In the example shown in Figure 7-40, the Contest Entity Style has Language Position set to
Inherit. As a result, the Contest text inherits the Default Merge setting and shows English
followed by Spanish for each paragraph of text.

l The Choice Candidate Entity Style has the Language Position set to Single.

This means that only the first defined language (English in this case) is shown for candidate
names.

l The Voter Group Entity Style has the Language Position set to Stack.

This means that the text for each language is stacked vertically.
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l The Choice Write-in Entity Style has the Language Position set to Float, with Separator “/”.

This means that the text for each language is floated horizontally, with “/” between each
language.

If Float is used for headers and contest text, ClearDesign tries to place the text side by side to
fill the available width. However, if the text is too wide for the available space, ClearDesign
wraps the block below the preceding one. If the text has a background color, the background
color fills only the width used by the text.

Applying a layout style to a ballot
To apply a layout style to a ballot set:

1. In the Ballot Sets view, in the row for the ballot set you want to modify, click Edit.

The Ballot Set dialog appears.

2. In Layout Style, select the layout style you want to apply.

Setting entity styles
An entity style is named collection layout settings, such as font type, size, and position. Examples are
Header Default, Voter Groups, and various Sub Headers.

The lower portion of Layout Style dialog manages entity styles (Figure 7-41).

Figure 7-41. Entity Styles section of the Layout Style dialog

Table 7-17 lists the actions that are available for entity styles.
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Actions Description

Edit an existing entity style 1. Click the name of the desired entity style in the selection
pane.

2. Change any desired settings in the editing pane.

3. Click Save.

Add a new entity style 1. Click Add.

2. Enter settings for the new entity style in the editing
window.

3. Click Save.

Delete an entity style 1. Click the name of the desired entity style in the editing
pane.

2. Click Delete.

Table 7-17. Actions available for entity styles

Entity style types
An entity style type associates a unique set of layout parameters with a named entity style. The
following types are customized through the Layout Styles editor.

You cannot change the entity style type for an existing entity.

Entity style type Description

Header Entity Styles

Header Default Controls all headers unless overridden by a more specific entity
style for headers

Header Card Header Controls card headers only

Header Card Footer Controls card footers only

Header Contest Header Controls contest headers only

Header Contest Footer Controls contest footers only

Contest Entity Styles

Contest Default Controls all contests unless overridden by a more specific entity
style for contests.

Table 7-18. System-defined entity style types
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Entity style type Description

Contest Candidate Controls Candidate-type contests except for Choices

Contest Question Controls Question-type contests except for Choices

Contest Retention Controls Retention-type contests except for Choices

Contest Recall Controls Recall-type contests except for Choices.

Contest Straight Party Controls the Straight Party-specified contest, but not the contests
affected by the straight party contest. Also does not affect
Choices.

Contest Primary Preference Controls the Primary Preference-specified contest. Does not
affect Choices.

Choice entity styles

Choice Default Controls all choices unless overridden by a more specific entity
style for choices

Choice Candidate Controls the choices of a Candidate-type contest

Choice Question Controls the choices of a Question-type contest

Choices Retention Controls the choices of a Retention-type contest.

Choices Recall Controls the choices of a Recall-type contest.

Choice Straight Party Controls the choices of a Straight Party-type contest.

Choice Primary Preference Controls the choices of a Primary Preference-type contest.

Choice Judges Initials Controls the choices of a Judges Initials-type contest

Choice Label Controls the label (informational text) field of any contest

Choice Write-in Controls the write-in field of any contest

Miscellaneous entity styles

Voter Group Controls the displayed voter group if a candidate choice has a
partisan association

Table 7-18. System-defined entity style types (continued)
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Entity style type Description

Subheader 1 through
Subheader 7

Controls the settings for the selected subheader type.

Subheader 5 is reserved for the contest Vote For value imported
from files such as BDF, GEMS, or OCVR. (The fixed text can be
modified by localizing message 5004. See the ClearDesign
Administration Guide.)

For OCVR format only, Subheader 4 is reserved for question text
other than the first line.

Table 7-18. System-defined entity style types (continued)
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Chapter 8. Layout Preview

This chapter describes Layout Preview.

8.1 What is Layout Preview?
A Layout Preview provides an on-screen view of a selected ballot style, ballot, card style, or card.
The page is useful for ballot proofing.

The Layout Preview allows you to experiment with layout styles and card templates. You can drag
contests and headers to different areas of the ballot to find the best location. Available actions vary
according to the type of entity that you preview.

The initial generation of ballot and ballot style layouts is a manual operation: you click Generate on
the Ballot Set page.

For convenience, ClearDesign makes automatic adjustments when you format headers or the
content of existing contests in the Layout Preview. Manual regeneration is required only when you
add or remove contests and candidates from any ballot styles.

Card generation is always manual. In general, card generation is required only when proofing macros
and when formatting is finalized.

Note: ClearDesign discards any changes in Layout Preview when you reset any affected ballot
styles, even if you have clicked Save in Layout Preview. See "Resetting ballot styles" on
page 160.

8.2 Displaying the Layout Preview
To display the Layout Preview:

1. From the Info view of an election, click the Ballot Sets tab.

See "Displaying the Info tab" on page 39.

2. From the Ballot Sets view, select one of the following views (tabs):

l Ballot Styles view (page 175)

l Ballots view (page 176)

l Card Styles view (page 180)

l Cards view (page 182)

3. Click the Layout button in the row corresponding to the entity that you want to preview.

For example, Figure 8-1 shows the Ballots Sets view. In this image, the Layout buttons are
enclosed in red.
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Figure 8-1. Ballot Sets view-Layout buttons

When you click a Layout button, ClearDesign displays the corresponding Layout Preview.

Figure 8-2 shows the top portion of a Layout Preview. Buttons to control viewing options appears
above an image of the ballot. In Figure 8-2, only the top two lines of the ballot image appear.

Figure 8-2. Layout Preview of a ballot

8.3 Selecting the card side
To select the card side to view in the Layout Preview, do one of the following:

l Select Front or Back (Figure 8-3).

Figure 8-3. Selecting the Front and Back
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l Click the forward and back arrow key to change sides (Figure 8-4).

Figure 8-4. Using the arrow keys to change card sides

8.4 Changing the card template
The Layout Preview enables you to select a card template that specifies the card dimensions of the
card, the number of columns on the front and back, the oval position, and the orientation.

For example, the first selection in Figure 8-5 for the card template is 8.5 x 18 - 4 Front 3 Back. To
change the card template, select another value from the drop-down list.

Figure 8-5. Selecting a card template

See also "Setting up card templates" on page 183.

8.5 Selecting the split
Select the desired split from the drop-down list (Figure 8-6).

The drop-down list for a split is available only for ballots and cards. It is unavailable when you select
a ballot style or card style.
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Figure 8-6. Selecting a split

If a split name appears in more than one precinct, the precinct name precedes the split name in the
drop-down list.

Example:

Precinct 10 - Split B

Precinct 20 - Split B

See also "Splits" on page 79.

8.6 Changing the layout style
The layout style controls the overall design of the ballot style on the Layout Preview page. Figure 8-7
shows that the layout style Color & Border is selected.

Figure 8-7. Selecting a layout style

See also "Setting up layout styles" on page 185.

8.7 Zooming in or out
To zoom in or out on an image in the Layout Preview page, use the zoom buttons (Figure 8-8 on
page 199):

l To make the preview larger, click Zoom In (+).

l To make the preview smaller, click the Zoom Out button (-).
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Figure 8-8. Options for zooming in and out

8.8 Printing the layout preview image
To print the image in the Layout Preview to a local printer, click the Print button (Figure 8-9).

Figure 8-9. Print button for the Layout Preview image

8.9 Viewing stubs
A Layout Preview of an entity contains a Stubs button only when an election contains a Header Type
of Card Stub Top or Card Stub Bottom.

For a description of Card Stub Top and Card Stub Bottom, see Table 7-2, "Header Type values" on
page 135

The Stubs button toggles the display of stubs. By default, the stubs do not display in Layout Preview
until you click Stubs.

Figure 8-10 shows the top section of a ballot after clicking the Stubs button. The Stubs button is
highlighted to indicate that the stub is active. This stub contains the placeholder text "Stub text."

Figure 8-10. Layout Preview of a ballot containing a stub
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8.10 Adding proof marks
To add a proof mark to the image in the Layout Preview page, click Proof Mark.

The previously specified proof mark is added as a watermark to the image.

Figure 8-11. Layout Preview showing the proof mark "Sample"

8.11 Previewing both sides of cards
To preview both sides of a card, side by side, click Both Sides.

When dragging and dropping headers with both sides visible, activate the side where you will drop
the header.

8.12 Resizing and repositioning contests or headers
To change the position of a contest or a header in the Layout Preview page:

1. Within the ballot image, click a contest or header to select it.

The selected entity is outlined in red.

2. To move the selected entity, hold down the left mouse button, drag it to a new location, and
release the mouse button.

3. To resize the selected entity, hold down the left mouse button, drag an edge of the entity to
the desired size, and release the mouse button.

When you drag to resize an entity, it snaps to regular predetermined intervals. To resize an
entity in smaller intervals, hold down the Ctrl key when you drag.
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Because other entities do not automatically move to accommodate a new entity, move each entity
manually.

8.13 Adding headers to layouts
To add a header to a layout:

1. In the Headers pane, click the header to select it.

The cursor changes to a four-sided arrow.

2. Drag the header from the Headers pane to the desired location in Layout Preview (Figure 8-
12).

3. Release the mouse button.

Figure 8-12. Dragging a header to the desired location in the Layout Preview

8.14 Paging through a series of ballot images
To page through a series of ballot images in the Layout Preview page, click Prev to move backward
or Next to move forward.

Figure 8-13. The Prev and Next buttons for paging through ballot images
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8.15 Moving text from one card to another
To move text from one of the cards in a ballot to another card in the same ballot on the Layout
Preview page:

1. Select the text you want to move.

2. Enter [Ctrl+X] to cut the text from the present location.

3. Move the cursor to the location where you want to place the text.

4. Enter [Ctrl+V] to paste the text in the new location.

8.16 Saving preview changes
To save changes made through the Layout Preview page, click Save.

Saving fails when any ovals overlap in the preview. This problem can occur when dragging and
dropping contests. An error message directs you to the side, row, and column where the overlap
occurs. The problem is resolved by adjusting the position of at least one of the affected contests.

8.17 Closing the Layout Preview page
To close the Layout Preview page:

1. Click Save.

ClearDesign discards any unsaved changes.

2. Click Close.
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Chapter 9. Managing languages, device messages, and
audio

9.1 Objectives
After reading this chapter, you should be to add languages to an election, edit device messages, and
manage audio associated with device messages.

9.2 Prerequisites
Before adding languages, make sure that an election meets the following prerequisites:

l Define all required splits.

When you add a language, you can associate the language with all or specific splits. This action
ensures the language-specific ballot media get generated for the appropriate splits.

See "Adding or editing contests" on page 85.

l Stabilize all ballot text in English.

By default, ClearDesign provides an English tab for entities containing a Ballot Text editor (voter
groups, contests, candidates, and headers). When you add new languages, ClearDesign adds
tabs associated with each language in the Ballot Text editor. The tabs for the additional
languages inherit layout and formatting from the English tab. To apply consistent formatting of
ballot text for all languages, stabilize the ballot text in English to avoid potential reformatting
when you add other languages.

However, you have to the option of applying language-specific formatting, if desired.

See the following topics:
o "Adding or editing a voter group" on page 62
o "Adding or editing contests" on page 85
o "Adding or editing candidates" on page 99
o "Adding or editing a header" on page 137

Before you edit device messages and record audio, set up vote centers and configure device types.
See the following topics:

l "Adding or editing vote centers" on page 1

l "Device types" on page 120
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9.3 Guidelines for supporting languages in addition to English
This topic provides guidelines for supporting languages in addition to English.

ClearDesign creates ballots in English by default. You can include additional languages as needed.
ClearDesign creates separate ballot image files for each language in the election unless Multi-
language Ballot is checked in the layout style being used. (For an explanation, see "Entity-level
settings for multi-language ballots" on page 190.)

When you add a language, associate the language with the relevant splits.

If your election contains audio associated with accessible devices, ClearDesign requires you to
provide translations of the audio for any languages in addition to English

Table 9-1 lists some considerations for adding languages, translations, and audio to an election.

Requirement Action See

Paper ballots only/
English only

No translation or audio required. Skip this section.

Paper ballots/
Translation required

Translate ballot text in ClearDesign. "Managing translations" on
page 210

Audio required
(ClearAccess)/
English only

Use automatic text-to speech. You
can preview this audio by clicking
the TTS button on the affected
screens.

"Text-to-speech (TTS)" on
page 215

Audio required
(ClearAccess)/
Translation required

Translate ballot/contest questions.

Translate ClearAccess device
messages.

"How to record device
messages and ballot text" on
page 216

Table 9-1. Considerations: adding languages other than English
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9.4 Displaying the Languages view
To display the Languages view, select one of the following options:

l From the Election menu, select Languages.

l From the Info view of an election, click the Languages tab.

ClearDesign displays the Languages view (Figure 9-1).

Figure 9-1. Languages view (default columns shown)

Selectable columns: Languages view
Use the Show / hide columns button to select which columns appear. Selectable columns include:
Sort Seq, Name, Short Name, Abbreviation, Import ID, Export ID, Last Edit By, Last Edit Time, Log
Count, and ISO Code. By default, the Sort Seq and Name columns appear.

Action Button Description

Add See "Adding languages and changing language settings" on the next page.

Delete To delete a language other than the English:

1. Select the check box for each desired language.

2. Click Delete.

You cannot delete English, which is the default language.

Export Text See "Exporting language text files for translation" on page 210.

Import Text See "Importing a translated language text file" on page 213.

Export Audio See "Managing device messages" on page 207.

Import Audio See "How to record device messages and ballot text" on page 216.

Table 9-2. Action buttons: Languages view
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Tab See

Device Messages "Managing device messages" on the next page

Audio "Displaying the Audio view" on page 214

Table 9-3. Additional tabs available from the languages view

9.5 Adding languages and changing language settings
To add a language to an election template:

1. Select one of the following options:

l To add a language, click Add from the Languages view.

l To edit the settings of a language, click Edit in the desired row of the Languages view.

ClearDesign displays the Language dialog.

Figure 9-2. Language dialog, Basic tab

2. If necessary, edit the following common attributes:

◦ Name ◦ Sort Seq

◦ Short Name ◦ Import ID

◦ Abbreviation ◦ Export ID

See "Common attributes of entities" on page 241.

3. (Optional) In ISO Code, select the ISO code of the language from the drop-down list.

This setting is required for generating text-to-speech audio.
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4. (Optional) Select the Splits tab.

Figure 9-3. Language dialog, Splits tab

By default, all splits in the election are selected. Clear the check boxes of any splits that do
not require ballots in the current language.

5. Click Save.

9.6 Managing device messages
A device message is text presented to users of ClearAccess (Accessible Marker Device Type) or
ClearCast (Paper Scanner Device Type).

9.6.1 Displaying the Device Messages view
To display the Device messages view (Figure 9-4), click the Devices Messages tab when on the
Languages view.

Figure 9-4. Device Messages view (default columns shown)

Selectable columns: Device Messages view
Click Show / hide columns to select which columns appear. Selectable columns include: Name, Log
Count, Device Class, Language,Message, Audio Source, and Audio Length. By default, all columns
appear other than Log Count.

Reset button
Click Reset to return device messages to their default state.
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9.6.2 Editing device messages
To edit and record an individual device message:

1. From the Languages view, select the Device Messages view.

2. Click Edit in the row corresponding to the desired device message.

Ensure the correct language is selected.

ClearDesign displays the Device Message dialog for the selected device message. Figure 9-5
shows an example.

Figure 9-5. Device Message dialog

3. InMessage, edit the text of the message:

l To apply boldface, highlight any portion of the message and click B.

l To view the HTML source code, click <>.

You can use only the HTML tags <br>, <p>, and <strong>.

4. (Optional) To create an MP3 recording of the message that ClearAccess can use, do the
following:

a. Click Record.

Google Chrome may issue a message about using your internal microphone.

b. Read the message.

c. When done, click Stop.

5. When you finish editing the device message, click Save.

For straight party elections and open primaries, Clear Ballot recommends that jurisdictions edit
device messages to suit their specific requirements and circumstances.
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9.6.3 Using HTML in device messages
You can format device messages by using HTML. You can use only the following HTML tags:

l <p>

l <strong>

l <br>

Figure 9-6 an example of HTML in a device message.

Figure 9-6. Example of HTML in a device message

9.6.4 Using macros in device messages
Device messages can use macros to handle variable text, such as geographical information. Figure 9-
7 shows an example.

Figure 9-7. Example of macro usage in device messages

For more information, see "Using Macros" on page 145.
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9.7 Managing translations
This topic describes how to manage translations.

9.7.1 Exporting language text files for translation
To export language text files for translation:

1. If the election was upgraded from a previous version of ClearDesign software, click Reset
from the Device Messages view.

The reset action removes previous audio recording recordings of device messages and
ensures that your election has the most up-to-date device messages. The reset action does
not remove audio recordings of contests, candidates, and so on.

2. From the Language view of the election, click Export Text.

The Export Language Text Files dialog appears (Figure 9-8).

Figure 9-8. Export Language Text Files dialog

The Export Language Texts Files dialog contains two option that are selected by default:

l Include Ballot Text

l Include Device Messages

3. To export the language text data:

a. (Optional) Deselect either or both of the options in the Export Language Text Files dialog.

b. Click OK.

When you click OK, ClearDesign creates a zip folder with a name in the following format in
your browser-specific download folder:

ElectionName-yyyy-mm-ddmm-ss-text.zip

The zip folder contains an HTML file named TextEditor.html and one CSV file for each
language in the election.
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9.7.2 Using Google Translate
This section provides some guidelines for using Google Translate.

Do not rely on Google Translate alone for completely accurate and error-free translations. Use the
output from Google Translate only as a baseline for review and verification by a human translator.

The steps in the remainder of this section assume the following:

l You have exported the Zip language folder as described in the previous section.

l Google Chrome is installed and configured as the default browser on your computer.

To use Google Translate, do the following:

1. Transfer the zip folder that you exported in the previous section to a computer that can
access the Internet.

2. Navigate to the location of the zip folder, right-click it, select Extract All, and specify a
location.

Window Explorer opens the extracted language text folder. Figure 9-9 shows an example.

Figure 9-9. Example of an extracted language text folder

3. Double-click the file TextEditor.html to open it in Google Chrome.

The Text Editor appears in the browser window (Figure 9-10).

Figure 9-10. TextEditor.html opened in Google Chrome

4. Click the Open button in the Text Editor.

5. When the Open dialog appears, click to select the CSV file associated with a language and
click the Open button (Figure 9-11 on page 212).
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Figure 9-11. Open dialog

The contents of the CSV file for the selected language appears in the Text Editor (Figure 9-12).

Figure 9-12. CSV language file in the Text Editor window (partial window shown)

6. Make a selection from the Select Language drop-down list.

7. Scroll to the end of the file to ensure that everything in the Language Text column gets
translated.

8. Click the Save button.

The Text Editor saves the translated CSV file and the Open button becomes disabled.

9. To translate another CSV or continue working on a CSV file that you previously saved, do the
following:

a. Right-click in the browser window and select Reload to clear the previously loaded file
from the Text Editor.

b. Repeat steps 4 through 8.

After you complete processing all files with Google Translate, create a zip folder containing the
translated CSV files. Continue with "Importing a translated language text file" on the next page.
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9.7.3 Using a third-party translator
To outsource translation to a vendor or verify the translation manually, do the following:

1. Export the language text files to a zip folder.

See "Exporting language text files for translation" on page 210.

2. Extract the zip folder.

3. Manually open each CSV file and edit it with an appropriate program.

Microsoft Excel will work in most cases, but translation agencies may have their own unique
tools.

4. Once the translations are complete, zip the CSV files together.

5. Reimport the Zip file into ClearDesign by using the Import Text button under the Languages
model.

See "Importing a translated language text file" below.

If you have problems reimporting your Zip package, double-check that the formatting parameters in
the CSV file were not compromised during the translation process. Contact Clear Ballot Technical
Support if problems persist.

9.7.4 Importing a translated language text file
This section describes how to import a translated language file processed by Google Translate or by a
third-party vendor.

To import a translated language text file:

1. From the Language view of the election, click Import Text.

The Import Language Text Files dialog appears.

Figure 9-13. Import Language Text Files dialog
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2. To import the language text data:

a. Deselect Invalidate affected Card Styles, if desired.

By default, this option is selected. As a result, ClearDesign invalidates any text affected by
the import in cards that are already laid out. A message in the dialog indicates if card
have already been laid out. A message also indicates if the ADFx, BDF, and BDFx have
been created so that you can regenerate these files after the import.

b. Click Choose File to locate and select the Zip file.

c. Click OK.

New and modified translations replace affected ballot text or device messages, for which you
can now generate audio for use by the ClearAccess system. If the ballot is only in English,
ClearAccess automatically uses Chrome's text-to-speech functionality.

9.8 Managing audio
This topic describes how to manage the audio content of an election. ClearAccess and ClearCast use
audio content. If your jurisdiction does not used ClearAccess and ClearCast, you can skip this topic.

9.8.1 Displaying the Audio view
To display the Audio view (Figure 9-14), click the Audio tab when in the Languages view.

After you import audio into your election, the Audio tab displays all the available files for the
election.

Figure 9-14. Audio view (default columns shown)

Selectable columns
Table 9-4 lists the selectable columns of the Audio view.

Column Description

ID The internal ID value that identifies the audio file.

Table 9-4. Selectable columns: Audio view
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Column Description

Language The language of the audio file.

Log Count The number of logs generated for this entry.

This is the only column that does not appear by default on the Audio tab. To
display this column, use the Show / hide columns button.

Entity Type The type of content of the file. This column is useful for identifying files with
similar content, but with different purposes.

Entity The name of the entity to which the audio pertains.

Audio File Use the Play button to review the previously recorded audio file, verify
pronunciation, and check the overall quality.

l Rerecord any errors in pronunciation by using the device messages, contest,
or header entity related to the given audio file.

l For text-to-speech corrections, re-export the audio. Then fix the
pronunciation by modifying the text in the Ballot Text editor.

Audio
Length

The length of the audio file in bytes

Table 9-4. Selectable columns: Audio view (continued)

9.8.2 Recording audio
Two of Clear Ballot's products, ClearAccess and ClearCast, use audio recordings to increase
accessibility. You use ClearDesign to record audio for both ClearAccess and ClearCast.

There are two options for recording audio:

l Text-to-speech

l Manual recording

You can use these options individually or in tandem.

9.8.3 Text-to-speech (TTS)
Text-to-speech, also known as TTS, uses computer-generated audio to record all necessary dialog for
a given language. Use the Ballot Text editor to record text-to-speech.

ClearAccess and ClearCast automatically provide text-to-speech translations for English, even if no
audio is recorded. To preview text-to-speech in ClearDesign, click the TTS button in the Ballot Text
editors for contests, headers, and device messages.

See the "How to record device messages and ballot text" on the next page for more information
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9.8.4 Manually recording audio
You can record manually in ClearDesign by using the record feature in the following locations:

l Ballot Text editor

l Device Message tab, under Language

l AudioEditor.html

Remember to record in all these locations because not all text present in ClearAccess and ClearCast
is derived from Contest and Header content. A summary of all available text is present under the
Audio tab.

Manually recording audio can be useful for difficult-to-pronounce names, which present a challenge
for text-to-speech.

You can also change the pronunciation of text-to-speech by editing the text in the Ballot Text editor.
Therefore, manual recording is usually unnecessary except in rare cases.

You can record manually in tandem with text-to-speech recording, if desired.

You can record audio with systems other than ClearDesign, but make sure to name the audio files to
correspond with any text strings within ClearDesign.

All audio files must be in MP3 format.

For more information, see "How to record device messages and ballot text" below.

9.8.5 How to record device messages and ballot text
This section describes how to record device messages and ballot text.

For assistance with recording audio, contact Clear Ballot Technical Support.

AudioEditor and Voice RSS
The AudioEditor is included when audio is exported. The AudioEditor contains a link to Voice RSS,
which is a third-party provider of text-to-speech in many languages. When generating audio, Clear
Ballot uses the services provided by Voice RSS. Clear Ballot recommends this service for voice
generation.

To use Voice RSS, go to http://www.voicerss.org/ and set up an account. Using Voice RSS requires
you to purchase a license. You can use Voice RSS to process up 1000 KB of data free each day. If you
process larger amounts, charges apply.
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Steps for recording device messages and ballot text
To record device messages or ballot text:

1. From the Language view of the election, click Export Audio.

The Export Language Audio Files dialog appears.

Figure 9-15. Export Language Audio Files dialog

2. To export the language audio data:

a. In Language, select All or a specific language.

b. (Optional) Check Include Ballot Text.

c. (Optional) Check Include Device Messages.

A Zip file named ElectionName-mm-dd mm-ss-audio.zip appears in the browser-
specific download folder. The file contains a folder for each language in the election and a file
named AudioEditor.html.

AudioEditor.html, the Audio editor, is a program for manually recording audio or
converting text to audio using the Voice RSS online service.

3. Extract the contained folders and AudioEditor.html to a dedicated folder on a
computer with an Internet connection.

4. From the extracted archive, double-click AudioEditor.html.

The Audio editor appears in a browser window. (No text is loaded initially.)

Figure 9-16. Audio editor window (audio data loaded)
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5. In TTS Key, enter the key provided by the Voice RSS service on registration.

When you are logged into Voice RSS, the TTS key is available underMy Account.

6. Click Open to locate and open the Zip file.

7. For each language:

a. Click the name of a language.

The data for the selected language appears.

b. Complete any of the following optional steps

o Select the desired voice (inflection) from the drop-down.
o Click Generate to record all text using the selected inflection.
o Click Delete to remove all existing recordings.

8. Click Save.

A Zip file appears in the browser-specific download folder. The file contains a folder
containing MP3 files for each language in the election.

9. From the Language view of the election, click Import Audio.

The Import Language Audio Files dialog appears.

Figure 9-17. Import Language Audio Files dialog

10. To import the language audio data:

a. For Select the file to import, click Choose File to locate and select the Zip file.

b. Click OK.

The Audio tab now includes the imported audio files.
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Chapter 10. Proofing elections

Proofing is a critical part of the ballot-development workflow. This chapter provides some guidelines
and recommendations for proofing elections and identifies some workflow considerations.

Clear Ballot does not provide legal advice or recommendations on following local statutes for ballot
proofing. If you have compliance questions, consult with the election officials in your jurisdiction.

10.1 When to proof an election
Proof raw data as early as possible in the process. Then, generate ballots and proof them because
they adjust in real time. Make sure that you generate and proof your ballots before generating cards.
The cards are static, and any change requires you to regenerate the cards.

10.2 Proofing on paper versus online
When proofing an election in ClearDesign, you can print the reports and ballots and proof the paper
copy or proof these documents online using ClearDesign's visual ballot imaging tools and screens.

In some jurisdictions, statutes mandate the format for proofing.

Many jurisdictions prefer to proof on paper for accuracy. The person proofing a document can
annotate it to list required changes. The printed and annotated paper copy can become part of the
audit trail for producing the election.

10.3 Recommendations for proofing elections
After creating an election and laying out ballots, it is important to proof the election before sending
the ballots to be printed. Elections contain a great deal of detailed information, and even a small
mistake may lead to confusion or even disqualification.

Proofing an election may include all of the following for every ballot in every language that the
election supports:

l Check that you have correctly defined all fundamental election entities.

l Check the district, precinct, and contest elections for each ballot style to make sure they appear
correctly.

l Check that candidates and contests are properly represented.

l Make sure rotations are properly represented in each ballot.

l Confirm that the numbers of candidates and contests are correct.

l Make sure that, for each ballot style, each split contains the correct contests.
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l If you have defined an advanced election type, such as a specific type of primary, additional
ballot sets, or a consolidated precinct, check that the election conforms to the requirements of
your jurisdiction and ClearDesign.

l Check that the election definition meets the requirements any downstream ClearDesign
products used in your jurisdiction:

o ClearAccess
o PrintNow
o ClearCount
o ClearCast

l In some jurisdictions, the ClearVote systems have interfaces with third-party election-night
systems and other data aggregation systems. Set aside time to test the import of data from
ClearDesign systems into the third-party systems

l Look for general typos and misspellings.

l Inspect the overall ballot style layout and making any needed design modifications.

l Look for ballot layout problems, such as missing, overlapping, or otherwise illegible text.

l Resolve any duplicate names.

When you export media, ClearDesign issues a warning message about specific duplicate names.
Examples are duplicate contest names, short names, and abbreviations for languages, voter
groups, and district categories, districts, and precincts. ClearDesign allows you to export the
election containing the duplicates, but Clear Ballot recommends resolving the duplicates before
committing to final version. Duplicate names cause identification issues in other ClearVote
products.

ClearDesign contains built-in tools that can help prevent users from inadvertently introducing errors
to their elections and ballots. In addition, ClearDesign supports efficient yet thorough ballot image
review for proofing purposes.
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Chapter 11. Ballot proofing reports

11.1 Introduction
ClearDesign provides multiple reports that are useful for proofing an election and analyzing how the
election is set up. You can view ballot proofing reports online in HTML format or save them as PDF
and CSV files.

11.2 Displaying the Reports window
The Reports window enables you to select reports the available for an election and specify the
options for viewing the reports.

To display the Reports window:

1. From the Elections view, click the name of a desired election to select it.

ClearDesign displays the Info tab for the selected election (Figure 11-1).

Figure 11-1. Selecting Reports on the Info tab for an election
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2. On the Info tab, click the Reports button.

ClearDesign displays the Reports window (Figure 11-2).

Figure 11-2. Reports window
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11.3 Selecting a report and the options for viewing it
To select a report and the desired the options:

1. Click to choose one of the report titles in the Select Report pane of the Reports window
(Figure 11-2).

For a list and description of all available reports in ClearDesign, see Table 11-2.

2. Select the desired Options.

Most options are self-explanatory. Table 11-1 lists the available Include options.

Option Description

Ordinal
number

Numbers each item in the report.

Example: The Ballot Groups report (Figure 11-3) shows ballot group styles
numbered 1 through 6.

Group
counts

Lists the numbers of items in each group shown in a report.

Example: The partial Ballot Group Styles with Contest Report shown in Figure
11-4 shows two ballot group styles. Ballot Group Standard Style 1 is
associated with four contests. Ballot Group Standard Style 2 is associated with
the five contests.

Empty
columns

Includes empty columns in a report. By default, ClearDesign does not show
empty columns in reports.

Example: The Ballot Sets report shown in Figure 11-5 shows the empty
columns Import ID and Export ID.

Table 11-1. Include options for reports

3. Once you select the desired options, click the Print button to generate the desired report.

The selected report displays in a separate browser tab. You can right-click to save the report,
if desired.
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11.4 Sample reports
This section shows some sample reports.

11.4.1 Ballot Groups report
Figure 11-3 shows an example of the Ballot Groups report generated with the Ordinal number option
selected. In this report, the ballot group styles are numbered 1 through 6 in the left column.

Figure 11-3. Ballot Groups report (Ordinal number option selected)

11.4.2 Ballot Group Styles with Contests report
Figure 11-4 shows an example of the Ballot Group Styles with contests report generated with the
Group Counts options selected.

This report shows two ballot group styles:

l BallotGroup Standard Style 1 is associated with four contests as indicated by the label Count: 4.

l Ballot Group Standard Style 2 is associated with five contests as indicated by the label Count: 5.

Figure 11-4. Example: Ballot Group Styles with Contests report

ClearDesign User Guide 224



Chapter 11.  Ballot proofing reports

11.4.3 Ballot Sets report
Figure 11-5 shows an example of a Ballot Sets report generated with the Empty Columns option
selected. In this example, the Import ID and Export ID columns are blank. By default, reports do not
show empty columns.

Figure 11-5. Example: Ballot Sets report

11.5 List of ballot proofing reports
Table 11-2 lists and describes the ballot proofing reports that are available in ClearDesign.

Report name Lists

Ballot Group
Styles

The number of ballot groups, splits, contests, and ballot styles for each ballot
group style in an election

Ballot Group
Styles with Ballot
Styles

The associated ballot style, voter group, and number of contests associated
with each ballot group style used in an election

Ballot Group
Styles with
Contests

The contests for each district in each ballot group style

Ballot Group
Styles with Splits

The precincts and splits in each ballot group style in the election

Ballot Groups The number of splits, contests, and ballots for each ballot group

Ballot Groups
with Ballots

The ballot, contest count, and voter group for each ballot group in the election

Ballot Groups
with Contests

The contests in each ballot group in the election

Ballot Groups
with Splits

The precincts and splits in each ballot group in the election

Table 11-2. ClearDesign ballot proofing reports
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Report name Lists

Ballot Sets The card template and layout style used by each ballot set in the election, as
well as the ballot styles count and whether or not the ballot set uses separate
ballots

Ballot Sets with
Ballot Styles

The ballot styles and voter groups for each ballot set in the election

Ballot Styles Each ballot style in the election

Ballot Styles with
Candidates

The contests and candidates by district and voter group for each ballot style.

Ballot Styles with
Card Styles

The card styles that roll up into each ballot style

Ballot Styles with
Contests

The contests that appear in each ballot style, by district

Ballot Styles with
Precincts

The voter group and precincts for each ballot style

Ballot Styles with
Splits

The precincts and splits in each ballot style

Ballots All the ballots in the election

Ballots with
Candidates

The contests and candidates for each ballot

Ballots with
Cards

All ballots and corresponding cards

Ballots with
Contests

The contests on each ballot by district

Ballots with
Precincts

The voter group and precincts for each ballot

Ballots with
Splits

The precincts and splits on each ballot

Candidates The candidates in an election

Candidates with
Ballot Text

The candidates and ballot text for each contest

Table 11-2. ClearDesign ballot proofing reports (continued)
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Report name Lists

Card Styles Each card style in the election

Card Styles with
Candidates

All candidates in each card style by district and contest

Card Styles with
Cards

The cards associated with each card styles

Card Styles with
Contests

The contests in each card style by district

Card Styles with
Precincts

The voter group, card sequence number, and precincts for each card style

Card Styles with
Splits

The precincts and splits for each card style

Cards All cards used in a n election

Cards with
Candidates

The contests and candidates for each card

Cards with
Contests

The contests on each card by district

Cards with
Precincts

The voter group, card sequence number, and precincts for each card

Cards with Splits The precincts and splits for each card

Contests All contests in an election

Contests with
Ballot Styles

The contests associated with each ballot style

Contests with
Ballot Text

The ballot text for each contest by district

Contests with
Ballots

The ballots where each contest appears

Contests with
Candidates

The candidate for each contest by district

Contests with
Card Styles

The card styles associated with each contest

Table 11-2. ClearDesign ballot proofing reports (continued)
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Report name Lists

Contests with
Cards

The cards on which each contest appears

Contests with
Entity Styles

Contest-specific formatting that has been applied by using entity styles

Contests with
Rotations

The rotation groups of districts or precincts for each contest

Contests with
Splits

The precincts and splits in each contest

Counter Groups All counter groups in an election

Counter Group
with Vote Center
Categories

The name of each counter group and its associated vote center category

Device Types Information about each device used in an elections. This report contains a
Media Hast column. Use the Media Hash value to verify the ADF and BDF.

Device Types
with Vote Center
Categories

The name of each device type and its associated vote center category

Device Types
with Vote
Centers

The name of each device type and the vote centers using each device type.

District
Categories

The district categories in an election

District
Categories with
Districts

Each district category and its associated district

District
Categories with
Unassigned
Splits

Each district category in an election, the precincts in each district category,
and any unassigned splits.

Districts All districts in an election

Districts with
Contests

Each contest and its associated voter group for each district category in the
election

Table 11-2. ClearDesign ballot proofing reports (continued)
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Report name Lists

Districts with
Precincts

Each district and its associated precincts for each district category in the
election

Districts with
Splits

The districts, precincts, and splits associated with each district category in an
election

Headers All headers used in ballots

Headers with
Ballot Text

Each header, its language, and associated ballot text

Headers with
Card Styles

All card styles where each header appears

Headers with
Cards

Each header, its associated voter group, ballot sets, cards, and voter groups

Headers with
Entity Styles

Each header and its justification and option settings

Languages Each language used in an election

Languages with
Splits

Each language used in an election, its associated precincts, and splits

Layout Styles The layout styles used in an election

Layout Styles
with Entity Styles

Each layout style, its associated entity style type, and current format settings

Logs The log for the current election. You can also the view election log by selecting
a desired elections and clicking the Logs tab.

Precincts All precincts in an election

Precincts with
Ballots

The details of each ballot group within each precinct or split

Precincts with
Candidates

Candidate information for each district and context on a precinct by precinct
basis

Precincts with
Cards

Details of the ballot groups in each precinct or split

Precincts with
Contests

All contests in each precinct by district

Table 11-2. ClearDesign ballot proofing reports (continued)
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Report name Lists

Precincts with
Districts
(columnar)

The districts in each precinct by district category

Precincts with
Districts (tabular)

The districts in each precinct in tabular format.

Precincts with
Splits

The splits in each precinct

Precincts with
Voter Counts

The Voter Count for each precinct or split

Splits The Splits and associated Ballot Groups for each precinct in the election

Splits with
Ballots

The ballot used for each split and the number of contests that it contains

Splits with
Candidates

Candidate information for each district and contest in a precinct on a per-split
basis

Splits with Cards Details of the ballot groups within each split, including card IDs.

Splits with
Contests

The contests in each split

Splits with
Districts
(Columnar)

The districts and district categories for each split in columnar format

Splits with
Districts
(Tabular)

The districts and district categories for each split in tabular format

Splits with
Languages

The languages for each split in a precinct

Splits with Voter
Counts

The voter count for each split

Vote Center
Categories

The identifiers (Name, Short Name, Abbr) for vote center categories, the
associated devices types and counter groups, the timestamp of the last edit,
and the login ID of the person who made the edit

Table 11-2. ClearDesign ballot proofing reports (continued)
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Report name Lists

Vote Center
Categories with
Counter Groups

The counter groups associated with each vote center category

Vote Center
Categories with
Device Types

The device types and ballot sets associated with each vote center category

Vote Center All vote centers in an election

Vote Centers
with Cards

The cards associated with each vote center

Vote Centers
with Device
Types

The device types associated with each vote center

Vote Centers
with Precincts

Vote center categories and associated precincts

Voter Groups Details for all voter groups in an election

Voter Groups
with Ballot Styles

Each voter groups, the associate ballot sets, and ballot names

Voter Groups
with Ballot Text

Each voter group, the ballot text, and language of the text

Voter Groups
with Candidates

Each voter group, the candidates in that voter group, the contest, and contest
voter group

Voter Groups
with Contests

Each voter group, the associated contests, and district of each contest.

Voter Groups
with Voter
Counts

For each voter group, the voter counts per split

Table 11-2. ClearDesign ballot proofing reports (continued)

ClearDesign User Guide 231



Chapter 12.  Producing an election

Chapter 12. Producing an election

This chapter describes the tasks for producing an election.

12.1 Exporting a ballot definition file (BDF or BDFx)
After generating, proofing, and finalizing the election definition, create the BDF so that you can load
the election into ClearCount and ClearCast.

1. Ensure that you have generated and laid out the ballot for the election.

2. From the Info dialog of an election, click Export BDF.

ClearDesign displays the Export BDF Files dialog if the election is ready to export (Figure 12-
1).

Figure 12-1. Export BDF Files dialog

The message Not all ballots generated or all cards laid out, cannot export BDF indicates that
the election is not ready to export.

3. If desired, deselect the option Set Election State to Media Created.

4. Click OK to export the BDF.

ClearDesign displays a status message while creating the BDF or BDFx.

When the export is complete, the following message appears.

Figure 12-2. Export complete message

5. Click Close.
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6. To navigate to the location of the BDF zipped archive file, click the link that appears at the
bottom of the screen.

The usual location is the Downloads folder in your Windows User folder.

After you generate the BDF, you can copy it to a USB drive that you can load into ClearCount and
ClearCast.

12.2 Exporting an encrypted accessible definition file (ADFx)
After generating, proofing, and finalizing the election definition, create the ADF so that you can load
the election definition into ClearAccess.

To generate the ADFx:

1. Ensure that:

l Ballots are generated and laid out

l Passwords are set up and associated with ballot sets

2. From the Info view of an election, click Export ADF.

The Export ADF Files dialog appears if the election is ready to export (Figure 12-3).

Figure 12-3. Export ADF Files dialog

The message Not all ballots generated or all cards laid out, cannot export ADF indicates that
the election is not ready to export.

3. (Optional) Deselect Set Election State to Media Created.
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4. Click OK.

ClearDesign displays a status message while creating the ADFx.

When the export process is complete, ClearDesign displays the following message (Figure 12-
4).

Figure 12-4. Export complete message

5. Click Download.

ClearDesign displays a progress message as the ADFx archive downloads to the user-specified
location for the browser.

6. When the Exported ADF message appears, click Close.

7. To navigate to the location of the ADFx zipped archive file, click the link that appears at the
bottom of the screen.

The usual location is Downloads folder in your Windows User folder.

After you export the ADF, you can copy it to a USB drive and load it into ClearAccess.

12.3 Printing cards
One final step in preparing an election is generating a zip file containing all card images.

See "Printing cards" on page 164.

You can print the cards locally or send them to a designated printer.

12.4 Backing up a finalized election
After you have finalized an election and generated the BDF and ADF, create a backup of the election.

See "Backing up an election" on page 43

Follow the requirements of your jurisdiction for storing the backup in a secure location.
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Chapter 13. Logs

This chapter describes ClearDesign logs.

13.1 Types of ClearDesign Logs
ClearDesign maintains the following read-only logs.

Log type Records the following

Election User actions, such as adding items or deleting them, for each election, starting
with election creation. ClearDesign enables you to view the logged events
associated with each individual election.

Entity User actions for an individual entity, such as creating or editing the entity.

System User-access and administrative exceptions across all elections in the
ClearDesign system. The system log also tracks functional updates and changes
to the election database. The ClearDesign Administration Guide describes the
System log.

Table 13-1. Types of ClearDesign logs

The layout and functionality of all Logs tab are similar.

13.2 Permission for viewing logs
To access ClearDesign logs, the role assigned to your username must have the Log View permission
enabled. For information about roles, permissions, and the system log, see the ClearDesign
Administration Guide.

13.3 Viewing a log for an individual election
This topic assumes that the role assigned to your username has the Log View permission enabled.

To view an election log:

1. From the Administration menu in the navigation page, select Elections.

The Election tab appears in the content pane.

2. From the Elections view, click to select an individual election.

3. Do one of the following:

l From the Administration menu in the navigation pane, select Logs.

l From the content pane, select the Logs tab.
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The Logs tab for the selected election appears in the content pane. Figure 13-1 shows an example of
the top portion of the Logs tab for an election. The Log tab is a list view where each row represents
is an event record.

Figure 13-1. Election log (partial view)

Buttons available from the Election log
As with all list views, you can use the buttons at the top of the screen to

l Show or hide columns

l Copy or print the contents

l Export the contents to a PDF, Excel, or CSV file

Backing up and clearing the election log
To back up and clear the election log, click Clear Election Log.

ClearDesign displays the following dialog (Figure 13-2).

Figure 13-2. Clear Election Log dialog
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13.4 Viewing an entity-specific log
An entity-specific log shows only event records specific to the current entity. The formats of an
entity-specific log, the system log, and the election log are similar.

To view the log for a specific entity:

1. Display the view for the desired entity type.

2. From the view for the desired entity type, click the Name cell of the desired entity.

ClearDesign displays the Info tab for the desired entity.

3. From the Info tab of the entity, click the Logs tab.

For example, suppose that you want to view the log for a voter group called Republican. Follow
these steps:

1. Display the Voter Groups view.

2. Click the Name cell "Republican" from the Voter Groups view.

ClearDesign displays the Info tab for the Republican voter group.

3. From the Info view of the Republican voter group, click the Log tab.

ClearDesign displays a log like the example in Figure 13-3.

Figure 13-3. Example: Log for the Republican voter group

13.5 Filtering log records
The tab containing a log has several filter fields for displaying events that meet specified criteria.
Table 13-2 describes these filter fields. After you fill in the fields, click the Filter button to display the
desired results.
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Filter Description

Start Date

End Date

Indicate a date range for retrieving event records. The Start Datemust be
earlier or the same as the End Date.

When filtering by dates and no entries appear in the results, the date
range is too restrictive, and the available log entries fall outside the
specified range. To display all potential log entries, enter the following:

l Start Date: the system installation date or a date preceding the
installation date.

l End Date: the current date

Limit Specifies the number of records to retrieve.

Example: If you specify a Limit of 200, ClearDesign displays the first 200
records that meet all the filter criteria.

Severity Enables filtering of election records according to level of severity. The
Severity drop-down list displays the severity levels in the following
hierarchy:

1. Exception 4. Info

2. Error 5. Detail

3. Warning 6. Tracing

ClearDesign displays all records of the selected Severity level and lower in
the hierarchy.

Example: If you select a Severity level of (3) Warning, ClearDesign retrieves
records having Severity levels of:

(3) Warning

(2) Error

(1) Exception.

Entity types A drop-down of the entity types contained in the log. If a given entity type
does not appear in the drop-down list, the log for the election does not
contain any records for that entity type. The default Entity Type selection
is All.

Table 13-2. Filters for log events
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13.6 Searching for log records
The Search field enables you to enter a string. ClearDesign retrieves records containing the specified
string.

Example: Enter the string undervote to retrieve all records containing this string.

13.7 Printing, copying, and saving a log
Use the standard buttons in the top corner of the screen to copy, print, or save a log in a format such
as PDF, Excel, or CSV. For an explanation of these buttons, see "Buttons in the top right corner of a
list view" on page 26.
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ClearDesign supports the following data-import formats.

l Ballot definition file (BDF and BDFx), which is a Clear Ballot-proprietary format

Import a BDF only to verify election data. Do not use the BDF as the basis for developing a new
election.

l Colorado SCORE system (GEMS standard import)

l Global Election Management Systems (GEMS)

l North Carolina Statewide Elections Information Management System (SEIMS)

l Ohio format

l Oregon OCVR (Unity format)

l Vermont State Export

l Washington Election Information Managements Systems (EIMS) format

For details on the formats for the state of Washington, contact the state election officials.
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Appendix B. Common attributes of entities

Entity definitions in ClearDesign use a common set of attributes. The values of the common
attributes are user-defined fields for each instance of an entity. Table B-1 lists and defines the
common attributes of entities.

Attribute Description Default

Name Full user-defined name used across ClearDesign and
ClearCount.

A Name can contain only the following characters:

a through z, A through Z, 0 through 9, hyphen (-), under bar
(_), comma (,), asterisk (*), and space ( ).

If you enter any other characters in a Name, ClearDesign
converts them to spaces.

ClearDesign provides a default consisting of the model
name, followed by a number, in increments of 10.

Example: Election 10, Election 20, Election 30, and so on.

Maximum characters: 60 for entities other than the Name
of an election.

For the Name of an election, use a maximum of 38
characters, including spaces, to ensure that ClearCast and
ClearCount can import the BDF or BDFx file.

ModelName
SortSeq

Short Name Concise name used across ClearDesign and ClearCount,
primarily in reports.

Maximum characters: 20

Up to the first 20
characters of
Name.

Abbreviation Very short name used across ClearDesign and ClearCount,
primarily for voter groups.

Maximum characters: 6

Up to the first 6
characters of
Name.

Sort Seq Sorting index.

ClearDesign provides default values in increments of 10.

Can be user-defined but must be numeric.

Numeric portion
of the default
value of Name.
Usually a
multiple of 10.

Table B-1. Common attributes of entities
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Attribute Description Default

Import ID Used when importing or exporting most values in
ClearDesign.

Example: When handling voter registration counts or ballot
definition files, ClearCount refers to the Import ID.

Blank

Export ID Optionally, used for recognizing entities, such as contests,
candidates, precincts, that are defined by an external
system, such as a statewide reporting system.

The Export ID is useful when the voter registration systems
of counties are separate from the statewide reporting
system.

The Export ID is included in the ClearCount XML Results file.

Blank

Table B-1. Common attributes of entities (continued)
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Appendix C. Formatting toolbar: Ballot Text editor

C.1 Dialogs containing a ballot text editor.
This topic describes the formatting toolbar of the Ballot Text editor. The Ballot Text editor enables
you to enter and format text that appears on a ballot to identify the entity.

Example: The ballot text associated with a voter group identifies a political party, such as
"Democratic".

The Ballot Text editor contains a tab for each language in the election.

The dialogs of the entities listed in Table C-1 contain a Ballot Text editor.

Entity See

Voter group "Adding or editing a voter group" on page 62

Contest "Adding or editing contests" on page 85.

Candidate "Adding or editing candidates" on page 99

Header "Adding or editing a header" on page 137

Table C-1. Dialogs of entities that contain a Ballot Text editor

C.2 Location, position, and appearance of the formatting toolbar
The Ballot Text editor has a formatting toolbar that is similar to those found in many word
processing applications. The formatting toolbar appears directly above the field where you enter
text.

Figure C-1 shows the formatting toolbar.

Figure C-1. Formatting toolbar of the Ballot Text editor

As you move your mouse over each icon in the formatting toolbar, ClearDesign displays a caption
that identifies the associated formatting option.

If you are familiar with word processing, you can skip this topic or use it as a reference source for
checking formatting details.

The remainder of this topic describes each option on the formatting toolbar.
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C.3 Formatting options
Table C-2 lists the options as they appear from left to right in the toolbar of the Ballot Text editor.

Icon Description

Undo the last change.

Redo the last change.

Formats menu See "Formats menu" on page 246.

Choose the color of the currently selected text.

Choose the background color for the currently selected text.

Make the currently selected text bold.

Italicize the currently selected text.

Underline the currently selected text.

Left-align the current paragraph.

Center the current paragraph.

Right-align the current paragraph.

Justify the current paragraph.

Format the currently selected paragraphs as a bulleted list.

Format the currently selected paragraphs as a numbered list.

Decrease the indentation of the currently selected paragraphs.

Table C-2. Ballot Text editor: toolbar formatting options
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Icon Description

Increase the indentation of the currently selected paragraphs.

Toggle between pasting as plain text and pasting as formatted text.

The DesignServer is installed with the default functionality to paste as plain
text. If one ClearDesign user changes this option for pasted text, the change
persists for all other ClearDesign users that access the same Design server.

To avoid unwanted formatting, Clear Ballot recommends pasting as plain
text and then applying desired formatting in the Ballot Text editor.

Click this icon to display the Table drop-down menu. For a description of the
options available from the Table drop-down menu, see "Inserting and
formatting tables in the Ballot Text editor" on page 247.

Image tool

Find and replace text.

< > Edit the source code.

If you know HTML, you can edit the source code directly. You can use only
the following HTML tags:

l <p>

l <strong>

l <br>

View the Ballot text editor in full-screen mode.

To return to the default size, click the icon again.

Table C-2. Ballot Text editor: toolbar formatting options (continued)
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C.4 Formats menu
The Formats menu (Figure C-2) in the toolbar of the Ballot text editor contains options that
determine how text appears. To use the Formats menu, select (highlight) the desired text or
paragraph and select one of the options listed in Table C-3.

If you know HTML and CSS, you are not limited to the options available from the Formats menu. You
can edit the markup for the HTML and CSS style specifiers directly by clicking the <> selection for the
tool bar.

Figure C-2. Formats menu

Option Description

Font Family Applies a font family to the selected text.

The default font family is Noto Sans, a cross-platform sans-serif font.

You can also load additional fonts. See Chapter 3, "Adding fonts and images"
on page 52.

Font Size Applies a font size to the selected text. The Font Size option provides a range
from 36 points to 6 points.

Paragraph Font
Size

Applies a font size to the current paragraph. The Paragraph Font Size option
provides a range from 36 points to 6 points.

Table C-3. Options available from the Formats menu
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Option Description

Styles Applies a style to the current paragraph. In ClearDesign, styles are called
subheaders.

Example: You can define a subheader that applies both a specified font and
font size to the selected paragraph.

To define and edit subheaders (styles), see "Setting up layout styles" on
page 185.

Line Height Controls the amount of space between lines of text in the current paragraph.
The Line Height option provides a range from 2.0 line to 0.5 lines.

Letter Spacing Controls the amount of space between letters in the currently selected text.
The Letter Spacing option provides the following selections: Very
Compressed, Compressed, Normal, Expanded, and Very Expanded.

Language Specifies the language for the currently selected text. This option is useful
when using text-to-speech.

Table C-3. Options available from the Formats menu (continued)

C.5 Inserting and formatting tables in the Ballot Text editor
The Ballot Text editor enables you to edit and edit tables. Tables provide a grid for positioning and
aligning text and images.

The following guidelines apply to tables:

l Any measurement parameters, such asWidth, Height, Border, and Cell Padding, are in pixels.
(96 px = 1 in; 38 px = 1 cm).

l All color parameters, such as Border Color and Background Color, and require valid HTML color
names or hex codes.

l If you know HTML, you can click the source code icon (< >) to format and edit a table.

l Do not use any of the table-alignment properties. ClearDesign sets the table to match the width
of containing header. Setting the table-alignment properties of a table in header can result in
undesirable formatting of the printed ballot.

C.5.1 Inserting tables
To insert a table:

1. In the Ballot Text editor, position the cursor in the location where you want the table to
appear.

2. Click the Table icon and select Insert Table.
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The table-size grid appears.

Figure C-3. Ballot Text editor, table sizing grid

3. In the grid, highlight the required columns and rows.

Used the table formatting options describes in the remainder for this topic to format the table
according to your requirements.

C.5.2 Setting table properties
Table properties control attributes, such as measurements and colors.

To set table properties:

1. In the Ballot Text editor, click to select the table that you want to format.

2. Click the Table icon and select Table properties.

ClearDesign displays the Table properties dialog (Figure C-4). The General tab is selected.

Figure C-4. Table properties dialog: General tab
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3. From the General tab, set any of the properties listed in Table C-4.

Property Description

Width Overall table width, which can force scaling of columns.

Cell spacing The width of individual table cells (if scaling does not occur).

Border The width of the overall table and individual cell borders.

Alignment Table placement on the ballot: None, Left, Center, or Right.

Height Overall table height, which can force the scaling of columns.

Cell padding Amount of empty space between the content in each cell and its
borders.

Caption Provides a text box for a caption immediately above the table.

Table C-4. Table Properties: General

4. Click the Advanced tab (Figure C-5).

Figure C-5. Table properties dialog: Advanced tab

5. Set any combination of the Advanced properties listed in Table C-5.

Property Description

Style Embedded table-level style sheet. If you know HTML, you can
modify this style sheet.

Border color A valid HTML color name or hex value to apply to the background of
all cells

Table C-5. Table properties: Advanced

6. Click OK.
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C.5.3 Resizing tables manually
To resize a table manually:

1. In the Ballot Text editor, click the table to select it.

Small squares appear around the perimeter of the table.

Figure C-6. Selecting a table to resize it

2. Hover over one of these squares until the cursor turns into a double-headed arrow.

3. Click and drag the table to the desired size.

4. Release the mouse button.

C.5.4 Deleting a table
To delete a table:

1. In the Ballot Text editor, click to select the desired table.

2. Click the Table icon and select Delete table.
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C.5.5 Setting table cell properties
To set the properties of a selected table cell:

1. In the Ballot Text editor, select the table cell or group of cells that you want to modify.

2. Click the Table icon and select Cell > Cell Properties.

ClearDesign displays the Cell properties dialog. The General tab is selected.

Figure C-7. Cell properties dialog, General tab

3. On the General tab, set any of the desired properties listed in Table C-6.

Property Description

Width The width of the cell, including units. Enter a value such as 15% or 50px.

Cell type Select: Cell or Header Cell

H Align The horizontal alignment in the cell. Select: None, Left, Center, or Right.

Height The height of the cell, including units.

Scope Select: None, Row, Column, Row Group, or Column Group

V Align The vertical alignment in the cell. Select:

Table C-6. Cell properties: General tab

4. Click the Advanced tab (Figure C-8 on page 252).
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Figure C-8. Cell Properties dialog: Advanced tab

5. On the Advanced tab, set any of the desired properties listed in Table C-7.

Property Description

Style The embedded table style sheet. If you know HTML, modify this style
sheet to meet your formatting requirements

Border color A valid HTML color name or hex value to apply to all borders.

Background
color

A valid HTML color name or hex value to apply to the background.

Table C-7. Cell properties: Advanced tab

6. Click OK.

C.5.6 Merging table cells
To merge table cells:

1. In the Ballot Text editor, select the cells that you want to merge.

2. Click the Table icon and select Cell > Merge cells.

ClearDesign merges the selected cells.

3. Click Save.

C.5.7 Splitting table cells
To split a table cell in the Ballot Text editor:

1. Select the cell to split.

2. Click the Tablemenu and choose Cell > Split cell.

ClearDesign splits the selected cell.
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C.5.8 Editing table row properties
To edit the properties of a selected row:

1. In the Ballot Text editor, select the desired table row.

2. Click the Table icon and select Row > Row properties.

The Row properties dialog appears. The General tab appears selected.

Figure C-9. Row properties dialog: General tab

3. Set any desired properties listed in Table C-8.

Property Description

Row type Select one of the following: Header, Body, or Footer

Alignment Select one of the following: None, Left, Center, or Right.

Height Height of the row in pixels. Example: 75px

Table C-8. Row properties: General

4. Click the Advanced tab.

Figure C-10. Row properties: Advanced tab
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5. Set any combination of the following:

l Style—Summarizes the existing row styles.

l Border color—Valid HTML color name for the border around the row.

l Background color—Valid HTML color name for the background of the row, expressed by
name.

Figure C-11. Row properties dialog: Advanced tab

6. Click OK.

C.5.9 Adding, deleting, or moving table rows
To add, delete, or move a table row in the Ballot Text editor:

1. Select the row that you want to modify.

2. Click the Table icon and hover over Row.
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3. Select one of the options listed in "Row properties" below.

Property Description

Insert row before Place a new empty row above the selected row.

Insert row after Places a new empty row below the selected row.

Delete row Deletes this row.

Cut row Cuts the row so that you can paste it elsewhere.

Copy row Copy the row so that you can paste it elsewhere.

Paste row before Paste the cut or copied row above the selected row.

Paste row after Paste the cut or copied row below the selected row.

Table C-9. Row properties

C.5.10 Adding or deleting columns
To add or delete a column:

1. In the Ballot Text editor, select the column you want to modify.

2. From the Table drop-down menu, hover over Column.

3. Select one of the following menu options:

l Insert Column Before—Places a new empty column to the left of the selected column.

l Insert Column After—Places a new empty column to the right of the selected column.

l Delete Column—Deletes the selected column.
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